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Please read through this manual carefully 

and keep it in a safe place. 

• Before using the instrument, read the safety 

instructions and precautions carefully.  

• Keep this manual in a safe place nearby so it can 

be referred to whenever needed. 
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NOTICE: 

1. Information contained in this document is subject to 

change without notice for improvement. 

2. This manual is copyrighted by Hitachi High-Technologies 

Corporation with all rights reserved.   

No part of this manual may be reproduced, transmitted 

or disclosed to a third party in any form or by any means 

without the express written permission of Hitachi 

High-Technologies Corporation. 

3. Hitachi High-Technologies Corporation assumes no 

liability for any direct, indirect, or consequential damages 

arising from use not described in this manual. 

Utmost care must be exercised when using the 

instrument. 

4. This document does not provide any warranty or 

permission for industrial properties or any rights to grant 

license lawfully and without infringement. 

 

 



PREFACE 

 

We thank you for purchasing the Hitachi High-Technologies Corporation 

fluorescence spectrophotometer. 

The instrument is intended for fluorescence analysis and should not be 

used for other purposes. 

The fluorescence spectrophotometer is designed for use by 

persons having a basic knowledge of chemical analysis.  Keep in 

mind that improper use of analytical instruments, chemicals or 

samples would result not only in wrong analytical results but also 

in consequences adverse to safety and possibly personal injury. 

Be sure to read this manual thoroughly before use to ensure correct use 

of the instrument. 

Carefully read and understand all of the safety instructions prior to 

operation or maintenance of the instrument. 

This manual should be kept at hand so it can be referred to whenever 

needed. 

The contents of this manual are subject to change without prior notice 

for improvement. 

 

 

ABOUT THIS MANUAL 

 

The Hitachi High-Technologies Corporation fluorescence 

spectrophotometer is accompanied by the following two instruction 

manuals. 

• F-7000 Fluorescence Spectrophotometer Instruction Manual – 

Maintenance Edition 

• F-7000 Fluorescence Spectrophotometer Instruction Manual – FL 

Solutions Program - Operation Edition 

The cautionary instructions concerning safety are also contained in the 

maintenance edition of the instruction manual.  Be sure to read them 

before attempting use. 

This manual describes the operational procedures for the FL Solutions 

program formulated for the Hitachi High-Technologies Corporation 

fluorescence spectrophotometer.  

Be sure to read through this manual before attempting operation. 
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IMPORTANT  

 

Precautions on CE Conformity Marking 

 

1.  Electromagnetic Compatibility Requirement 

 

This equipment conforms to the EMC Directive 89/336/EEC and has the 

CE conformity marking.  It is designed to satisfy the European Norm 

EN61326 (1997) and its amendment 1 (1998) & amendment 2 (2000). 

 

This equipment is classified as Class A of EN61326.  So, this 

equipment must not be used in domestic establishments nor in 

establishments directly connected to a low voltage power supply 

network which supplies buildings used for domestic purpose.  

 

And this equipment is also designed to comply with table 1 “Minimum 

immunity test requirements” and with evaluation table 2 “Continuous 

unmonitored operation”.  If the equipment is used near an intense 

electromagnetic source, however, interfering noise may be given to the 

instrument to cause an adverse effect on its performance or 

functionality. 

 

2.  Safety Requirement 

 

This equipment also conforms to the LVD Directive 73/23/EEC and has 

the CE conformity marking.  Its is designed to satisfy the European 

Norm EN61010-1: 2001. 

Since this instrument is classified in class 1, pollution degree 2 of 

EN61010-1, be sure to use it in a suitable environment and ground it 

appropriately.  
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Information for Users on WEEE (only for EU Countries) 

 

This symbol is in compliance with the Waste Electrical and Electronic 

equipment directive 2002/96/EC (WEEE). 

This symbol on the product indicates the requirement NOT to dispose 

the equipment as unsorted municipal waste, but use the return and 

collection systems available. 

 

 

 

 

Information on Disposal for Users 

 

1.  In the European Union 

 

If you need to discard this product or discard user serviceable parts: 

Please contact your local sales representative or distributor who will 

inform you of the recycle of the product.  

You might be charged for the costs arising from take-back and recycling. 

 

2.  In other Countries outside the EU 

 

If you wish to discard this product, please contact your local authorities 

and ask for the correct method of disposal. 
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Warranty on Product  

 

The Hitachi fluorescence spectrophotometer is warranted to be free 

from defects in material or workmanship under normal use within the 

product specifications indicated in this manual and under conditions 

given below.  This warranty is void if the instrument is not used in 

accordance with the instruction manual.  

 

(1) Scope of Warranty  

 

This instrument will be repaired without charge if it malfunctions 

due to a defect in workmanship during the warranty period. 

Note that a substitute part may be used for repair, or replacement 

with an equivalent product may be made instead of repair.  

Such system components as a personal computer and printer to be 

updated frequently for improvement may not be available in original 

versions at the time of replacement.  

In addition, the instrument resold without consulting Hitachi, 

consumables and failure of parts that have reached the end of 

specified useful life are excluded from the warranty. 

 

(2) Warranty Period  

 

One year from the date of initial installation  

(Excluding consumables such as a xenon lamp)  

 

(3) Limitations and Exclusions on Warranty  

 

Note that the following cases are excluded from the scope of this 

warranty.  

(a) Failure due to operation at a place not meeting the installation 

requirements specified by us.  

(b) Failure due to power supply voltage/frequency other than 

specified by us or due to abnormality in power supply.  

(c) Corrosion or deterioration of the tubing due to impurities 

contained in gas, air or cooling water supplied by the user.  

(d) Corrosion of the electric circuits or deterioration of the optical 

elements due to highly corrosive atmospheric gas.  

(e) Failure due to use of hardware, software or spare parts other 

than specified by us.  

(f) Failure due to improper handling or maintenance by the user.  

(g) Failure due to maintenance or repair by a service agent not 

approved or authorized by us.  
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(h) Failure due to relocation or transport after initial installation.  

(i) Failure due to disassembly, modification or relocation not 

approved by us.  

(j) Failure due to acts of God, including fire, earthquake, storm, 

flood, lightning, social disturbance, riot, crime, insurrection, 

war (declared or undeclared), radioactive pollution, 

contamination with harmful substances, etc.  

(k) Failure due to computer virus infection.  

 

WE MAKE NO WARRANTIES, EITHER EXPRESS OR IMPLIED, 

EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT 

LIMITATION THEREOF, WARRANTIES AS TO MARKETABILITY, 

MERCHANTABILITY, FOR A PARTICULAR PURPOSE OR USE, 

OR AGAINST INFRINGEMENT OF ANY PATENT.  IN NO 

EVENT SHALL WE BE LIABLE FOR ANY DIRECT, INCIDENTAL 

OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR 

LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE 

PRODUCT OR THE USE OF ANY PRODUCT.  

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY 

US, OUR DEALERS, DISTRIBUTORS, AGENTS OR 

EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY 

INCREASE THE SCOPE OF THIS WARRANTY.  

HITACHI HIGH-TECHNOLOGIES CORPORATION ASSUMES NO 

LIABILITY FOR ANY DAMAGE TO DATA OR APPLICATION 

SOFTWARE ACCOMPANYING DAMAGE OF THE INSTRUMENT. 

 

(4) About the Warranty Card 

 

Be sure to keep the warranty card in a safe place, since it will not 

be re-issued. 

 

 

Installation, Relocation and After-sale Technical Service  

 

Installation of the instrument shall be carried out by or under supervision 

of our qualified service personnel or our authorized service agent.  

Before installation of the instrument, the customer shall make 

preparations for satisfying the installation requirements in accordance 

with this manual.  

When relocation of the instrument becomes necessary after initial 

installation (delivery), please notify our local sales representative or 

service office nearest you.  
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Technical Seminars and Training for Customers  

 

For the customers to acquire in-depth understanding of the analytical 

instruments, technical seminars and customer training courses are 

available at our or your site.  For further information, contact our local 

sales representative.   

(The technical seminars and customer training courses are available at 

charge.)  

 

 

Precautions on Disposal of Instrument 

 

Although at present this instrument does not use materials that would 

directly cause environmental disruption, the environmental protection 

laws and regulations may be revised or amended.  When disposing of 

this instrument, be sure to check the latest issues of the relevant laws 

and regulations or consult your local Hitachi High-Technologies 

Corporation service office. 
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Other Precautions  

 

Handling of Chemicals and Samples  

 

(1) The user is responsible for following relevant legal standards and 

regulations in the handling, storage and discarding of chemicals 

and samples used in analytical operations of the instrument.  

 

(2) Reagents, standard solutions and accuracy-control samples shall 

be handled, stored and discarded as instructed by the respective 

suppliers.  

 

 

Notice on This Instruction Manual  

 

(1) The information contained in this manual is subject to change 

without notice for product improvement.  

 

(2) This manual is copyrighted by Hitachi High-Technologies 

Corporation with all rights reserved.   

 

(3) No part of this manual may be reproduced or transmitted in any 

form or by any means without our express written permission.  

 

 

Trademark Acknowledgments  

 

Microsoft, Windows, Microsoft Excel, Microsoft Word, and Windows XP 

are registered trademarks of Microsoft Corporation USA.  

All other brand names and product names used in this manual are 

trademarks, registered trademarks, or trade names of their respective 

holders.   
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SAFETY SUMMARY 

 

 

 

 

 
PRECAUTIONS ON SAFETY 

 

Before using the F-7000 fluorescence spectrophotometer, be sure to 

read the following safety instructions carefully. 

 

 

     General Safety Guidelines 
 

• Follow all the operating procedures provided in this manual. 

• Installation and maintenance of this instrument shall be carried 

out by service personnel qualified for this purpose. 

• Be sure to observe the warnings indicated on the product and in the 

instruction manual.  Failure to do so could result in personal injury 

or damage to the product. 

• The hazard warnings which appear on the warning labels on the 

product or in the manual have one of the following alert headings 

consisting of an alert symbol and signal word DANGER, WARNING, 

or CAUTION. 

 

DANGER : Indicates an imminently hazardous situation 

which, if not avoided, will result in death or 

serious injury.  

(This warning does not apply to this product.) 

WARNING : Indicates a potentially hazardous situation 

which, if not avoided, can result in death or 

serious injury. 

CAUTION : Indicates a hazardous situation which, if not 

avoided, will or can result in minor or 

moderate injury, or serious damage to the 

product. 

 : The alert symbol shown at left precedes 

every signal word for hazard warnings, and 

appears in safety-related descriptions in the 

manual. 

 

“NOTE” and “NOTICE” are heading words which do not concern 

personal safety directly. 
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SAFETY SUMMARY 

 

 

 

 

 

     General Safety Guidelines (Continued) 
 

NOTICE : Used to indicate an instruction for preventing damage 

to the product. 

NOTE : Used to indicate an instruction for ensuring correct 

use of the product and accurate analysis therewith. 

 

 

• Do not modify the instrument, replace parts that are not user-

serviceable, use non-specified parts, nor remove safety devices, as it 

could be hazardous.  

• Installation at delivery, maintenance and relocation should be 

referred to service personnel qualified by us.  

• Do not perform any operation or action other than described in this 

manual.  When in doubt, please contact our local sales 

representative or service office nearest you.  

• When using a chemical for analytical operation, be sure to provide 

proper ventilation in the laboratory room as per local requirements.  

Inadequate ventilation could endanger your health.  

• Keep in mind that the hazard warnings in this manual or on the 

product cannot cover every possible case, as it is impossible to 

predict and evaluate all circumstances beforehand.  

Be alert and use your common sense.  
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SAFETY SUMMARY 

 

 

 

 

 

Safety Notices on Fluorescence Spectrophotometer  
 

Electricity  

 

• Make sure that the fluorescence spectrophotometer is supplied with 

power of 100 V AC, 700 VA or more (50 Hz or 60 Hz).  If the power 

voltage fluctuates or noise is applied to the power line, the 

spectrophotometer may be adversely affected, resulting in any 

trouble in it.  

• Be sure to provide grounding connection together with power line 

connection.  The grounding resistance should be 100 ohms or less.  

Check that the grounding connection is proper.  If the grounding 

connection is improper, the spectrophotometer may become 

vulnerable to external noise or stray voltage may be produced in it, 

resulting in an electric shock hazard.  

• The high voltage circuit is used inside the spectrophotometer.   

To prevent electric shock, do not open covers during operation 

unless otherwise necessary.  

 

 

Source of Heat/Flame  

 

Do not smoke or hold a flame near the fluorescence spectrophotometer.  

 

 

Data Backup  

 

Data stored on the hard disk may become unusable due to a system 

failure, wrong operation, computer virus infection, etc.  To ensure data 

integrity in case of accidental damage to the hard disk, periodically 

make backup copies of hard disk files onto floppy disks.  

To prevent an erroneous operation on the hard disk, always reserve 

approx. 100 MB of free space as a working area for application software.  
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SAFETY SUMMARY 

 

 

 

 

 

Protection against Computer Viruses  

 

If any program/data is damaged suddenly or an unexpected 

operation/screen is encountered, the personal computer is suspected of 

being infected by a computer virus.   

Computer viruses are malicious programs that sneak into personal 

computers to cause misbehavior or damage to data.  And, a program 

designed to offer protection against computer viruses is called a vaccine 

program.  

 

Possible causes of virus infection are:  

• Downloading a virus-laden program through communication.  

• Using a floppy disk or other storage medium infected by a virus.  

 

Note also that once any personal computer is infected by a virus, it may 

spread to other computers via communication or storage medium.  

Never use a program or storage medium that is suspected of 

containing a virus.  

If there is a possibility of virus infection, check for a virus using a 

vaccine program.  Note, however, that some kinds of vaccine programs 

cannot eradicate particular viruses.  So, be sure to make a backup of 

hard disk files beforehand.  

The user is requested to prepare a vaccine program and carry out virus 

removal on his or her own responsibility.  

 

 

Power Interruption  

 

On occurrence of momentary power voltage drop due to power 

interruption or lightning, the personal computer may become faulty or 

the system software, application software or data may be damaged.  

For protection against momentary power voltage drop, it is advisable to 

use an AC uninterruptible power supply unit (stated according to the 

Japanese Electronic Industry Development Association guidelines for 

protection against momentary power voltage drop in personal 

computers).  
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SAFETY SUMMARY 

 

 

 

 

 

Turning On/Off Personal Computer  

 

Do not turn off power to the personal computer while the hard disk or 

floppy disk drive is active.  If power to the personal computer is turned 

off while the hard disk or floppy disk is being accessed, the personal 

computer may become faulty or data/software stored in it may be 

damaged.  

Before turning off power to the personal computer, be sure to quit the 

fluorescence spectrophotometer control/data processing program (FL 

Solutions program) first and then take the shut-down procedure using 

the system software.  
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1.  FUNCTIONS AND SCREEN COMPOSITION  

 

1.1  Functions  
 

In this program, the following measurement modes are available:  

• Wavelength scan  

• Time scan  

• Photometry  

• 3-D scan  

• 3-D time scan 

 

Wavelength Scan 

 

(1) Photometric value data can be printed at the specified wavelength intervals or at up to 12 

specified wavelengths.   

 

(2) The function keys provide functions unique to the wavelength scan mode.  

Measurement:  [F4],  Stop:  [F6]  

 

(3) Wavelength scan measurement can be repeated max. 99 times.  And, a repetition period is 

settable.  

 

Time Scan 

 

(1) Kinetics, or rate calculation will be performed.  

 

(2) Photometric value data can be printed at the specified time intervals or at up to 12 specified 

time points. 

 

Photometry 

 

(1) Quantification method is selectable among specified wavelength, peak area, peak height, peak 

ratio and derivative methods.   

Up to 20 standards can be measured.  A calibration curve is prepared by drawing polygonal 

lines through each point of standard concentrations or a regression calibration curve is prepared 

by least squares.  It is also possible to measure up to 20 standards and prepare a calibration 

curve based on an average value of standard concentrations.   

 

(2) A calibration curve can be redrawn by re-measuring a specific standard.  In a calibration curve 

graph on the screen window, a value at each point can be read out using the cursor.  

 

(3) A calibration curve can be printed.  

A calibration curve can be drawn by inputting its factor value.  
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(4) Measurement data and a calibration curve are displayed on the same screen window.  It is 

therefore possible to carry out measurement while observing the calibration curve.  

 

(5) According to the coefficient of determination calculated automatically, judgment can be made on 

a degree of matching between standard values and a calibration curve.   

Two/three-wavelength calculation is permitted in preparation of a calibration curve.  

 

(6) Statistical calculation is possible.  

Mean value of measured data and standard deviation (SD) can be calculated.  

 

(7) Upper/lower limit judgment will be performed.  

 

(8) Spectrum display under photometry  

In the data measured by a quatification method; peak height, peak area, peak ratio or derivative, 

a spectrum due to wavelength scan is displayable.  

 

3-D Scan 

 

(1) Spectral calculation can be performed using the measured data.  

 

(2) A peak table can be displayed.  

 

(3) A bird’s-eye view/synchronous spectrum can be displayed and printed.  

 

(4) Printing conditions are selectable.  

In use of the DDE function, the wavelength interval and start/end wavelengths of data list can 

be selected.  

 

3-D Time Scan 

 

(1) A peak table can be displayed. 

 

(2) A bird’s eye view/contour lines can be displayed and printed. 

 

(3) Printing conditions are selectable. 

 



1.1 

1 - 3 

Secondary Processing of Data 

 

Measured data can be saved, and a variety of processings can be carried out on the saved data.  

 

(1) Automatic reading of data (spectrum tracing)  

By placing the cursor on the currently displayed spectral graph, a photometric value at the 

cursor position can be read out.  

 

(2) Peak detection  

Peaks and valleys of the currently displayed spectrum are detected automatically.  

 

(3) Change of scale  

A measured spectrum can be enlarged or reduced by changing the ordinate and abscissa 

scales.  

 

(4) Smoothing  

A measured spectrum can be smoothed for elimination of noise components.  

 

(5) Derivative  

Spectral derivative is obtainable.  It is permitted to specify an order of derivative, that of 

smoothing and a count value of data.  

 

(6) Spectrum calculation  

Fundamental arithmetic operations can be made between spectra or a spectrum can be 

multiplied with a factor.  

 

(7) Area  

The area value of the specified peak will be calculated.   

The average area value is also calculable among peaks.  

 

(8) File conversion  

Measurement data can be converted into an ASCII text file (*.txt) or JCAMP-DX file (*.dx).  It is 

also possible to save a spectrum and calibration curve graph in a Windows meta file (*.wmf).   

 

(9) Display/print font setting  

The font, style and size of characters to be displayed and printed can be changed as desired.  

 

(10) Data acquisition  

Photometric value data on the data processing window and monitor window can be acquired.  

Acquisition is allowed within 100 data.   

 

(11) Printing items collectively specifiable  

Printing items on overlaid spectra can be specified collectively.  

 



1.1  Functions 

1 - 4 

(12) Specification of printing items  

Items in a peak table can be selected and printed.  

 

(13) Portrait or Landscape printing settable  

Printing can be made Portrait or Landscape.   

 

(14) Collective spectrum printing  

Printing can be carried out just by specifying a file.  

 

(15) Selection of spectrum to be displayed  

The spectrum to be displayed for overlaying is selectable.  

 

(16) Automatic saving mode ON/OFF settable  

ON/OFF can be set in the sample name/comment input window.   

Automatic saving is effective in all the modes that use a sample table.  

 

(17) Data in each mode can be transferred to Microsoft® Excel.  

(This is valid when Microsoft® Excel 2003 has been installed in PC.)  

 

(18) After copying spectral data into commercial software such as Microsoft® Word, its scale, line 

type, color, etc. are changeable on the software.  

 

(19) The report generator (separately available, P/N 250-0455) can be used.  
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1.2  Installation of FL Solutions Program  
 

1.2.1  Specifications of Personal Computer 

 

For running the FL Solutions 2.1 program on Microsoft Windows XP Professional, the following 

specifications must be met.  

 

OS : Microsoft Windows XP Professional  

CPU : CPU that allows the above OS to run in your computer  

Main memory : Minimum 256 MB  

Hard disk : Minimum free space 5 GB  

FD drive : One 3.5-inch FD drive  

CD-ROM drive : 24× or faster  

Interface : USB1.1 or USB2.0 × 1 or more, RS-232C × 1 or more  

 

 

1.2.2  Setup of FL Solutions Program 

 

For installing this program, implement the following procedure.  

 

 

Fig. 1-1  

 

1 Click the start button of Windows 

XP and select “Control Panel”.  

• A window as shown in Fig.  

1-2 will appear.  

 

 

1 
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Fig. 1-2  

 

2 Select “Add or Remove 

Programs.”  

• A window as shown in Fig.  

1-3 will appear.  

 

 

 

Fig. 1-3  

 

3 Select “Add New Programs.”  

• A window as shown in Fig.  

1-4 will appear.  

 

 

Fig. 1-4  

4 Set the furnished CD in the CD-

ROM drive and click CD or 

Floppy.  

• A window as shown in Fig.  

1-5 will appear. 

 

2

3 

4
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Fig. 1-5  

 

5 Click Next. 

• A window as shown in Fig.  

1-6 will appear.  

 

 

Fig. 1-6  

 

6 Make sure ‘D:\setup.exe’ is 

displayed, and then click Finish.  

• A window as shown in Fig.  

1-7 will appear.  

 

 

Fig. 1-7 

7 Click Next.  

• A window as shown in Fig.  

1-8 will appear.  

 

5

6 

6

7
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Fig. 1-8  

 

8 Click Next.  

• A window as shown in Fig.  

1-9 will appear.  

 

 

Fig. 1-9  

 

9 Installation starts.  

• Upon completion of 

installation, a window as 

shown in Fig. 1-10 appears.  

 

 

Fig. 1-10  

10 For placing the shortcut of this 

program on the desktop, put the 

check mark in this check box.   

If you do not want to place it, 

remove the check mark.  

11 Click Finish.  

12 Take out the CD from the CD-

ROM drive.  

 

8

10

11



1.2.3 

1 - 9 

1.2.3  Reinstallation of this Program  

 

Before reinstallation, the existing program needs to be deleted.   

Carry out the following procedure for deleting the program.  

 

 

Fig. 1-11  

 

1 Select [Start]-[Control 

Panel] and double-click the 

“Add or Remove Programs” 

icon.   

A window as shown in Fig. 

1-11 will open.  

2 Among the currently 

installed programs, select 

“FL Solutions for F-7000” 

and click Change/Remove.  

After removal, click Finish.  

Then, install the FL 

Solutions 2.1 program.  

 

2
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1.2.4  Setup of USB Driver  

 

After system setup for FL Solutions, the USB driver needs to be set up for communication with the 

Model F-7000.   

 

 

Fig. 1-12 

 

1 Connect a USB 

communication cable and 

turn on the power switch of 

F-7000.   

2 “Found New Hardware” 

appears at the bottom right 

of screen, and then a wizard 

begins.  

 

Fig. 1-13 

 

3 Select ‘Install from a list or 

specific location 

(Advanced).’  

4 Click Next.  

 

 

 

Fig. 1-14 

5 Put check mark at [Include this 

location in the search].  

6 Click Browse and specify the 

directory in which FL Solutions is 

set up (usually C:\Program 

Files\FL Solutions).  

7 Click Next.  

 

3 

4

6

7

5 
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Fig. 1-15 

 

 

Fig. 1-16 

 

8 A window for indicating the 

installing status will appear.  

Wait until the installation is 

completed.  When the wizard 

end window appears, click 

Finish.  

 

8
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1.3  Startup of FL Solutions Program  
 

To start up the FL Solutions 2.1 program, carry out the following procedure.  

 

 

 

 

Fig. 1-17 

 

1 Make sure the standard-

equipped communication 

cable (USB cable) is 

connected between the 

fluorescence 

spectrophotometer and the 

personal computer (PC).  

2 Turn on the PC power 

supply and wait until 

Windows XP starts.  

3 After completion of PC start, 

turn on power supply to the 

spectrophotometer main 

unit.  

 

 

NOTE: If power supply to the spectrophotometer 

main unit is turned on before PC start, USB 

connection cannot be recognized, so 

communication will be disabled.  If this 

occurs, you should restart the PC with the 

spectrophotometer power supply turned off, 

and then turn on that power supply. 

 

1 

3 2
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Fig. 1-18 

 

4 The FL Solutions 2.1 program 

can be started by either method 

below.   

Use a desired method.  

(1) Usually, this program is 

started by double-clicking 

the “FL Solutions 2.1 for  

F-7000” icon on the desktop.  

 

 

Fig. 1-19 

 

(2) The other method 

begins with clicking the 

start button at the 

bottom left corner of 

desktop.  Next, point 

to All Programs and 

Hitachi FL 

Spectrophotometer, 

and then select FL 

Solutions 2.1 for  

F-7000.  

 

 

Fig. 1-20 

5 The computer now recognizes 

the fluorescence 

spectrophotometer connected to 

it and displays a window as 

shown in Fig. 1-20.   

Then, the FL Solutions 2.1 

program is launched 

automatically.  

 

4 

5
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Fig. 1-21 

 

 

NOTE: If the spectrophotometer is not connected 

with the communication port or its power is 

not turned on, the monitor window (“F-7000 

Fluorescence Spectrophotometer on USB” 

indicated on its title bar) is not presented.  

In this status, functions for other than 

measurement are usable.   

For measurement, first confirm connection 

of the cable, and then turn on power supply 

of the spectrophotometer.  Next, select the 

Instrument command from the Tools menu.  

When selecting and connecting the 

spectrophotometer, the window shown in 

Fig. 1-21 is presented. 

 

 

 

Fig. 1-22 

 

6 A gauge of initialization is 

displayed as shown in Fig. 1-21, 

so its progress can be checked 

visually.   

In execution of initialization, self-

diagnosis is performed on the 

following items.  

• ROM 

• RAM  

• Wavelength drive system  

• Xenon lamp turn-on  

• Slit mechanism  

• Chopper  

• Contents of wavelength and slit 

calibration values  

If an abnormality is found in the self-

diagnosis, the relevant error message 

will be displayed (Fig. 1-22).   

In this case, a corrective measure 

should be taken, referring to Appendix 

J.   

If necessary, notify our local service 

office.  

 

 

6
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Fig. 1-23 

 

 

NOTE: A sample should be set after “Ready” 

appears.   

If the lid of sample compartment is opened 

or closed in the “Initializing” or “Parameter” 

status, zero point may not be set exactly.  

In this case, perform zero-point adjustment 

again.  

 

7 On completion of initialization, 

the window shown in Fig. 1-23 is 

displayed.  

When “Ready” appears, 

measurement can be started.  
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1.4  Screen Composition  
 

1.4.1  Basics of Window Operation  

 

This manual contains multiple methods for executing a function.  For implementing each method, 

explanation is given using the naming described below.  

 

 

 

Fig. 1-24  Menu Bar and Command (step ①) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1-25 Example Help Display for Measure 

Command (step ②) 

 

1 Menu bar  

• Menu bar is a bar on which menus such 

as “File” and “Edit” are arranged.  

2 Command  

• Commands are contained in each 

menu.  

In the case shown in Fig. 1-24, an 

expression of “Measure command of 

Spectrophotometer menu” is used.  

• A menu or command is selectable by 2 

methods.   

◊ Move the mouse pointer to a menu 

and click it.  

◊ Key in the alphabetic letter after a 

menu name with the Alt key held 

down.  Then, key in the alphabetic 

letter after a command name.  

• Explanation of a command function can 

be displayed in the following procedure.  

① Click the  (Help) button.  

The mouse pointer is now turned 

into .  

② Move the mouse pointer  to a 

menu and click the left mouse 

button.  (See Fig. 1-25.)  

1 

2 
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Fig. 1-26 Example Help Display for Measure 

Command (step ③) 

 

 

Fig. 1-27 Example Help Display for Measure 

Command (step ④) 

 

③ When the menu is displayed, move 

the mouse pointer  to the 

target command and click the left 

mouse button.  (See Fig. 1-26.)  

④ The help message for the selected 

command is now displayed.   

(See Fig. 1-27.)  

 

 

 

Fig. 1-28  Toolbar 

 

3 Toolbar  

• Toolbar is a row of tool buttons such as 

.  

4 Tool button  

• Tool buttons are provided for executing 

the functions of the respective 

commands.   

• In using the  button, it is expressed 

as “  button of Measurement 

toolbar” or “  (analytical condition) 

button.”  

• For details of each button, refer to 1.4.4.  

 

4

3
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Fig. 1-29  Dialog Box 

 

5 Dialog box  

• When you click the  button of 

Measurement toolbar, a small window 

as shown in Fig. 1-29 is presented.  

This window is called a “dialog box.”  

 

 

 

Fig. 1-30  Tab 

 

6 Tab  

• Tabs are used in the Analysis Method 

and Properties windows.  

• Click a tab for changing display.   

Each tab contains setting items.   

The display shown in Fig. 1-30 is 

expressed as “Instrument tab.”  

 

 

Fig. 1-31  Combo Box and Spin Button 

 

7 Combo box  

• Selection is allowed among the 

predetermined conditions.   

Click  for selecting the desired 

condition.  

8 Spin button  

• This button is used for inputting a 

numeral.  Click  or  for 

setting a numeral.  However, a 

value below decimal point cannot 

be set.  Such a value must be 

input with the keyboard.  

 

5 

6 

7

8
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Fig. 1-32  Check Box 

 

9 Check box  

• For turning on a check box, put a 

check mark in it by clicking.  

• The check box is then set in the 

 status.  

• For turning off the check box, click 

it again to remove the check mark.  

 

9 
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1.4.2  Kinds of Windows  

 

The FL Solutions 2.1 program has two kinds of windows: monitor window and data processing window.  

 

 

Fig. 1-33  Monitor Window 

 

1 Monitor window 

Set the monitor window active for 

measurement.  

• The toolbar is now turned into the 

one for this window.  

 

 

Fig. 1-34  Data Processing Window  

 

2 Data processing window  

Set the data processing window 

active for data processing.  

• The toolbar is now turned into the 

one for this window.  

 

 

1 

2
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1.4.3  Data Processing Window  

 

The items displayable in each measurement mode are shown below.  

 

 

Fig. 1-35  Wavelength Scan 

 

1 Wavelength scan  

• A spectrum alone can be 

displayed or both spectrum (①) 

and peak table (②) can be 

displayed as shown in Fig. 1-35.   

• Display of the peak table can be 

turned ON/OFF by the “Peak 

Table” command in the View 

menu.  

 

 

Fig. 1-36  Time Scan (kinetics result table) 

 

2 Time scan  

• A spectrum alone can be 

displayed or both spectrum (③) 

and kinetics result table (④) can 

be displayed as shown in Fig. 1-36.  

 

 

 

Fig. 1-37  Time Scan (peak table) 

 

• Both spectrum (③) and peak table (⑤) 

can be displayed as shown in Fig. 1-37.  

• Display of the kinetics result table or 

peak table can be turned ON/OFF by 

the “Kinetics” or “Peak Table” command 

in the View menu.  

 

1

2 

3

4 

5 

3



1.4  Screen Composition 

1 - 22 

 

 

Fig. 1-38 

 

3 Photometry  

• On start from measurement for a 

calibration curve, a window as shown in 

Fig. 1-38 will appear.  

Standard data (⑥)  

Calibration curve (⑦)  

Sample data (⑧)  

Calibration curve data (⑨)  

 

 

Fig. 1-39  

 

• On sample measurement with a 

calibration curve generated 

through factor input, a window as 

shown in Fig. 1-39 will appear.  

Sample data (⑩)  

Calibration curve factor (⑪)  

 

 

Fig. 1-40  

 

• On measurement of the 

photometric value at each 

wavelength in multi-wavelength 

mode, the sample data is 

displayed as listed in Fig. 1-40.  

Sample data (⑫) 

 

 

9

76 

8 
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1.4.4  Explanation of Tool Buttons  

 

The FL Solutions 2.1 program provides five kinds of toolbars as shown below.  You can also select a 

command by pulling down each menu from the menu bar.  But for quick and easy operation, it is 

advisable to use these tool buttons.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1-41  Toolbars 

 

Standard toolbar 

Has buttons related to printing and file 

handling. 

Instrument toolbar (displayed in monitor 

window) 

Has buttons related to 

spectrophotometer control such as 

wavelength drive and automatic pre-

scanning. 

Measurement toolbar (displayed in monitor 

window) 

Has buttons related to measurement 

such as analysis method setting and 

sample name input. 

Spectrum toolbar (displayed in data 

processing window) 

Has buttons related to spectral display 

such as auto scaling, ruled line 

indication and spectrum tracing. 

Processing toolbar (displayed in data 

processing window) 

Has buttons related to data processing 

such as smoothing and differentiation. 

 

 

 

Fig. 1-42  An Example of Toolbar Arrangement  

1 These five toolbars are independent 

and each of them can be located at a 

desired position as shown in Fig. 1-42 

(monitor window).  

 

 

1
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The following tables present the functional descriptions of the buttons on each toolbar.   

The function keys on the keyboard can also be utilized for the same purpose.  For the functional 

assignment to each function key, refer to 1.5.  

 

Table 1-1  Standard Toolbar  

 

Button Function Button Function 

 
Creates a new analysis 
method/sample table.  

Opens the print window. 

 

Opens data files. 

 

Indicates the present status of 
the connected 
spectrophotometer. 

 

Opens a data file in the print 
preview mode. 

 

Indicates the information (version 
number, etc.) on the FL 
Solutions program. 

 

Saves the current file. 

 

Calls up the help window. 

 

Stores a selected character string 
or graphic item into the clipboard.  

Brings the monitor window to the 
forefront. 

 
Pastes the contents of the 
clipboard. 

  

 

 

Table 1-2  Measurement Toolbar 

 

Button Function Button Function 

 
Opens the Analysis Method 
window.  

Starts measurement. 

 
Displays the same name/comment 
entry window.  

Stops measurement. 

 

Displays the sample table. 
 

Closes the shutter. 

 

For manual input of standard 
sample values.  

Opens the shutter. 

 
Executes pre-scanning.   
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Table 1-3  Spectrum Toolbar  

 

Button Function Button Function 

 

Restores the scale to its original 
condition.  

For display in a contour map. 

 

Indicates ruled lines. 

 

For display from the front. 

 
Indicates a bird’s-eye view. 

 
For display from the left. 

 
For display from the rear. 

 
Automatically sets the scale. 

 

For display from the right side. 

 

Displays a dialog box to allow 
change of sample 
name/comment. 

 

Selects a spectrum to be 
displayed. 

 

Sets a mode for expansion of 
contour scale.  For this 
expansion, click this icon and 
drag the area to be enlarged with 
the mouse. 

 
Indicates the trace cursor.   

 

 

Table 1-4  Instrument Toolbar  

 

Button Function Button Function 

 
Performs wavelength drive. 

 

Restores the scale to its original 
condition. 

 

Performs automatic pre-scanning.  
This is a function for automatic 
search of the optimum excitation 
and emission wavelengths for a 
sample. 

 

Adopts auto scale for vertical-
axis display so that you can view 
the entire spectral graph. 

 

Conducts zero-point adjustment. 
Zero point with the shutter closed 
is adjustable.  Effective for 
higher-accuracy measurement. 

 

Indicates ruled lines. 

 
Enlarges the vertical axis double. 

 

Magnifies the present data and 
status. 

 
Reduces the vertical axis to half.   
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Table 1-5  Processing Toolbar  

 

Button Function Button Function 

 
Opens the Spectrum Properties 
window.  

Performs fundamental arithmetic 
calculations between spectra. 

 
Outputs a report of data file. 

 
Calculates the life of 
phosphorescence. 

 
Performs peak detection. 

 
Performs smoothing. 

 
Performs differentiation. 

 
Resets data. 

 

Performs peak detection in 3-
dimensional measured data. 

 

Performs fundamental arithmetic 
calculations of 3-dimensional 
spectra. 

 
Performs area calculation.   
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1.5  Functions of Function Keys  
 

The function keys on the keyboard provides the following functions.  

Each function can be executed directly.  

 

Key No. 
Wavelength 
Scan 

Time Scan Photometry 3-D Scan 
3-D Time 
Scan 

[F4] Measurement Measurement Sample 
measurement 

Measurement Measurement

[F5]   Blank 
measurement 

  

[F6] Stop Stop Stop Stop Stop 

[F7]   Interrupting 
measurement 

  

[F8]   Re-
measurement 

  

[F9]   End   
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1.6  Explanation of Monitor Window  
 

 

 

 

Fig. 1-43  

 

1 Sample name indication  

A sample name is indicated.  For its input, 

use the sample table or sample 

name/comment input window.  

2 Current photometric value indication  

The current photometric value is indicated.  

3 EX  

The current excitation wavelength is 

indicated.  

4 EM  

The current emission wavelength is 

indicated.  

5 EX slit 

The current excitation slit width is indicated.  

6 EM slit  

The current emission slit width is indicated.  

7 Shutter  

Open or closed state of the shutter is 

indicated.  

8 Lamp  

ON/OFF state of the light source lamp is 

indicated.  

9 Shutter control  

The active state of shutter control is 

indicated.  

10 Corrected spectra  

Setting of spectrum correction is indicated.  

11 Sample 

The number assigned to the sample under 

measurement is indicated.  

12 Replicate count  

A count in repeated measurement is 

indicated. 

2
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 13 Message indication  

A status message such as “Ready,” 

“Scanning” or “Parameter” is presented.  

In the “Ready” status, the  

(measurement) button can be clicked.  

14 Error message indication  

An error message “Xe lamp” is presented.  

If any error message appears, take a 

proper countermeasure, referring to 4.7 of 

the maintenance edition.  
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1.7  Input of Spectrophotometer Serial No.  
 

The serial No. of the presently connected F-7000 fluorescence spectrophotometer can be displayed 

for its confirmation.  

Select the Instrument command from the Tools menu or click the  button.  The dialog box shown 

in Fig. 1-44 opens.  The serial No. of the connected F-7000 fluorescence spectrophotometer can be 

checked here.  

 

 

 

Fig. 1-44  
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1.8  Window Setting  
 

The information to be displayed upon starting the FL Solutions 2.1 program or opening the data 

processing window can be selected here by excluding unnecessary one from display.  

 

 

Fig. 1-45  Options Setting Window 

 

1 Select Options command from the 

Tools menu.  

2 The Options setting window is now 

displayed.  In this window, the 

following settings can be made.  

After your setting, click OK.  

• The set functions are validated 

when starting the monitor window 

again or opening the data 

processing window.  

 

The Options setting window has the 

following tabs.  

Display tab 

Fonts tab  

Processing tab  

Colors tab  

Startup tab 

Sensitivity Slits tab  

Analysis condition tab  

Report tab  
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1.8.1  Display Tab  

 

Items to be displayed when opening a saved data file or data immediately after measurement can be 

set here.  Those items can also be set by tool buttons or View menu after measurement.  

For the settable range of each parameter, refer to Appendix I.  

 

 

Fig. 1-46  Display Tab 

 

1 Show trace display  

Put a check mark in this box, and the trace 

cursor appears to permit spectrum tracing 

when the data processing window is open.  

2 Show gridlines with increment  

When a check mark is put in this box, the 

contents of monitor and data processing 

windows will be displayed with ruled lines.  

The width of ruled line is selectable.  

3 Wavelength scan  

Items to be displayed on the data 

processing window open in the wavelength 

scan mode can be set.  

4 Time scan  

Items to be displayed on the data 

processing window open in the time scan 

mode can be set.  

5 3-D Scan  

Items to be displayed on the data 

processing window open in the 3-D scan 

mode can be set.  

6 Intracellular cation scan  

Items to be displayed on the data 

processing window open in the intercellular 

cation scan mode can be set.  

7 Intracellular cation spectrum  

Items to be displayed on the data 

processing window open in the intercellular 

cation spectrum mode can be set.  
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8 Polarization time scan  

Items to be displayed on the data 

processing window open in the polarization 

time scan mode can be set.  

9 Polarization spectrum  

Items to be displayed on the data 

processing window open in the polarization 

spectrum mode can be set.  
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1.8.2  Fonts Tab  

 

Display font, character size, etc. can be set.  

Printer font, character size, etc. are also settable.  

 

 

Fig. 1-47  Fonts Tab  

 

1 Display Font  

Font, character size, etc. in the 

spectrum area under display can be 

set.  

2 Printer Font  

Printer font is settable.  

3 Clicking Select presents a window as 

shown in Fig. 1-48.   

 

 

 

 

Fig. 1-48  Font Specification  

 

4 Set the desired font, style and size.   
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1.8.3  Processing Tab  

 

Initial parameters of data processing can be set.  For the settable range of each parameter, refer to 

Appendix I.  

 

 

Fig. 1-49  Processing Tab 

 

1 Area integration method  

An area integration method can be 

selected.  

2 Calibration  

A calibration curve formula to be used 

for the Photometry mode can be set.  

3 Peak table/Calculate peak area  

By means of a check mark, inclusion 

of the area calculation item in the 

peak table can be selected or avoided.  

4 Smooth  

The initial values of smoothing 

parameters can be set.  However, 

this setting will not be reflected on the 

parameters of Analysis Method 

window.  

5 Derivative  

With regard to derivative operation, 

the initial parameters of smoothing in 

an analysis method or to be carried 

out after measurement can be set.  
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1.8.4  Colors Tab  

 

The color of the spectrum to be overlaid is settable here.  Color 1 (bottom) is the color of the initial 

display.  

 

 

Fig. 1-50  Colors Tab  

 

1 Click Select….  

• A window as shown in Fig. 1-51 is 

presented.  

 

 

Fig. 1-51  Color Setting  

2 Select a basic color or custom color.  

3 If there is no basic color you want, click 

Define Custom Colors.  

• A window as shown in Fig. 1-52 is 

presented.  
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Fig. 1-52  Addition of Color  

 

4 Select hue, saturation, luminance, etc. and 

click Add to Custom Colors.  

5 Your color is then added to the custom 

colors.  So select it and click OK.  

 

5 4
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1.8.5  Startup Tab 

 

Analysis method to be taken upon start of the FL Solutions 2.1 program is settable here.  

 

 

Fig. 1-53  Startup Tab 

 

1 Restore last method used  

The method used last will be brought 

in.  

2 Auto Parameter File  

The specified method will be brought 

in.  

3 For specifying a method, click this 

button.  

• A window as shown in Fig. 1-54 is 

then presented.  

 

 

 

Fig. 1-54  

 

4 Specify a method file and click Open.  

The specified method file appears in 

Fig. 1-53.  
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1.8.6  Sensitivity Slits Tab  

 

 

Fig. 1-55  Sensitivity Slits Tab  

 

Sensitivity Slits  

A slit width is settable for sensitivity 

check.  

For sensitivity check, select the 

Sensitivity Check command from the 

Utility menu.  

 

 



1.8  Window Setting 

1 - 40 

1.8.7  Analysis Condition Tab  

 

For the settable range of each parameter, refer to Appendix I.  

 

 

Fig. 1-56  Analysis Condition Tab  

 

1 Integration time for current data  

An integration time for reading the 

current data by the Read Data 

command of Tools menu can be set.  

2 Change Instrumental Response 

Condition  

When this check box is turned on, the 

excitation slit, emission slit and 

photomultiplier voltage can be set on 

the instrument function measurement 

window.  

This window appears when clicking 

the Instrument Response command 

of Utility menu.  

 

 

1 
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1.8.8  Report Tab  

 

 

Fig. 1-57  Report Tab  

 

Data List Printing Direction  

The direction of data list printing (with 

constant line spacing) can be set.  

In case of vertical printing:  

Wavelength or time and photometric 

values will be printed vertically in 3 

rows.  

 

 

 

 

 

In case of horizontal printing:  

Wavelength or time and photometric 

values will be printed horizontally in 

3 rows.  That is, 3 data will be 

printed on each line.  
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1.9  Saving a Data File  
 

Data can or cannot be saved depending on setting.  So perform setting, referring to the table below.  

Setting in any of patterns ① to ⑤ is recommended.  

 

“Use sample table in analysis method” 
Setting 

ON OFF 

Sample name/comment input 
dialog 

� “Save file automatically 
after data acquisition” 

⎯ ON OFF 

Analysis Method - Monitor tab 

� “Open data processing 
window after data 
acquisition” 

ON OFF ON OFF ON OFF 

Display � × � × � × Result 

Saving Automatic Automatic Automatic Automatic Manual Impossible

Pattern ① ② ③ ④ ⑤ ⑥ 

 

Read � and × symbols in the Result - Display row as follows.  

� : Icons or data processing window is open immediately after measurement.  

× : The data processing window is not open immediately after measurement.  

 

 



1.10 

1 - 43 

1.10  Photometer Menu Commands  
 

The Spectrophotometer menu contains the following commands.  

• Set Wavelength  

• Auto Pre-scan  

• Zero Adjust  

• Shutter Open/Close  

 

Set Wavelength  

This command sets the excitation/emission wavelength to a specified wavelength.  

Click the Set Wavelength command or button, and the dialog box shown below will come up.  

 

 

 

Fig. 1-58  

 

 

Zero Adjust  

This command automatically closes the shutter and measures a zero point in detection.  When the 

zero point is changed, e.g., after variation of the photomultiplier voltage, automatic zero-point 

adjustment will be carried out.  

 

NOTE: If the lid of sample compartment is opened or closed during zero-

point adjustment, zero point may not be set exactly.  In this case, 

perform zero-point adjustment again. 

 

 

Auto Pre-scan  

This command automatically searches for the optimum excitation/emission wavelength for the sample 

under measurement.  Other peaks than the fluorescence peak (such as peaks of excitation scattered 

light and Raman spectrum) are ignored.  On completion of automatic pre-scanning, the optimum 

excitation/emission wavelength is indicated on the monitor window (in the current wavelength 

indication field detailed in 1.6).  

 

Shutter Open/Close  

This command is available for opening/closing the excitation beam shutter.  The current shutter state 

is indicated on the right side of the monitor window (⑨ in Fig. 1-43).  
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1.11  Utility Menu Commands  
 

The Utility menu contains the following command.  

• Instrument Response  

• Analog Output Gain  

• EX Power Monitor  

• Sensitivity Check  

• Lamp Usage  

• Lamp Off  

 

Instrument Response  

 

This command is used for spectral correction.  The spectral correction accessory kit (P/N 251-0126) 

needs to be prepared.  

 

Analog Output Gain  

 

Use this command for setting a data value corresponding to 1 V of analog output.  For details, refer to 

9.3.  

 

EX Power Monitor  

 

Use this command for checking output of the monitor detector.  When the EX Power Monitor is turned 

on (clicked), monitor value data is displayed regardless of measurement condition.  

 

Sensitivity Check  

 

Use this command for checking sensitivity.  You can check sensitivity/drift with this command.   

For details, refer to the maintenance edition.  

 

Lamp Usage  

 

Use this command for checking/resetting the usage period of the Xenon lamp.  A cumulative turn-on 

time of the Xenon lamp is indicated.  

 

 

 

Fig. 1-59  
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When the limit use time is exceeded, the following message appears.  

 

 

 

Fig. 1-60  

 

 

After lamp replacement, reset this indication.  For details, refer to the maintenance edition.  

 

Note: If the Model F-7000 power supply is turned on without starting up the PC, indication of the 

Xenon lamp turn-on time may not be updated correctly.   

 

Lamp Off  

 

Use this command for turning off the Xenon lamp.  

For turning on the Xenon lamp again, restarting the spectrophotometer is necessary.  
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1.12  Termination of FL Solutions Program  
 

After completion of measurement, shut down the instrument in the following procedure.  

 

1 From the File menu, select the Exit command.  

A window appears as shown below.  

 

 

 

Fig. 1-61  

 

 

2 For termination without turning off the light source lamp, select “Close the monitor window, but 

keep the lamp operating?”  

For termination after turning off the light source lamp, select “Close (Turn off) the lamp, then close 

the monitor window?”  

Click Yes, and the FL Solutions program will then be terminated.  

3 Turn off the power switch of the spectrophotometer main unit.  

4 Click the start button of Windows XP, select “Turn Off Computer” and click OK.  

5 Turn off power to the personal computer and the CRT display monitor.  

(At step 4, the personal computer may be turned off depending on system settings.)  

6 Turn off power to the printer.  
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2.  WAVELENGTH SCAN  

 

2.1  Flow of Operation  
 

This section explains the condition setting and operating method for 

wavelength scan.  

Measurement proceeds along the following flow.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2-1  Operational Flow (wavelength scan)  

Start 

Method setting 

(See 2.2.) 

Sample name/ 

comment input 

(See 2.3.) 

Pre-scan 

(See 2.4) 

Measurement 

(See 2.5.) 

Data processing 

(See Section 7.) 

Result output in report 

(See 2.6.) 

End 

Click 
 

 button and set your analytical conditions. 

 
 

• Scan range  

• Data mode  

• Scan speed, etc.  

Click  button. 

 

• Sample name  

• Auto File  

• File name, etc. 

Set a sample.  

Click 
 

 button to execute auto scale for peaks. 

Click  button to execute wavelength scan. 

• Spectrum tracing  

• Peak detection, etc. 

Click  button.  Measurement result will be 

displayed in a report format. 
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2.2  Creating an Analysis Method  
 

Set the analytical conditions (method) prior to measurement.   

Select the Method command from the Edit menu or click the  

button.  A window shown in Fig. 2-2 will appear.  

 

 

 

Fig. 2-2  Analysis Method  

 

 

The following tabs are provided on the Analysis Method window for the 

wavelength scan mode.  These tabs are detailed on the subsequent 

pages.  

• General  

• Instrument  

• Monitor  

• Processing  

• Report  
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The parameters shown in Fig. 2-3 are provided at the General tab.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 2-3  General Tab  

 

 

1 Measurement (mode)  

A measurement mode is selectable.  Here, select “Wavelength 

scan.”  

For Time scan, Photometry, 3-D Scan and 3-D Time scan, refer to 

Sections 3, 4, 5 and 6, respectively.  

2 Operator  

Enter an operator name.  

3 Instrument  

The name of the connected instrument is indicated.  

4 Sampling 

- None  

Indicates that samples are to be exchanged manually.  

5 Comments  

Enter a description or notes on measuring conditions.  

6 Use sample table (Set measurement sample)  

Apply a check mark here when a sample table is used.  

2.2.1 General Tab 
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7 Load  

Click this button to read out saved analytical conditions.   

Upon clicking, the file opening window appears.  So, select an 

analytical condition file.  

8 Save  

When you click this button after setting the parameters, the 

analytical conditions can be saved by overwriting.  In case of a 

new analysis method, clicking this button displays the “Save As” 

window.  You must enter a file name for saving in this window.  

9 Save As  

Click this button for renaming the set conditions for saving.   

The “Save As” window appears, so enter a file name.  
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When you click the Instrument tab, the window in Fig. 2-4 appears.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 2-4  Instrument Tab 

 

 

1 Scan mode  

Select a scan mode here.  In case of Synchronous, the abscissa 

of the graph stands for excitation wavelength.   

The unit indication of the abscissa becomes ‘EX/EM(nm).’  

2 Data mode  

Select a data mode.  The Luminescence mode is for measuring 

luminescence in the biological/chemical field.   

In this mode, only the sample side signal is acquired without 

performing ratio photometry.  The Phosphorescence mode is for 

acquiring only phosphorescence after extinction of excitation beam 

while turning a chopper on the excitation side.  

2.2.2 Instrument Tab 
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3 Chopping speed  

Select a chopping speed.  Setting is allowed when 

Phosphorescence is selected for Data mode.   

The Phosphorescence mode is for acquiring only phosphorescence 

after extinction of excitation beam while turning a chopper on the 

excitation side.  An increase in chopping speed makes the 

chopper turns faster.  

4 EM WL  

For the Excitation scan mode, enter the fixed wavelength on the 

emission side .  For the Synchronous scan mode, enter the start 

wavelength on the emission side.  

5 EX Start WL  

This is the start wavelength on the excitation side in wavelength 

scan.  Enter the shorter wavelength side of measuring wavelength 

range.  

6 EX End WL  

This is the end wavelength on the excitation side in wavelength 

scan.  Enter the longer wavelength side of measuring wavelength 

range.  

7 EX WL  

For the Emission scan mode, enter the fixed wavelength on the 

excitation side.  

8 EM Start WL  

This is the start wavelength on the emission side in wavelength 

scan.  Enter the shorter wavelength side of measuring wavelength 

range.  

9 EM End WL  

This is the end wavelength on the emission side in wavelength 

scan.  Enter the longer wavelength side of measuring wavelength 

range.  

10 Scan speed  

Set a wavelength scan speed.  

11 Delay  

After pressing the Measure button, measurement is started 

following the delay time set here.  It is used for temperature 

stabilization, etc.  In repeat measurement, it is the time until the 

start of the first measurement.  The delay time is invalid for the 

second and subsequent measurements.  
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12 EX Slit  

Select a slit width on the excitation side.  

13 EM Slit  

Select a slit width on the emission side.  

14 PMT Voltage  

A function for controlling the voltage of the photomultiplier detector 

(photomultiplier tube).  As a reference, changing from 400 V to 

700 V increases the data value about two digits and changing from 

700 V to 950 V increases it about 1 digit.  

When a check mark is put for PMT Voltage 0-1000V, the 

photomultiplier voltage is settable within a range from 0 to 1000 V.  

15 PMT Voltage 0-1000V  

When a check mark is put in this box, the photomultiplier voltage is 

settable within a range from 0 to 1000 V.  

16 Response  

When “Auto” is selected, response will be set automatically 

depending on scan speed.  Select “Auto” usually.  

17 Corrected spectra  

A function for determining the spectrum inherent to a sample by 

correcting the photometer wavelength characteristic using the 

saved instrument parameters, following measurement with the 

instrument parameters for photometer control.  If there are no 

instrument parameters for the wavelength range to be measured, 

only the wavelength range that allows correction is scanned.   

And if there is no wavelength area measurable, an error will occur.  

The Instrument Response command is provided in the Utility menu 

for operating this function.  

When this setting is at ON, “Corrected spectra” appears on the 

monitor window.  (See Fig. 1-43 in 1.6.)  

18 Shutter control  

The shutter can automatically be closed in other than measurement 

for slowing down sample deterioration due to the energy of 

excitation beam and opened when measurement starts.   

When you put a check mark at the head, the shutter will close, and 

open at start of measurement.  The shutter will close again when 

measuring wavelength begins returning to the start wavelength 

after measurement in the wavelength scan mode.  
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19 Replicates  

Set the number of repeat measurements.  

An average spectrum can also be determined in repeat 

measurement.  Setting is available on the Processing tab (shown 

in Fig. 2-6).  

20 Cycle time  

Set a repetition interval.  

21 Range of corrected spectra  

Spectrum correction range is indicated.  
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When selecting the Monitor tab, the window in Fig. 2-5 appears.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 2-5  Monitor Tab 

 

 

Assign the following parameters.  

 

1 Y-Axis Max (maximum)  

Enter a maximum value for Y-axis on the monitor window.  

2 Y-Axis Min (minimum)  

Enter a minimum value for Y-axis on the monitor window.  

3 Open data processing window after data acquisition  

Select whether or not to conduct data processing after sample 

measurement.  When selected (check mark is applied), an icon 

(as shown in ) is displayed for the data 

processing window at the end of measurement.  And by opening 

this icon, data processing such as peak detection is available.  

2.2.3 Monitor Tab 
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NOTE: When the remaining memory capacity of PC in operation is 

very small (system resource is less than 20%), the data 

processing window will not open even if this item is turned ON.  

Either close the presently opened data processing window or 

restart the FL Solutions program.  

 

4 Open data processing window after acquisition (Overlay)  

Select whether or not to conduct data processing with spectra 

overlaid after sample measurement.  This setting is unavailable in 

repeat measurement.  

5 Print report after data acquisition  

Select whether or not to print a report after sample measurement.  

When selected (check mark is applied), printing will be made 

automatically after measurement.   

The items set at the Report tab will be printed.  When this item is 

not selected, data processing is allowed by reading out a file via 

[File]-[Open].  

6 Overlay  

Spectra can be overlaid in the monitor window.  

This setting cannot be selected for repeat measurement.  
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On selection of the Processing tab, the window in Fig. 2-6 will be 

displayed.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 2-6  Processing Tab 

 

 

1 CAT (Computing for Averaging Transient)  

Valid when 2 or larger value is entered for Replicates at the 

Instrument tab.  

When a check mark is put at the head, an average spectrum is 

determined upon carrying out repeat measurement.  

This is especially effective for measuring samples with which the 

emission intensity varies with time.  

2 Processing choices  

A list of data processing is displayed.  Select a data processing 

item, and click the Right arrow button ( ).  Then, the selected 

method appears in the Processing steps field.  For example, 

select ‘Derivative’ and click , then ‘Derivative’ is displayed in 

the Processing steps field as shown in Fig. 2-7.  

2.2.4 Processing Tab 
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Fig. 2-7  

 

 

3 Processing steps  

The processing sequence is displayed.  After measurement, data 

processing will be carried out in the order set here.  

How to Delete a Processing Method  

Select a processing method to be deleted and click the Left 

arrow button ( ).  Then, the selected method disappears 

from the Processing steps field.  

 

Display and Change of Parameter  

When you click [+] in the Processing steps field, a parameter list 

is displayed.  Click a parameter name to be changed, and it 

becomes changeable.  For changing a ‘Derivative’ parameter, 

click [+] at the left of ‘Derivative’ in Fig. 2-7.  The present 

derivative parameters (Derivative order, Smoothing order, 

Number of points) are displayed.  For changing the derivative 

order, click ‘Derivative order,” and it is highlighted as shown in 

Fig. 2-8 to allow your change.  

 

 

 

Fig. 2-8 
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4 Peak Finding:  Integration method  

Select an integration method for the peaks to be displayed in the 

data processing window.  

5 Peak Finding:  Threshold  

Enter the minimum photometric value difference (between peak 

and valley) for definition as a peak.  

 

 

 

 

6 Peak Finding:  Sensitivity  

Select the number of data points in the horizontal axis direction 

(abscissa).  For detecting sharp peaks, select a sensitivity value of 

“1.”  Or select “8” for detecting broad peaks.  
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Select the Report tab, and the window in Fig. 2-9 will appear.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 2-9  Report Tab 

 

 

This window is used to select a printout method and items of 

measurement results.  

 

1 Output  

• Print Report  

Data of the specified items will be printed in a report.   

For printing method, refer to 2.6.  

• Use Microsoft(R) Excel  

Data of the specified items will be transferred to Microsoft(R) 

Excel.  For transferring method, refer to 7.13.  

• Use print generator sheet  

Select this method for using the report generator (option).   

For usage, refer to the instruction manual of the report 

generator.  

2.2.5 Report Tab 
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2 Orientation  

Selectable when Print Report is chosen for Output.  

Select a printing orientation.  Either Portrait or Landscape 

orientation is selectable.  When the Landscape orientation is 

selected, date and method can be printed.  

3 Print items (printable/transferable items) 

• Include date  

• Include method  

• Include graph  

• Include data listing  

◊ Constant  

Data will be printed at fixed intervals between 2 wavelength 

points.  Make entries for Data interval, Data start and Data 

end.  

◊ Select data  

Data at the specified wavelength will be printed.  Up to 12 

wavelengths can be specified.  

When clicking a wavelength value, it allows editing.   

Select a wavelength within the measurable range set in the 

Instrument tab.  

• Include peak table  

Select output items in the peak table.  

4 Printer Font  

Click the Select button for changing the font to be used in the 

report.  
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2.3  Defining Your Samples  
 

When “Use sample table” is not selected in Analysis Method, a sample 

must be defined in the following procedure before measurement.  

 

(1) Click the  button.  The window in Fig. 2-10 will appear.  

 

 

 

Fig. 2-10  

 

 

(2) Make entries for Sample name and Comment.  

Maximum number of enterable characters (half-size)  

 

Sample name : 40 characters  

Comment : 255 characters  

 

For automatic saving, put a check mark in the “Auto File” box to 

specify a file name.  First click the Select button, and then 

specify a saving location and enter a file name.  

2.3.1 Without Using 

Sample Table 
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When you put a check mark at the head of “Auto JCAMP-DX file,” 

“Auto Text file” and “Auto Meta file” after turning on “Auto File,” 

wavelength scan data can be saved automatically in the following 

file formats as soon as this data is automatically saved.  

• JCAMP-DX file (*.dx)  

• ASCII text file (*.txt)  

• Graph meta file (*.wmf)  

The data will be saved in the file name entered for “File name.”  

 

(3) After completion of setting, click OK.  

 

 

When “Use sample table” is selected in Analysis Method, samples must 

be defined in the following procedure before measurement.  

Open the monitor window and click the  button.  

When the Sample Table window in Fig. 2-11 appears, enter the sample 

name and comment for each sample.  

 

1 For creating a sample table newly, make entry for Number of 

Samples and click the Update button.  For instance, if there are 

five samples, enter “5” for Number of Samples and click the 

Update button.  

 

 

 

Fig. 2-11  Sample Table  

 

 

2.3.2 With Sample 

Table 

2

1
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2 For adding a row at the end of sample table, click the Insert button.  

3 To delete an unnecessary row, click its row No. to make it active as 

shown in Fig. 2-12.  Then, click the Delete button.  

 

 

 

Fig. 2-12  

 

 

4 Make entries for Sample and Comments of each sample.   

The sample names entered here appear on the monitor window.  

Maximum number of characters to be entered (half-size)  

Sample : 40 characters  

Comment : 255 characters  

 

Next, you must enter a file name for automatic saving after 

measurement.  

When you click a File Name column, the […] button appears as 

shown in Fig. 2-13.  Click this button.  Upon opening of the 

window shown in Fig. 2-14, specify a saving location and enter a 

file name.  

3
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Fig. 2-13  

 

 

 

 

Fig. 2-14  

 

 

5 After entries, check them and then click the OK button.  

6 Load button  

Used for reading out the existing sample table.  

Clicking the Load button displays the file opening dialog.  

4

5

6 7 8 
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Fig. 2-15  File Opening Dialog 

 

 

Select a sample table and click the Open button.  The specified 

sample table will be read out.  

 

7 Save button  

The contents of change can be saved by overwriting.  In case of a 

new generation, the Save As dialog will open.  

8 Save As button  

Used for saving the sample table with a name newly given.  

Click this button, and the Save As dialog will open.  

 

 

 

Fig. 2-16  Save As Dialog 

 

 

Select a saving location and enter a file name.  Then, click the 

Save button.  
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2.4  Prescan  
 

Select the Auto Pre-scan command from the Spectrophotometer menu 

or click the  (pre-scan) button.  

This function executes high-speed scan under the set measuring 

conditions, detects the peak wavelength and moves the system to that 

wavelength.  Also, the upper limit photometric value on the Y-axis scale 

is automatically set so that the peak-wavelength value becomes 

approximately 70% of that upper limit value.  In this case, the lower 

limit photometric value on the Y-axis scale is set at 0.  

Scan rages are as follows.  

 

Excitation spectra:  

Start wavelength on excitation side to (fixed wavelength on emission 

side - 20 nm) or (end wavelength on excitation side) whichever 

shorter  

 

Emission spectra:  

(Start wavelength on emission side) or (fixed wavelength on 

excitation side + 20 nm) whichever longer to end wavelength on 

emission side  

 

Synchronous spectra:  

Excitation wavelength; Start wavelength on excitation side to end 

wavelength on excitation side  

Emission wavelength;  Fixed wavelength on emission side to [fixed 

wavelength on emission side + (end wavelength on excitation side - 

start wavelength on excitation side)]  

However, when 900 nm is reached, scan is terminated.  
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2.5  Conducting Measurement  
 

(1) Click the  button and make sure a sample has already been 

defined.  

 

(2) Set a sample and click  (pre-scan) button.  

 

(3) After completion of pre-scan, click the  button.  

Measurement starts and a spectrum is displayed.  

For halting the measurement midway, click the  (stop) button.  

 

(4) Upon completion of the measurement, the measured data will be 

saved automatically at the specified saving location using the 

specified file name when auto saving is selected.  

If auto saving is not selected, select the “Save As” command from 

the File menu and save the data.  

Opening the saved data file will display the data processing 

window as shown below.  

 

 

 

Fig. 2-17  Data Processing Window (wavelength scan)  

 

 

2.5.1 Without Using 

Sample Table 
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(1) Click the  button and make sure a sample has already been 

defined.  

 

(2) Set a sample and click  (pre-scan) button.  

 

(3) After completion of pre-scan, click the  button.  The window 

shown in Fig. 2-18 appears.  Click Yes.  

 

 

 

Fig. 2-18 

 

 

(4) A dialog box opens as shown below.  

 

 

 

Fig. 2-19 

 

 

Click OK.  Measurement starts.  

For halting the measurement midway, click the  (stop) 

button.   

Measure all the samples set in the sample table according to the 

message guide.  

2.5.2 With Sample 

Table 
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(5) Upon completion of the measurement, the measured data will be 

saved automatically at the specified saving location using the 

specified file name.  Opening the saved data file will display the 

data processing window as shown below. 

 

 

 

Fig. 2-20  Data Processing Window (wavelength scan) 

 

 

① Spectrum  

The spectrum of a measured sample is displayed.  

 

② Peak table  

Peak wavelength, peak height and valley wavelength are 

listed.  

 

① Spectrum

② Peak table 
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NOTICE: 1. The data measured under the following conditions will 

be saved automatically in Program Files\FL 

Solutions\Data.  (Example:  C:Program Files\FL 

Solutions\Data)  

(1) Measurement was carried out using a sample table 

with no file name specified in the File Name 

column.  

(2) Measurement was carried out with “Auto File” 

specified and a file name unspecified, avoiding use 

of a sample table.  

2. The data measured under the following conditions will 

be saved automatically in Program Files\FL Solutions.  

(Example:  C:Program Files\FL Solutions)  

(3) There is not an adequate free area in the specified 

storage medium (such as floppy disk or MO).   

(4) Writing is inhibited.  

A file automatically saved under such a condition as above is 

named according to the following rule.  

Rule 1: When a file name is given to analysis method: 

File name of analysis method + serial No. (001, 

002, ...)  

Rule 2: When a file name is not given to analysis method:  

DEFLT + serial No. (001, 002, ...)  
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2.6  Data Printout  
 

Printout can be provided even when the function for automatic printout 

after measurement is not used.  The following two procedures are 

available.  

 

(1) Click on the spectrum window, and the circumference turns blue.  

In this status, select the Print command from the File menu.   

Or click the  (print) button on the toolbar.  The field active 

on the data processing window (e.g., ① in Fig. 2-20) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.  

 

 

 

Fig. 2-21  

 

 

(2) Select the Report command in the Data menu.  Or click the  

button on the toolbar.  The Print Preview window will appear as 

shown below, so click Print.  
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Fig. 2-22 

 

 

NOTE: If characters overflow from the print frame in repeat 

measurement or in overlaying, then change the printing 

orientation from vertical (Portrait) to horizontal (Landscape).  
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Select the items to be printed in the following procedure.  

Click the  button, and the Spectrum Properties window will appear.  

↓ 

Select the Report tab, and the window in Fig. 2-23 will open.  

↓ 

In this window, select desired print items.  

 

 

 

Fig. 2-23 
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3.  TIME SCAN  

 

3.1  Flow of Operation  
 

This section explains the parameter setting and operating method for 

time scan.  Measurement proceeds along the flow shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3-1  Operational Flow (time scan) 

Click 
 

 button. 

 

• Measuring wavelengths 

• Scan time, etc. 

Click  button. 

 

• Sample name 

• Auto File 

• File name at destination of 

saving, etc. 

Set a sample.  

Click  button to execute time scan. 

• Rate calculation 

• Peak detection 

• Spectrum tracing 

• Spectral calculation 

Click  button.  Measurement result will be displayed 

in a report format. 

 

Start 

Method setting 

(See 3.2.) 

Sample name/ 

comment input 

(See 3.3.) 

Measurement 

(See 3.4.) 

Data processing 

(See Section 7.) 

Result output in report 

(See 3.5.) 

End 
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3.2  Creating an Analysis Method  
 

Set the analytical conditions (method) prior to measurement.   

From the Edit menu, select the Method command or click the  

button.  A window shown in Fig. 3-2 will appear.  

 

 

 

Fig. 3-2  Analysis Method 

 

 

The following tabs are provided on the Analysis Method window for the 

time scan mode.  These tabs are detailed on the subsequent pages.  

• General  

• Instrument  

• Monitor  

• Processing  

• Report  
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The parameters shown in Fig. 3-3 are provided at the General tab.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 3-3  General Tab 

 

 

1 Measurement (mode)  

A measurement mode is selectable.  Here, select “Time scan.”  

For Wavelength scan, Photometry, 3-D Scan and 3-D Time scan, 

refer to Sections 2, 4, 5 and 6, respectively.  

2 Operator  

Enter an operator name.  

3 Instrument  

The name of the connected instrument is indicated.  

4 Sampling  

- Standard  

Indicates that samples are to be exchanged manually.   

5 Comments  

Enter a description or notes on measuring conditions.  

6 Use sample table (Set measurement sample)  

Apply a check mark here when a sample table is used.  

3.2.1 General Tab 

 

1 

2 

3 

4 

5 

6 

7 

8 

9 
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7 Load  

Click this button to read out saved analytical conditions.   

Upon clicking, the file opening window appears.  So, select an 

analytical condition file.  

8 Save  

When you click this button after setting the parameters, the 

analytical conditions can be saved by overwriting.  In case of a 

new analysis method, clicking this button displays the “Save As” 

window.  You must enter a file name for saving in this window.  

9 Save As  

Click this button for renaming the set conditions for saving.   

The “Save As” window appears, so enter a file name.  
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This window appears when Time scan is specified for Measurement at 

the General tab on the Analysis Method window.  When you click the 

Instrument tab, the window in Fig. 3-4 appears.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 3-4  Instrument Tab  

 

 

1 Data mode  

Select a data mode.  The Luminescence mode is for measuring 

luminescence in the biological/chemical field.  In this mode, only 

the sample side signal is acquired without performing ratio 

photometry.  If phosphorescence life is shorter than 20 ms, 

“Phosphorescence short life” should be selected.  In this case, unit 

time and measuring time are automatically set to ms and 20 ms. 

2 Chopping speed  

Select a chopping speed.  Setting is allowed when 

Phosphorescence is selected for Data mode.   

The Phosphorescence mode is for acquiring only phosphorescence 

after extinction of excitation beam while turning a chopper on the 

excitation side.  An increase in chopping speed makes the 

chopper turns faster.  

3.2.2 Instrument Tab 

 

2 

3 

4 
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3 EX WL  

Enter an excitation wavelength.  

4 EM WL  

Enter an emission wavelength.  

5 Time unit  

Set a time unit.  

6 Scan time  

Set a wavelength scan speed.  

For the relationship between scan time and sampling interval, refer 

to Appendix H.  

7 Delay  

After pressing the Measure button, measurement is started 

following the delay time set here.  It is used for temperature 

stabilization, etc.  In repeat measurement, it is the time until the 

start of the first measurement.  The delay time is invalid for the 

second and subsequent measurements.  

8 EX Slit  

Select a slit width on the excitation side.  

9 EM Slit  

Select a slit width on the emission side.  

10 PMT Voltage  

A function for controlling the voltage of the photomultiplier detector 

(photomultiplier tube).  As a reference, changing from 400 V to 

700 V increases the data value about two digits and changing from 

700 V to 950 V increases it about 1 digit.  

When a check mark is put for PMT Voltage 0-1000V, setting is 

allowed within a range from 0 to 1,000 V.  

11 PMT Voltage 0-1000V  

When a check mark is put in this box, the photomultiplier voltage is 

settable within a range from 0 to 1000 V.  

12 Response  

Set a response time.  

13 Shutter control  

The shutter can automatically be closed in other than measurement 

for slowing down sample deterioration due to the energy of 

excitation beam and opened when measurement starts.   
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14 Replicates  

Set the number of repeat measurements.   

15 Cycle time  

Set a repetition interval.  

16 Stopped Flow  

When a check mark is put in this box, the stopped flow mode is set.  

In this case, when you click the measurement start button, the 

system waits until an external start signal comes in.   

Then, measurement starts.  
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When selecting the Monitor tab, the window in Fig. 3-5 appears.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 3-5  Monitor Tab 

 

 

Assign the following parameters.  

 

1 Y-Axis Max (maximum)  

Enter a maximum value for Y-axis on the monitor window.  

2 Y-Axis Min (minimum)  

Enter a minimum value for Y-axis on the monitor window.  

3 X-Axis Max (maximum)  

Enter a maximum value for X-axis on the monitor window.  

4 X-Axis Min (minimum)  

Enter a minimum value for X-axis on the monitor window.  

 

NOTE: X-Axis Max and Min correspond to a display interval on the 

monitor window.  For example, when Max and Min are 60 

and 30, display on the window is made within 30 to 60 s, 60 to 

90 s, 90 to 120 s and so on.  

3.2.3 Monitor Tab 
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5 Open data processing window after data acquisition  

Select whether or not to conduct data processing after sample 

measurement.  When selected (check mark is applied), an icon 

for this function (as shown in ) is displayed.  

 

NOTE: When the remaining memory capacity of PC in operation is 

very small (system resource is less than 20%), the data 

processing window will not open even if this item is turned ON.  

Either close the presently opened data processing window or 

restart the FL Solutions program.  

 

6 Open data processing window after acquisition (Overlay)  

Select whether or not to conduct data processing with spectra 

overlaid after sample measurement.  This setting is unavailable in 

repeat measurement.  

7 Print report after data acquisition  

Select whether or not to print a report after sample measurement.  

When selected (check mark is applied), printing will be made 

automatically after measurement.  The items set at the Report tab 

will be printed.   

8 Overlay  

Spectra can be overlaid in the monitor window.  

This setting cannot be selected for repeat measurement.  
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On selection of the Processing tab, the window in Fig. 3-6 will be 

displayed.  

For the settable range of each parameter, refer to Appendix G.  

 

 

Fig. 3-6  Processing Tab  

 

 

1 Processing choices  

A list of data processing is displayed.  Select a data processing 

item, and click the Right arrow button ( ).  Then, the selected 

method appears in the Processing steps field.  For example, 

select ‘Derivative’ and click , then ‘Derivative’ is displayed in 

the Processing steps field as shown in Fig. 3-7.  

 

 

Fig. 3-7 

3.2.4 Processing 

Tab 
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2 Processing steps  

The processing sequence is displayed.  After measurement, data 

processing will be carried out in the order set here.  

How to Delete a Processing Method  

Select a processing method to be deleted and click the Left 

arrow button ( ).  Then, the selected method disappears 

from the Processing steps field.  

 

Display and Change of Parameter  

When you click [+] in the Processing steps field, a parameter list 

is displayed.  Click a parameter name to be changed, and it 

becomes changeable.  For changing a ‘Derivative’ parameter, 

click [+] at the left of ‘Derivative’ in Fig. 3-7.  The present 

derivative parameters (Derivative order, Smoothing order, 

Number of points) are displayed.  For changing the derivative 

order, click ‘Derivative order,” and it is highlighted as shown in 

Fig. 3-8 to allow your change.  

 

 

 

Fig. 3-8 

 

 

3 Peak Finding:  Integration method  

Select an integration method for the peaks to be displayed in the 

data processing window.  

4 Peak Finding:  Threshold  

Set a detection limit for the photometric value axis of peak and 

valley.  

Peaks or valleys below the set value will not be detected.   
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5 Peak Finding:  Sensitivity  

Select the number of data points in the horizontal axis direction 

(abscissa).  For detecting sharp peaks, select a sensitivity value of 

“1.”  Or select “8” for detecting broad peaks.  

6 Kinetics:  Start time  

Enter a start time for kinetics (rate calculation).  

7 Kinetics:  End time  

Enter an end time for kinetics.  

8 Kinetics:  K-Factor  

Enter a K-factor for kinetics.  
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Select the Report tab, and the window in Fig. 3-9 will appear.  

 

 

 

Fig. 3-9  Report Tab 

 

 

This window is used to select a printout method and items of 

measurement results.  

 

1 Output  

• Print Report  

A report will be printed.  For printing method, refer to 3.5.  

• Use Microsoft(R) Excel  

Data will be transferred to Microsoft(R) Excel.  For transferring 

method, refer to 7.13.  

• Use print generator sheet  

Select this method for using the report generator (option).   

For usage, refer to the instruction manual of the report 

generator.  

2 Orientation  

Selectable when Print Report is chosen for Output.  

Select a printing orientation.  Either Portrait or Landscape 

orientation is selectable.  When the Landscape orientation is 

selected, date and method can be printed.  

3.2.5 Report Tab 
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3 
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3 Print items (printable/transferable items) 

• Include date  

The date and time of analysis can be printed.  Printing time will 

always be printed.  

• Include method  

• Include graph  

• Include data listing  

◊ Constant  

Data will be printed at fixed intervals between 2 wavelength 

points.  Make entries for Data interval, Data start and Data 

end.  

◊ Select data  

Data at the specified wavelength will be printed.  Up to 12 

time points can be specified.  

When clicking a time value, it allows editing.  Select a time 

within the measurable range set in the Instrument tab.  

• Include peak table  

Select output items in the peak table.  

When a check mark is put in this box, the following output items 

are selectable.  

◊ Peak time/Peak data  

◊ Start time/End time  

◊ Valley time/Valley data  

◊ Peak Area  

• Include kinetics  

4 Printer Font  

Click the Select button for changing the front to be used in the 

report.  
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3.3  Defining Your Samples  
 

When “Use sample table” is not selected in Analysis Method, a sample 

must be defined in the following procedure before measurement.  

 

(1) Click the  button.  The window in Fig. 3-10 will appear.  

 

 

 

Fig. 3-10  

 

 

(2) Make entries for Sample name and Comment.  

Maximum number of enterable characters (half-size)  

Sample name : 40 characters  

Comment : 255 characters  

 

For automatic saving, put a check mark in the “Auto File” box to 

specify a file name.  First click the Select button, and then 

specify a saving location and enter a file name.  

When you put a check mark at the head of “Auto JCAMP-DX file,” 

“Auto Text file” and “Auto Meta file” after turning on “Auto File,” 

time scan data can be saved automatically in the following file 

formats as soon as this data is automatically saved.  

• JCAMP-DX file (*.dx)  

• ASCII text file (*.txt)  

• Graph meta file (*.wmf)  

The data will be saved in the file name entered for “File name.”  

 

(3) After completion of setting, click OK.  

 

3.3.1 Without Using 

Sample Table 
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When “Use sample table” is selected in Analysis Method, samples must 

be defined in the following procedure before measurement.  

Open the monitor window and click the  button.  

When the Sample Table window in Fig. 3-11 appears, enter the sample 

name and comment for each sample.  

 

1 For creating a sample table newly, make entry for Number of 

Samples and click the Update button.  For instance, if there are 

five samples, enter “5” for Number of Samples and click the 

Update button.  

 

 

 

Fig. 3-11  Sample Table 

 

 

2 For adding a row at the end of sample table, click the Insert button.  

3 To delete an unnecessary row, click its row No. to make it active as 

shown in Fig. 3-12.  Then, click the Delete button.  

3.3.2 With Sample 

Table 

 

2

1
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Fig. 3-12 

 

 

4 Make entries for Sample and Comments of each sample.   

The sample names entered here appear on the monitor window.  

Maximum number of characters to be entered (half-size)  

Sample : 40 characters  

Comment : 255 characters  

 

Next, you must enter a file name for automatic saving after 

measurement.  

When you click a File Name column, the [...] button appears as 

shown in Fig. 3-13.  Click this button.  Upon opening of the 

window shown in Fig. 3-14, specify a saving location and enter a 

file name.  

 

 

Fig. 3-13 
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Fig. 3-14  

 

 

5 After entries, check them and then click the OK button.  

6 Load button  

Used for reading out the existing sample table.  

Clicking the Load button displays the file opening dialog.  

 

 

 

Fig. 3-15  File Opening Dialog 

 

 

Select a sample table and click the Open button.  The specified 

sample table will be read out.  
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7 Save button  

The contents of change can be saved by overwriting.  In case of a 

new generation, the Save As dialog will open.  

8 Save As button  

Used for saving the sample table with a name newly given.  

Click this button, and the Save As dialog will open.  

 

 

 

Fig. 3-16  Save As Dialog 

 

 

Select a saving location and enter a file name.  Then, click the 

Save button.  
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3.4  Conducting Measurement  
 

(1) When “Use sample table” is not selected in Analysis Method, you 

should click the  button and make sure that a sample has 

already been defined.  

 

(2) Set a sample and click  (measurement) button.  

Measurement starts and a spectrum is displayed.  

For halting the measurement midway, click the  (stop) 

button.   

 

(3) Upon completion of the measurement, the measured data will be 

saved automatically at the specified saving location using the 

specified file name when auto saving is selected.   

If auto saving is not selected, select the “Save As” command from 

the File menu and save the data.  

Opening the saved data file will display the data processing 

window as shown in Fig. 3-17.  This figure shows a spectrum 

and the result of rate calculation.  Peak table can be displayed, 

but both the result of rate calculation and the peak table cannot 

be displayed simultaneously.  Simultaneous display is selectable 

from the View menu.  

 

 

 

Fig. 3-17  Data Processing Window (time scan) 

 

 

3.4.1 Without Using 

Sample Table 
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(1) Click the  button and make sure a sample has already been 

defined.  

 

(2) Set a sample and click the  button to start measurement.  

 

(3) Upon start of measurement, the window shown in Fig. 3-18 

appears.  Click Yes.  

 

 

 

Fig. 3-18 

 

 

(4) A dialog box opens as shown below.  

 

 

 

Fig. 3-19 

 

 

Click OK.  Measurement starts and a spectrum is displayed.  

For halting the measurement midway, click the  (stop) 

button.  

Measure all the samples set in the sample table according to the 

message guide.  

3.4.2 With Sample 

Table 
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(5) Upon completion of the measurement, the measured data will be 

saved automatically at the specified saving location using the 

specified file name.  Opening the saved data file will display the 

data processing window as shown in Fig. 3-20.  This figure 

shows a spectrum and the result of rate calculation.  Peak table 

can be displayed, but both the result of rate calculation and the 

peak table cannot be displayed simultaneously.   

Simultaneous display is selectable from the View menu.  

 

 

 

Fig. 3-20  Data Processing Window (wavelength scan) 

 

 

① Spectrum  

The spectrum of a measured sample is displayed.  

 

② Result of rate calculation  

The result of rate calculation (slope, activity, R, R2) are 

displayed.  Start time and end time are settable by numeric 

input or clicking Set with the line cursor aligned.   

After setting, click Update for recalculation.  For rate 

calculation, refer to Appendix B.  

 

When peak table is selected, peak time, valley time, peak start/end 

times and peak area will be displayed.   

 

 

① Spectrum 

② Result of rate calculation 
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(1) Put a check mark for ‘Stopped Flow’ at the Instrument tab in the 

Analysis Method window.  At the General tab in this window, 

remove a check mark from “Use sample table.”  

 

(2) Click the  button to make sure a sample has already been 

defined.  

 

(3) Click the  (measurement) button to start measurement.  

 

(4) When measurement starts, the window shown in 3-21 appears to 

await an external start signal.   

 

 

 

Fig. 3-21 Stopped Flow Measurement Window  

(external signal wait status) 

 

 

3.4.3 Measurement 

in Stopped 

Flow Mode 
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(5) On arrival of the external signal, measurement starts and a 

spectrum is drawn in the window.  

 

 

 

Fig. 3-22  Stopped Flow Measurement Window  

 

 

For stopping the measurement halfway, click the  (stop) 

button.  

 

(6) Upon completion of the measurement, the measured data will be 

saved automatically at the specified saving location using the 

specified file name when auto saving is selected.   

If auto saving is not selected, select the “Save As” command from 

the File menu and save the data.  
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NOTICE: 1. The data measured under the following conditions will 

be saved automatically in Program Files\FL 

Solutions\Data.  (Example:  C:Program Files\FL 

Solutions\Data)  

(1) Measurement was carried out using a sample table 

with no file name specified in the File Name 

column.  

(2) Measurement was carried out with “Auto File” 

specified and a file name unspecified, avoiding use 

of a sample table.  

2. The data measured under the following conditions will 

be saved automatically in Program Files\FL Solutions.   

(Example:  C:Program Files\FL Solutions)  

(3) There is not an adequate free area in the specified 

storage medium (such as floppy disk or MO).   

(4) Writing is inhibited.  

A file automatically saved under such a condition as above is 

named according to the following rule.  

Rule 1: When a file name is given to analysis method: 

File name of analysis method + serial No. (001, 

002, ...)  

Rule 2: When a file name is not given to analysis method:  

DEFLT + serial No. (001, 002, ...)  
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3.5  Data Printout  
 

Printout can be provided even when the function for automatic printout 

after measurement is not used.  The following two procedures are 

available.  

 

(1) Click on the spectrum window, and the circumference turns blue.  

In this status, select the Print command from the File menu.   

Or click the  (print) button on the toolbar.  The field active 

on the data processing window (e.g., ① in Fig. 3-20) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.  

 

 

 

Fig. 3-23  

 

 

(2) Select the Report command in the Data menu.  Or click the  

(report) button on the toolbar.  The Print Preview window will 

appear as shown below, so click Print.  
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Fig. 3-24  

 

 

NOTE: If characters overflow from the print frame in repeat 

measurement or in overlaying, then change the printing 

orientation at the Report tab shown in Fig. 3-25 from vertical 

(Portrait) to horizontal (Landscape).  
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Select the items to be printed in the following procedure.  

 

Click the  button, and the Spectrum Properties window will appear.  

↓ 

Select the Report tab, and the window in Fig. 3-25 will open.  

↓ 

In this window, select desired print items.  

 

 

 

Fig. 3-25 
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3.6  Calculating the Phosphorescence Life  
 

This is the function for calculating phosphorescence life from the 

measurement result (phosphorescence attenuation curve).   

Replacing data value at T1 with I0, I0/e time (T2) is found, and T1, T2 and 

τ (phosphorescence life) = T2 - T1 are displayed.  

Select the phosphorescence life command from the Data menu or click 

the  button on the Processing toolbar.  A window as shown in Fig. 

3-26 will appear.  

 

 

 

Fig. 3-26 

 

 

Move the line cursor to the start point (T1) of calculation by the mouse 

or arrow keys [←] and [→] on the keyboard.  Right-click the mouse at 

the start point.  Or enter a numeral in the T1 field and click Calculate.  

The result of calculation will be displayed.  
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Fig. 3-27 

 

 

For printout of the calculation result, click Print.  For printout of the 

spectrum and calculation result, apply a check mark to “Print spectrum” 

and click Print.   

For scale expansion, specify the area to be enlarged with the mouse.  

Draw a rectangle with the mouse button held down as shown in Fig.  

3-28.  

 

 

 

Fig. 3-28 
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When releasing the mouse button, the specified area will be enlarged as 

shown in Fig. 3-29.  

 

 

 

Fig. 3-29  

 

 

Double-clicking on the spectrum selects auto scale.  
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4.  PHOTOMETRY  

 

4.1  Flow of Operation  
 

This section explains the method of determining sample concentration 

with a calibration curve prepared.  Measurement proceeds along the 

flow shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4-1  Operational Flow (photometry)  

Click 
 

 button and set an analysis method. 

 
 

• Quantitation type 

• Number of wavelengths 

• Calibration type 

Click  button and set sample information. 

 

• Sample name   

• Auto File 

• File name at destination of 

saving, etc. 

Click and measure a standard sample according to the 

message guide. 

After completion of standard measurement, set a sample and 

click [Sample (F4)] button to measure the sample. 

Click  button.  Measurement result will be displayed 

in a report format. 

 

Start 

Method setting 

(See 4.2.) 

Sample name/ 

comment input 

(See 4.3.) 

Standards 

measurement 

(See 4.4) 

Sample measurement 

(See 4.4.) 

Result output in report 

(See 4.5.) 

End 

Standard table setting 

(See 4.2.) 

At the Standards tab, set a standard table. 
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4.2  Creating an Analysis Method  
 

Set the analytical conditions (method) prior to measurement.  

From the Edit menu, select the Method command or click the  

button.  A window shown in Fig. 4-2 will appear.  

 

 

 

Fig. 4-2  Analysis Method 

 

 

The following tabs are provided on the Analysis Method window for the 

photometry mode.  These tabs are detailed on the subsequent pages.  

• General  

• Quantitation  

• Instrument  

• Standards  

• Monitor  

• Report  
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The parameters shown in Fig. 4-3 are provided at the General tab.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 4-3  General Tab  

 

 

1 Measurement (mode)  

A measurement mode is selectable.  Here, select “Photometry.”  

For Wavelength scan, Time scan, 3-D Scan and 3-D Time scan, 

refer to Sections 2, 3, 5 and 6, respectively.  

2 Operator  

Enter an operator name.  

3 Instrument  

The name of the connected instrument is indicated.  

4 Sampling  

- Standard  

Indicates that samples are to be exchanged manually.   

5 Comments  

Enter a description or notes on measuring conditions.  

6 Use sample table (Set measurement sample)  

Apply a check mark here when a sample table is used.  

4.2.1 General Tab 
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7 Load  

Click this button to read out saved analytical conditions.   

Upon clicking, the file opening window appears.  So, select an 

analytical condition file.  

8 Save  

When you click this button after setting the parameters, the 

analytical conditions can be saved by overwriting.  In case of a 

new analysis method, clicking this button displays the “Save As” 

window.  You must enter a file name for saving in this window.  

9 Save As  

Click this button for renaming the set conditions for saving.   

The “Save As” window appears, so enter a file name.  

 

 



4.2.2 

4 - 5 

Upon selection of the Quantitation tab, the window shown in Fig. 4-4 

appears.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 4-4  Quantitation Tab 

 

 

1 Quantitation type  

Quantitation type is selectable among Wavelength, Peak area, 

Peak height, Derivative and Ratio.  Spectra measured by the Peak 

area, Peak height and Derivative methods can be checked, 

referring to 7.19.  

(a) Wavelength  

Upon selecting ‘None’ for Calibration type in this quantitation 

method, photometric values can be obtained at the specified 

number of wavelengths for Number of wavelengths.   

A calibration curve will not be prepared.  

 

Upon selecting 1st order, 2nd order, 3rd order or Segmented 

in this quantitation method, calibration curve data and sample 

data will be obtained by one, two or three-wavelength 

calculation depending on your entry for Number of 

wavelengths.  

 

4.2.2 Quantitation 

Tab 
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(i) One wavelength calculation  

This is the most generally used method.  When you 

specify one wavelength and enter it at the Instrument 

tab, a calibration curve and concentration are 

determined from the data I1 at the specified wavelength 

as shown in Fig. 4-5 (a).  

 

 

 

Fig. 4-5 (a) 

 

 

(ii) Two wavelength calculation  

When you specify two wavelengths and enter them at 

the Instrument tab, a calibration curve and 

concentration are calculated through determination of I 

by the equation below assuming I1 and I2 are the 

photometric values at two different wavelengths as 

shown in Fig. 4-5 (b).   

 

 

 

Fig. 4-5 (b)  

 

 

I1

D
a
ta
 

I 

WL1 

D
a
ta
 

I1 

I2

I 

WL1 WL2



4.2.2 

4 - 7 

(iii) Three wavelength calculation  

As shown in Fig. 4-5 (c), assuming I1, I2 and I3 are the 

data values at three different wavelengths, a calibration 

curve and concentration are calculated through 

determination of I by the equation below.   

Photometry is made in the order of WL1, WL2 and WL3.   

 

I = I2 -  

 

But the following relation must hold:  

WL1 < WL2 < WL3 or WL1 > WL2 > WL3  

 

 

 

Fig. 4-5 (c) 

 

 

(b) Peak area  

Enter the peak wavelength and its accuracy for Peak apex.  

Integration method (area detection method) is selectable 

among Rectangular, Trapezoid and Romberg.  (Refer to 

“integration method” in Appendix D.2.)  Then, set a 

threshold value and sensitivity for defining the peak, referring 

to 7.6.   

I1 (WL3 - WL2) + I3 (WL2 - WL1) 

WL3 - WL1 

D
a
ta
 

I1 

I2

WL1 WL2

I3

WL3

I
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Measurement will be carried out within the wavelength range 

set at the Instrument tab.  According to the specified 

threshold level and sensitivity, peak wavelength is sought.  

The area of the peak found within a range of the entered 

Peak apex ± wavelength accuracy is calculated, thereby 

preparing a calibration curve.  

 

 

 

Fig. 4-6  Quantitation Tab (peak area) 
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(c) Peak height  

Enter the peak wavelength and its accuracy for Peak apex.  

Measurement will be carried out within the wavelength range 

set at the Instrument tab.  According to the threshold level 

and sensitivity specified for the “Peak area” quantitation 

method, peak wavelength is sought.  A calibration curve is 

prepared using the height of the peak found within a range of 

the entered Peak apex ± wavelength accuracy.   

 

 

 

Fig. 4-7  Quantitation Tab (peak height) 
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(d) Derivative  

Enter peak wavelength (or wavelength to be used for 

calibration curve preparation) for Peak apex.   

Measurement will be carried out within the wavelength range 

set at the Instrument tab.  A calibration curve is created 

using the derivative value at the peak wavelength.   

Assign your values for derivative parameters; Derivative 

order, Smoothing order and Number of points.  

 

 

 

Fig. 4-8  Quantitation Tab (derivative) 
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(e) Ratio  

Upon selecting Ratio, an input column for three factors (K-

factor 0, K-factor 1, K-factor 2) and a setting column for 

calculation method (+, -, ∗) are displayed.   

 

NOTE: By this quantitation method, a calibration curve cannot 

be created.  

 

 

 

Fig. 4-9  Quantitation Tab (peak ratio) 

 

 

Calculation is made by the following equation.  

 

RATIO =  #K0 

 

# (calculation method):  +, -, ∗  

WL1, 2, 3 : Specified wavelengths  

WL3 : Background correcting wavelength  

A ( ) : Measured value at specified wavelength  

 

2 Calibration type  

Set a calibration type.  For selecting factor input (when the formula 

of standard calibration curve and its factors are already known), put 

a mark in the check box for Manual calibration and enter values for 

A0, A1, A2 and A3.   

 

K1 (A (WL1) - A (WL3))

K2 (A (WL2) - A (WL3))
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(a) None  

Mode in which calibration curve is not used.  When this 

mode is selected with Wavelength set for Quantitation type, 

multi-wavelength measurement at up to six wavelengths is 

possible.  However, no spectrum can be displayed.  

 

(b) 1st order  

This specifies the most generally used calibration curve.   

A linear calibration curve is to be created.  The formula of 

calibration curve is as follows.  

x = A1y + A0  

Here, x is sample concentration and y is sample data.  

 

 

 

Fig. 4-10  1st Order 

 

 

(c) 2nd order  

A calibration curve is created using a quadratic curve.   

The formula of calibration curve is as follows.  

x = A2y
2 
+ A1y + A0 

Here, x is sample concentration and y is sample data.  

 

 

 

Fig. 4-11  2nd Order 
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(d) 3rd order  

A calibration curve is created using a cubic curve.   

The formula of calibration curve is as follows.  

x = A3y
3 
+ A2y

2 
+ A1y + A0 

Here, x is sample concentration and y is sample data.  

 

 

 

Fig. 4-12  3rd Order  

 

 

(e) Segmented  

A calibration curve created by connecting standard samples 

linearly according to the measured values of respective 

samples or input data.  

 

 

 

Fig. 4-13  Segmented 
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NOTE: A proper calibration curve can be created when the 

photometric value increases or decreases 

monotonously versus the concentration value.  With a 

monotonic increase, the calibration curve is created with 

standard 1 (STD1) as origin.  And with a monotonic 

decrease, the calibration curve is created with STD1 

plotted on the photometric value axis and STD5 on the 

concentration axis.  In these examples, the number of 

standards is set at 5.  

 

 

 

 

3 Number of wavelengths  

Enter the desired number of wavelengths to be used for 

measurement.  

4 Concentration unit  

Enter a concentration (in mg/mL for example) from the keyboard.  

Calibration curve with monotone increase

Calibration curve with monotone decrease

D
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5 Manual calibration  

Put a check mark in this box for creating a calibration curve using 

factors.  Enter factors in response to the selected calibration type.   

6 Force curve through zero  

By putting a check mark in this box, a calibration curve is created 

so that its factor A0 takes 0 automatically.   

7 Digit after decimal point  

Set the number of digits below decimal point for indicating the 

calculated concentration of the measured sample.   

The concentration value is rounded off to the set number of digits.  

8 Lower concentration limit/Upper concentration limit  

This is used to set a normal value range for the concentration of 

the measured sample.  If the concentration is higher than the 

upper limit set here, “HIGH” will appear in the Conc column, and if 

lower than the lower limit set here, “LOW” will appear in the Conc 

column.  

 

 

 

Fig. 4-14  (measurement example with upper limit set at 5) 
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When you click the Instrument tab, the window in Fig. 4-15 appears.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 4-15  Instrument Tab 

 

 

1 Data mode  

Select one of the three data modes.  The Luminescence mode is 

for measuring luminescence in the biological/chemical field.   

In this mode, only the sample side signal is acquired without 

performing ratio photometry.   

2 Chopping speed  

Select a chopping speed.  Setting is allowed when 

Phosphorescence is selected for Data mode.   

The Phosphorescence mode is for acquiring only phosphorescence 

after extinction of excitation beam while turning a chopper on the 

excitation side.  An increase in chopping speed makes the 

chopper turns faster.  

3 Wavelength mode  

Selects a wavelength setting for creation of a calibration curve.  

4.2.3 Instrument 

Tab 
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4 Fixed WL 

When ‘EX WL Fixed’ is selected in Wavelength mode, set the fixed 

wavelength on the excitation side.  

When ‘EM WL Fixed’ is selected in Wavelength mode, set the fixed 

wavelength on the emission side.  

5 WL (1 to 6)  

Make your entry for the number of wavelengths specified at the 

Quantitation tab.  

6 EX Slit  

Select a slit width on the excitation side.  

7 EM Slit  

Select a slit width on the emission side.  

8 PMT Voltage  

A function for controlling the voltage of the photomultiplier detector 

(photomultiplier tube).  As a reference, changing from 400 V to 

700 V increases the data value about two digits and changing from 

700 V to 950 V increases it about 1 digit.  

When a check mark is put for PMT Voltage 0-1000V, setting is 

allowed within a range from 0 to 1,000 V.  

9 PMT Voltage 0-1000V  

When a check mark is put in this box, the photomultiplier voltage is 

settable within a range from 0 to 1000 V.  

10 Auto statistic cal. number  

Calculation is made for mean value, SD (standard deviation) and 

CV (coefficient of variation).  Set the number of samples for this 

purpose.  

11 Replicates  

Set the number of measurements to be repeated.   

12 Integration time  

A function for obtaining data averaged over the specified time for 

acquisition of stabilized data.  

13 Delay  

After pressing the Measure button, measurement is started 

following the delay time set here.  It is used for stabilization after 

setting an unknown sample, etc.  In repeat measurement, it is the 

time until the start of the first measurement.  The delay time is 

invalid for the second and subsequent measurements.  
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Clicking the Standards tab opens the window shown in Fig. 4-16.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 4-16  Standards Tab 

 

 

1 Number of Samples  

For generating a sample table newly, enter the number of samples 

here, and then click the Update button.  

2 Standard Table  

This table gives a list of standards for sample measurement or 

calibration curve preparation.  The table contains the items listed 

below.  

NOTE: The size of the standard table columns (cells) is changeable.  

Bring the cursor to a boundary line between the left and right 

table headers, and it changes into one shown below.   

 

Now click the mouse button on the line and drag it to the left or 

right to obtain a suitable column size.  

 

4.2.4 Standards Tab 
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⎯ No.  

This is the number given to each sample.  

⎯ Sample  

Enter the name of each sample.   

⎯ Comment  

Enter comments on each sample.  

⎯ Concentration  

Enter the concentration of each sample.  

 

3 Update  

When clicking this button, a confirmation message appears.  

 

 

 

 

Clicking Yes will clear the presently entered sample names and 

comments, and table rows are formed by the entered number of 

samples.  

For adding a row below the final one in the sample list, click the 

Insert button.  

4 Insert  

When you click the Insert button, data will be added below the final 

row in the standard list.  

5 Delete  

Click the column of the sample No. to be deleted, and it becomes 

active.  Then, click the Delete button, and the relevant sample 

data will be deleted.  
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When selecting the Monitor tab, the window in Fig. 4-17 appears.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 4-17  Monitor Tab 

 

 

Assign the following parameters.  

 

1 Y-Axis Max (maximum)  

Enter a maximum value for Y-axis on the monitor window.  

2 Y-Axis Min (minimum)  

Enter a minimum value for Y-axis on the monitor window.  

3 Open data processing window after data acquisition  

Select whether or not to conduct data processing after sample 

measurement.  When selected (check mark is applied), an icon 

for this function (as shown in ) is displayed.  

Opening the saved file allows data processing such as peak 

detection.  When this function is not selected, data processing can 

be achieved by reading out the file via [File]-[Open].  

4 Print report after data acquisition  

Select whether or not to print a report after sample measurement.  

When selected (check mark is applied), printing will be made 

automatically after measurement.  The items set at the Report tab 

will be printed.  

 

4.2.5 Monitor Tab 

 



4.2.6 

4 - 21 

Select the Report tab, and the window in Fig. 4-18 will appear.  

 

 

 

Fig. 4-18  Report Tab  

 

 

On this window, select the items to be contained in an analysis report.  

 

1 Output  

• Print Report  

A report will be printed.  For printing method, refer to 4.5.  

• Use Microsoft(R) Excel  

Data will be transferred to Microsoft(R) Excel.  For transferring 

method, refer to 7.13.  

• Use print generator sheet  

Select this method for using the report generator (option).   

For usage, refer to the instruction manual of the report 

generator.  

4.2.6 Report Tab 
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2 Print items (printable/transferable items) 

• Include date  

• Include method  

• Include calibration curve  

• Include standards data  

• Include calibration data  

• Include sample data  

3 Printer Font  

Click the Select button for changing the front to be used in the 

report.  
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4.3  Defining Your Samples  
 

When “Use sample table” is not selected in Analysis Method, a sample 

must be defined in the following procedure before measurement.  

 

(1) Click the  button.  The window in Fig. 4-19 will appear.  

 

 

 

Fig. 4-19 

 

 

(2) Make entries for Sample name and Comment.  

Maximum number of enterable characters (half-size)  

Sample name : 40 characters  

Comment : 255 characters  

 

For automatic saving, put a check mark in the “Auto File” box to 

specify a file name.  First click the Select button, and then 

specify a saving location and enter a file name.  

When you put a check mark at the head of “Auto Text file” and 

“Auto Meta file” after turning on “Auto File,” photometry data can 

be saved automatically in the following file formats as soon as this 

data is automatically saved.  

• ASCII text file (*.txt)  

• Graph meta file (*.wmf)  

The data will be saved in the file name entered for “File name.”  

 

(3) After completion of setting, click OK.  

4.3.1 Without Using 

Sample Table 
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When “Use sample table” is selected in Analysis Method, samples must 

be defined in the following procedure before measurement.  

Open the monitor window and click the  button.  

When the Sample Table window in Fig. 4-20 appears, enter the sample 

name and comment for each sample.  

 

1 For creating a sample table newly, make entry for Number of 

Samples and click the Update button.  For instance, if there are 

five samples, enter “5” for Number of Samples and click the 

Update button.  

 

 

 

Fig. 4-20  Sample Table  

 

 

2 For adding a row at the end of sample table, click the Insert button.  

3 To delete an unnecessary row, click its row No. to make it active as 

shown in Fig. 4-21.  Then, click the Delete button.  

4.3.2 With Sample 

Table 
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Fig. 4-21  

 

 

4 Make entries for Sample and Comments of each sample.  

Maximum number of characters to be entered (half-size)  

Sample : 40 characters  

Comment : 255 characters  

 

Next, you must enter a file name for automatic saving after 

measurement.  Click the […] button, and specify a saving location 

and enter a file name.  

 

 

 

Fig. 4-22 
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5 After entries, check them and then click the OK button.  

6 Load button  

Used for reading out the existing sample table.  

Clicking the Load button displays the file opening dialog.  

 

 

 

Fig. 4-23  File Opening Dialog  

 

 

Select a sample table and click the Open button.   

The specified sample table will be read out.  

7 Save button  

The contents of change can be saved by overwriting.  In case of a 

new generation, the Save As dialog will open.  

8 Save As button  

Used for saving the sample table with a name newly given.  

Click this button, and the Save As dialog will open.  



4.3.2 

4 - 27 

 

 

 

Fig. 4-24  Save As Dialog 

 

 

Select a saving location and enter a file name.  Then, click the Save 

button.  
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4.4  Conducting Measurement  
 

First create a calibration curve, and then proceed to sample 

measurement.  

 

(1) Click , select the Standards tab and make sure standards 

have already been defined.  (Refer to 4.2.4.)   

Click the  button or  button to also confirm that the 

samples have already been defined.  (Refer to 4.3.)  

 

(2) Click the  (measurement) button to start measurement.  

When measurement starts, the window in Fig. 4-25 appears.  

 

 

 

Fig. 4-25 

 

 

(3) When you click Yes, and the window in Fig. 4-26 will appear.  

 

 

 

Fig. 4-26 

 

4.4.1 Standards 

Measurement 
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Set standard sample 1 and click OK.  

This standard sample is measured and advance to the next 

standard measurement is awaited.  Since a window as shown in 

Fig. 4-25 appears, you should click Yes.  

Then, a window as shown in Fig. 4-26 appears.  Set the next 

standard sample and click OK.  Continue standard 

measurement until the standards set at the Standards tab in 

Analysis Method are all measured.  

 

(4) When measurement of all standards is finished, a window as 

shown in Fig. 4-27 appears.  Clicking of the OK button under 

selection of “Go to measure samples” takes you to measurement 

of unknown samples.  

 

 

 

Fig. 4-27 
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Now let’s measure samples.  

Operation differs between when a sample table is used and when it is 

not used.  

 

(1) Without using a sample table  

(when “Use sample table” is not selected in Analysis Method)  

 

 

 

Fig. 4-28 

 

 

① Set a sample and click the Sample(F4) button.  

Measurement is carried out and the result is displayed.  

 

② For blank measurement at the mid-point of sample 

measurement, click Blank(F5).  

 

③ To interrupt the measurement for other samples, click the 

Interrupt(F7) button.  

The window in Fig. 4-29 will appear.  Enter a number for 

Interrupt’s Sample No.  

 

 

 

Fig. 4-29 

4.4.2 Sample 

Measurement 
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④ Click the OK button, and the window in Fig. 4-30 will appear.  

 

 

 

Fig. 4-30 

 

 

⑤ Click the OK button, and measurement of the interruption 

sample starts.  

 

⑥ When sample measurement is finished, click the End(F9) 

button.  

When auto saving is selected, the measured data will be 

saved automatically at the specified saving location using the 

specified file name.   

When auto saving is not selected, you must select the “Save 

As” command from the File menu to save the measured data.  

 

Entry and Change of Sample Name  

After completion of sample measurement, sample names 

can be entered on the monitor window (Fig. 4-31).  

 

 

 

Fig. 4-31 

 

 

Follow steps (a) to (d).  

5
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(a) Select Edit Sample Name from the Edit menu as shown in 

Fig. 4-32.  

 

 

 

Fig. 4-32 

 

 

(b) The Edit Sample Name dialog opens as shown in Fig. 4-33.  

 

 

 

Fig. 4-33 
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(c) Enter sample names as exemplified in Fig. 4-34 and click the 

Update or OK button.   

 

 

 

Fig. 4-34 

 

 

(d) The monitor window is redisplayed with the newly entered 

sample names as shown in Fig. 4-35.  

 

 

 

Fig. 4-35 

 

 

For saving the data after entry of sample names, click the 

 button.  The data processing window appears.  

Select the Save As command from the File menu and save 

the data.  

For changing the sample names, follow the same procedure 

as for entry of sample names.  
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(2) With sample table (when “Use sample table” is selected in 

Analysis Method)  

 

 

 

Fig. 4-36 

 

 

① The message box shown in Fig. 4-37 appears.  Carry out 

operation according to the messages.  Measurement can 

be continued by clicking Yes and OK alternately.  

 

 

 

Fig. 4-37 
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② To interrupt the measurement for other samples, put a check 

mark for “Insert a new sample into the sequence?” as shown 

in Fig. 4-38.  Then, click Yes.  

 

 

 

Fig. 4-38 

 

 

③ The window in Fig. 4-39 appears.  Enter the sample name 

and comment, and then click OK.  

 

 

 

Fig. 4-39 
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④ When you click OK, measurement of the interruption sample 

starts.  

 

 

 

Fig. 4-40 

 

 

When measurement of all samples is over, the data 

processing window shown in Fig. 4-41 will be displayed 

automatically (only when “Open data processing window 

after data acquisition” is selected at the Monitor tab in 

Analysis Method).  

After measurement of all the samples entered for Sample 

Table, the photometric data will be saved automatically at the 

specified saving location using the specified file name.  
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Upon completion of photometry or when opening the data file, the data 

processing window is displayed as shown in Fig. 4-41.  

 

 

 

 

Fig. 4-41  Data Processing Window (photometry) 

 

 

① Standard data  

The measurement results of standards used for preparing a 

calibration curve are displayed.  

 

 

 

Fig. 4-41-1  Standard Data 

 

 

② Calibration curve  

A calibration curve obtained from standard data is displayed.  

The curve can also be traced.  

Photometric value and Concentration are indicated at the top left 

of this field.  

4.4.3 Explanation of 

Measurement 

Result Window

① Standard data
② Calibration 

curve 

③ Results of sample 
measurement 

④ Calibration curve 
data 
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③ Results of sample measurement 

Sample data such as photometric value (Data), concentration 

(Conc), mean value (Avg Conc), standard deviation (SD), 

coefficient of variation (CV) and upper/lower limit judgment results 

(HIGH/LOW) are displayed.  

 

 

 

Fig. 4-41-2  Results of Sample Measurement  

 

 

④ Calibration curve data  

Data such as determination coefficient and factors (A0, A1, A2, 

A3) of calibration curve are displayed.  And the calibration type 

can be changed.   

 

 

 

Fig. 4-41-3  Calibration Curve Data 
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NOTICE: 1. The data measured under the following conditions will 

be saved automatically in Program Files\FL 

Solutions\Data.  (Example:  C:Program Files\FL 

Solutions\Data)  

(1) Measurement was carried out using a sample table 

with no file name specified in the File Name 

column.  

(2) Measurement was carried out with “Auto File” 

specified and a file name unspecified, avoiding use 

of a sample table.  

 2. The data measured under the following conditions will 

be saved automatically in Program Files\FL Solutions.  

(Example:  C:Program Files\FL Solutions)  

(3) There is not an adequate free area in the specified 

storage medium (such as floppy disk or MO).   

(4) Writing is inhibited.  

A file automatically saved under such a condition as above is 

named according to the following rule.  

Rule 1: When a file name is given to analysis method: 

File name of analysis method + serial No. (001, 

002, ...)  

Rule 2: When a file name is not given to analysis method:  

DEFLT + serial No. (001, 002, ...)  
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If remeasurement becomes necessary after completing a series of 

measurements, both standard and sample data accept remeasurement.  

 

① Click the data to be remeasured for making it active as shown in 

Fig. 4-42.   

 

NOTE: Figure 4-42 shows the window for the case where the sample 

table is not used.  Five buttons including the Remeasure(F8) 

are displayed.  On the window for the case where the sample 

table is used, only the Remeasure(F8) button is displayed.  

 

 

 

Fig. 4-42 Measurement End Window  

(without using sample table) 

 

 

② Click the Remeasure(F8) button.  A window as shown in Fig.  

4-43 will appear.  

 

 

 

Fig. 4-43 
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③ Click OK, and measurement will start.  When standards are 

remeasured, a calibration curve will be displayed through 

recalculation of the data.  

 

④ For saving data after remeasurement, click the  button.  

The data processing window appears.  From the File menu, 

select “Save As” and save the data.  

 

Remeasurement is possible for both standard and sample data.  
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Statistical calculation ensues from sample measurement.  The results 

are displayed in the “Avg Conc” column of the data processing window 

as shown in Fig. 4-41-2.  
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Here, N = Number of standards  

 MEAN = Mean value  

 SD = Standard deviation  

 CV = Coefficient of variation (%)  

 

NOTE: [∗∗∗∗∗] is indicated for SD and CV values when they are nearly 

“0.”  

 

 

4.4.5 Statistical 

Calculation 
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4.5  Data Printout  
 

Printout can be provided even when the function for automatic printout 

after measurement is not used.  The following two procedures are 

available.  

 

(1) Click on the spectrum window, and the circumference turns blue.  

In this status, select the Print command from the File menu.   

Or click the  (print) button on the toolbar.  The field active 

on the data processing window (e.g., ② in Fig. 4-41) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.  

 

 

 

Fig. 4-44 
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(2) Select the Report command in the Data menu.  Or click the  

(report) button on the toolbar.  The Print Preview window will 

appear as shown below.  For printout, click the Print button.  

Measurement conditions will be printed together.  

 

 

 

Fig. 4-45 

 

 

Select the items to be printed at the Report tab with the 

Photometry Properties command chosen in the Edit menu.  

 

 

 

Fig. 4-46 
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4.6  Manual Input of Standard Data  
 

The standard data can be entered manually.  This function is usable 

after measurement of standards.  Either select Standard Data from the 

Edit menu on the monitor window or click the  button.  A window 

as shown in Fig. 4-47 will appear.  So enter values in the Data column.  

After entry, click the OK or Update button.  Then, the calibration curve 

is recalculated and displayed.  

 

 

 

Fig. 4-47 
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4.7  Measurement Using Saved Calibration Curve  
 

Call a calibration curve in the following way.  

 

(1) Set measurement mode in Photometry.  

 

(2) From the File menu, select the calibration curve load command.  

The following message is reported in a dialog box.   

This message does not appear immediately after turning on 

power supply or when measurement mode is other than 

Photometry.  

Click the OK button.  

 

 

 

Fig. 4-48 

 

 

(3) A window as shown below will appear.  Select the file of the 

calibration curve to be used.  

After file selection, click the Open button.  

 

 

 

Fig. 4-49 
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(4) The window in Fig. 4-50 is now displayed.  The sample data 

section is blank.   

 

 

 

Fig. 4-50 

 

 

 (5) Click the  button, and the window in Fig. 4-51 will appear.  

Enter a sample name and comment.  

Click the OK button.  

 

 

 

Fig. 4-51 

Sample data 
section 



4.7  Measurement Using Saved Calibration Curve 

4 - 48 

(6) Set a sample to be measured.  Click the  button.   

(Or select the Scan command from the Spectrophotometer 

menu.)  

 

(7) The following message box appears.  

Click the OK button.  

 

 

 

Fig. 4-52 

 

 

(8) The Sample button is now active.  Click this button.  

Measurement starts.  

 

 

 

Fig. 4-53 

 

 

(9) After measurement, click the End(F9) button for termination.  
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5.  3-D SCAN  

 

5.1  Flow of Operation  
 

This section explains the parameter setting and operating method for 3-

D scan.  Measurement proceeds along the following flow.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5-1  Operational Flow (3-D scan)  

Click 
 

 button and set your analytical conditions. 

 
 

• Scan range 

• Data mode 

• Scan speed, etc. 

Click  button. 

 

• Sample name 

• Auto File 

• File name, etc. 

Set a sample. 

Click  button to execute wavelength scan. 

• Spectrum tracing 

• Peak detection 

• Spectral calculation 

Click  button.  Measurement result will be displayed 

in a report format. 

 

Start 

Method setting 

(See 5.2.) 

Sample name/ 

comment input 

(See 5.3.) 

Measurement 

(See 5.4.) 

Data processing 

(See Section 7.) 

Result output in report 

(See 5.9.) 

End 
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5.2  Creating an Analysis Method  
 

Set the analytical conditions (method) prior to measurement.  

 

(1) Click the  button on the Measurement toolbar.  The window 

in Fig. 5-2 appears.  

(Or select the Method command from the Edit menu.)   

 

 

 

Fig. 5-2  Analysis Method  

 

 

(2) The following tabs are provided on the Analysis Method window 

for the 3-D scan mode.  These tabs are detailed on the 

subsequent pages.  

• General  

• Instrument  

• Monitor  

• Processing  

• Report  
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The parameters shown in Fig. 5-3 are provided at the General tab.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 5-3  General Tab 

 

 

1 Measurement (mode)  

A measurement mode is selectable.  Here, select “3-D Scan.”  

For Wavelength scan, Time scan, Photometry and 3-D Time scan, 

refer to Sections 2, 3, 4 and 6, respectively.  

2 Operator  

Enter an operator name.  

3 Instrument  

The name of the connected instrument is indicated.  

4 Sampling 

- Standard  

Indicates that samples are to be exchanged manually.   

5 Comments  

Enter a description or notes on measuring conditions.  

5.2.1 General Tab 
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8 
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6 Load  

Click this button to read out saved analytical conditions.   

Upon clicking, the file opening window appears.  So, select an 

analytical condition file.  

7 Save  

When you click this button after setting the parameters, the 

analytical conditions can be saved by overwriting.  In case of a 

new analysis method, clicking this button displays the “Save As” 

window.  You must enter a file name for saving in this window.  

8 Save As  

Click this button for renaming the set conditions for saving.   

The “Save As” window appears, so enter a file name.  
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The window shown below is based on that 3-D Scan is specified for 

Measurement at the General tab.  When you click the Instrument tab, 

the window in Fig. 5-4 appears.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 5-4  Instrument Tab 

 

 

1 Data mode  

Select a data mode.  The Phosphorescence mode is for acquiring 

only phosphorescence after extinction of excitation beam while 

turning a chopper on the excitation side.  

2 Chopping speed  

Select a chopping speed.  Setting is allowed when 

Phosphorescence is selected for Data mode.   

The Phosphorescence mode is for acquiring only phosphorescence 

after extinction of excitation beam while turning a chopper on the 

excitation side.  An increase in chopping speed makes the 

chopper turns faster.  

3 EX Start WL  

This is the start wavelength on the excitation side in wavelength 

scan.  Enter the shorter wavelength side of measuring wavelength 

range.  

5.2.2 Instrument 

Tab 
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4 EX End WL  

This is the end wavelength on the excitation side in wavelength 

scan.  Enter the longer wavelength side of measuring wavelength 

range.  

5 EX Sampling interval  

In the 3-dimensional scan mode, emission spectrum measurement 

is repeated while shifting the excitation wavelength.  Therefore, a 

shorter sampling interval on the excitation side will result in a longer 

measurement time.  

6 EM Start WL  

This is the start wavelength on the emission side in wavelength 

scan.  Enter the shorter wavelength side of measuring wavelength 

range.  

7 EM End WL  

This is the end wavelength on the emission side in wavelength 

scan.  Enter the longer wavelength side of measuring wavelength 

range.  

8 EM Sampling interval  

In the 3-dimensional scan mode, emission spectrum measurement 

is repeated while shifting the excitation wavelength.  Therefore, a 

shorter sampling interval on the emission side will result in a longer 

measurement time.  

9 Scan speed  

Set a wavelength scan speed.  

10 EX Slit  

Select a slit width on the excitation side.  

11 EM Slit  

Select a slit width on the emission side.  

12 PMT Voltage  

A function for controlling the voltage of the photomultiplier detector 

(photomultiplier tube).  As a reference, changing from 400 V to 

700 V increases the data value about two digits and changing from 

700 V to 950 V increases it about 1 digit.  

When a check mark is put for PMT Voltage 0-1000V, the 

photomultiplier voltage is settable within a range from 0 to 1000 V.  

13 PMT Voltage 0-1000V  

When a check mark is put in this box, the photomultiplier voltage is 

settable within a range from 0 to 1000 V.  
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14 Response  

When “Auto” is selected, response will be set automatically 

depending on scan speed.  Select “Auto” usually.  

15 Corrected spectra  

A function for determining the spectrum inherent to a sample by 

correcting the photometer wavelength characteristic using the 

saved instrument parameters, following measurement with the 

instrument parameters for photometer control.  If there are no 

instrument parameters for the wavelength range to be measured, 

only the wavelength range that allows correction is scanned.   

And if there is no wavelength area measurable, an error will occur.  

The Instrument Response command is provided in the Utility menu 

for operating this function.  

When this setting is at ON, “Corrected spectra” appears on the 

monitor window.  (See Fig. 1-43 in 1.6.)  

16 Shutter control  

The shutter can automatically be closed in other than measurement 

for slowing down sample deterioration due to the energy of 

excitation beam and opened when measurement starts.   

17 Range of corrected spectra  

Spectrum correction range is indicated.  

18 Prediction measurement time  

The predicted measurement time is indicated.  After change of a 

parameter such as scan speed, click the Update button.   

The predicted value will then be updated.  
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When selecting the Monitor tab, the window in Fig. 5-5 appears.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 5-5  Monitor Tab 

 

 

Assign the following parameters.  

 

1 Y-Axis Max (maximum)  

Enter a maximum value for Y-axis on the monitor window.  

2 Y-Axis Min (minimum)  

Enter a minimum value for Y-axis on the monitor window.  

3 Contour interval  

Function for setting intervals of drawing contour lines.   

4 Open data processing window after data acquisition  

Select whether or not to conduct data processing after sample 

measurement.  When selected (check mark is applied), an icon 

(as shown in ) is displayed for the data 

processing window at the end of measurement.  And by opening 

this icon, data processing such as peak detection is available.  

 

5.2.3 Monitor Tab 

 

2 

1 

4 

5 

3 
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NOTE: When the remaining memory capacity of PC in operation is 

very small (system resource is less than 20%), the data 

processing window will not open even if this item is turned ON.  

Either close the presently opened data processing window or 

restart the FL Solutions program.  

 

5 Print report after data acquisition  

Select whether or not to print a report after sample measurement.  

When selected (check mark is applied), printing will be made 

automatically after measurement.  The items set at the Report tab 

will be printed.  When this item is not selected, data processing is 

allowed by reading out a file via [File] - [Open].  
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On selection of the Processing tab, the window in Fig. 5-6 will be 

displayed.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 5-6  Processing Tab 

 

 

1 Peak Finding:  Integration method  

Select an integration method for the peaks to be displayed in the 

data processing window.  

2 Threshold  

Set a detection limit for the photometric value axis of peak and 

valley.  Peaks or valleys below the setting will not be detected.  

3 Sensitivity  

Select the number of data points in the horizontal axis direction 

(abscissa).  For detecting sharp peaks, select a sensitivity value of 

“1.”  Or select “8” for detecting broad peaks.  

 

 

5.2.4 Processing 

Tab 
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Select the Report tab, and the window in Fig. 5-7 will appear.  

 

 

 

Fig. 5-7  Report Tab 

 

 

1 Output  

• Print Report  

A report will be printed.  For printing method, refer to 5.9.  

• Use Microsoft(R) Excel  

Data will be transferred to Microsoft(R) Excel.  For transferring 

method, refer to 7.13.  

• Use print generator sheet  

Select this method for using the report generator (option).   

For usage, refer to the instruction manual of the report 

generator.  

2 Orientation  

Selectable when Print Report is chosen for Output.  

Select a printing orientation.  Either Portrait or Landscape 

orientation is selectable.  When the Landscape orientation is 

selected, date and method can be printed.  

5.2.5 Report Tab 

 

4 

3 

1 

2
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3 Print items (printable/transferable items) 

• Include date  

• Include instrument 

• Include graph  

When you put a check mark for this item, any of the graphs 

listed below is selectable.  

◊ Contour  

◊ Bird’s-eye view  

◊ Contour and Bird’s-eye view  

◊ Contour and Spectrum  

• Include peak table  

• Data listing  

◊ Interval  

◊ Start  

◊ End  

These parameters are settable when “Use Microsoft(R) Excel” 

or “Use print generator sheet” is specified for Output.  

For time scan, make entries for Interval, Start and End.  

For wavelength scan, make entries for Interval, Start and End.  

4 Printer Font  

Click the Select button for changing the font to be used in the 

report.  
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5.3  Defining Your Samples  
 

A sample must be defined in the following procedure before 

measurement.  

 

(1) Click the  (sample name/comment input) button on the 

Measurement toolbar.  The window in Fig. 5-8 will appear.  

 

 

 

Fig. 5-8 

 

 

(2) Make entries for Sample name and Comment.  

Maximum number of enterable characters (half-size)  

Sample name : 40 characters  

Comment : 255 characters  

 

For automatic saving, put a check mark in the “Auto File” box to 

specify a file name.  First click the Select button, and then 

specify a saving location and enter a file name.  

When you put a check mark at each head of “Auto Text file” and 

“Auto Meta file” after turning on “Auto File,” 3-D scan data can be 

saved automatically in the following file formats as soon as this 

data is automatically saved.  

• ASCII text file (*.txt)  

• Graph meta file (*.wmf)  

The data will be saved in the file name entered for “File name.”  

 

(3) After completion of setting, click OK.  
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5.4  Conducting Measurement  
 

(1) Make sure an analysis method has been set and a sample has 

been defined.  (Refer to “5.2 Creating an Analysis Method” and 

“5.3 Defining Your Samples.”)  

 

(2) Set a sample in the sample compartment and click the  

button on the Measurement toolbar to start measurement.   

(See ① in Fig. 5-9.)  

On this monitor window, the X and Y axes stand for the EM and 

EX-side wavelengths, respectively.  

 

 

 

Fig. 5-9  Monitor Window 

 

 

(3) For halting the measurement midway, click the  (stop) 

button on the toolbar.  (See ② in Fig. 5-9.)  

 

(4) The information to be displayed upon opening the data 

processing window can be selected here by excluding 

unnecessary one from display.  

Select the Options command from the Tools menu and click the 

‘Display’ tab in the Options dialog box.  Then, the window in Fig. 

5-10 appears.  For example, select “Show contour plus EX,EM 

spectrum plus peak table” and click the OK button.  

1

2
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Fig. 5-10 

 

 

(5) When measurement is completed, the data processing window 

appears as shown in Fig. 5-11.  This is available only when a 

check mark is put for “Open data processing window after data 

acquisition” at the ‘Monitor’ tab of Analysis Method.  (See ④ in 

Fig. 5-5.)  

The measured data will be saved automatically when auto saving 

is selected.  

If auto saving is not selected, select the “Save As” command from 

the File menu and save the data.  Opening the saved data file 

will display the data processing window as shown below.  
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Fig. 5-11  Data Processing Window (3-D scan) 

 

 

① Contour lines  

From these contour lines, excitation and emission spectra can be 

read out.  

As the cursor is moved, the cursor-specified excitation and 

emission spectra are displayed in ② and ③.  

 

② Excitation spectrum  

An excitation spectrum at the cursor position in ① is displayed.  

Wavelength and photometric value can be read by selecting the 

“trace” command from the View menu or clicking the  button.   

 

③ Emission spectrum  

An emission spectrum at the cursor position in ① is displayed.  

Wavelength and photometric value can be read by selecting the 

“trace” command from the View menu or clicking the  button.   

 

④ Peak table  

Peak wavelength and peak height are indicated.  For setting 

threshold and sensitivity values, click the  button.  

 

① Contour lines

② Excitation spectrum 

③ Emission spectrum

④ Peak 
table 
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NOTICE: 1. The data measured under the following condition will be 

saved automatically in Program Files\FL Solutions\Data.  

(Example:  C:Program Files\FL Solutions\Data)  

(1) Measurement was carried out with “Auto File” 

specified and a file name unspecified.  

2. The data measured under the following conditions will 

be saved automatically in Program Files\FL Solutions.  

(Example:  C:Program Files\FL Solutions)  

(2) There is not an adequate free area in the specified 

storage medium (such as floppy disk or MO).   

(3) Writing is inhibited.  

A file automatically saved under such a condition as above is 

named according to the following rule.  

Rule 1: When a file name is given to analysis method:  

File name of analysis method + serial No. (001, 

002, ...)  

Rule 2: When a file name is not given to analysis method:  

DEFLT + serial No. (001, 002, ...)  
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5.5  Displaying Data in a Bird’s-Eye View  
 

3-D Scan data can be displayed in a bird’s-eye view.  

Select the  (bird’s-eye view) button on the Spectrum toolbar.   

(Or select the bird’s-eye view command from the View menu.)   

 

 

 

Fig. 5-12 

 

 

Viewing direction is changeable by clicking  (from front),  

(from rear),  (from left) or  (from right).   

Clicking  (contour line diagram) displays a contour line diagram.  

 

 



5.6 

5 - 19 

5.6  Contour Scale Expansion with Mouse  
 

In the contour display of 3-D scan data, display scale can be expanded 

with the mouse.  On the Spectrum toolbar, click the  (contour 

scale expansion) button.  The button is set in the clicked status.  

 

 

 

Fig. 5-13 

 

 

Move the mouse cursor onto the contour as shown in Fig. 5-14 and drag 

the mouse along an area to be expanded with the left mouse button 

held down.  
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Fig. 5-14 

 

 

The area enclosed with the mouse cursor is now expanded as shown in 

Fig. 5-15.  For restoring the original display, click the  (scale 

reset) button.  

 

 

 

Fig. 5-15 

 

 

For using the trace cursor on the contour window, click  again for 

returning to the non-clicked status.  
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5.7  Auto Scale Display of Data  
 

When you click the  (auto scale) button on the data processing 

window after completion of measurement or from which the 3-D scan 

data file has been read out, the contour window, excitation spectrum 

window and emission spectrum window are displayed in the auto scale 

mode as shown in Fig. 5-16.  

 

 

 

Fig. 5-16  (Before execution of auto scale)  
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Fig. 5-17  (After execution of auto scale) 

 

 

For restoring the original display, click the  (scale reset) button.  
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5.8  Linking Trace Cursors from Peak Table  
 

On the data processing window where a contour and peak table are 

displayed, you may move the mouse cursor onto the peak table and 

click the mouse.  As a result, each trace cursor on the contour window, 

excitation spectrum window and emission spectrum window moves to 

the peak wavelength position.  

 

 

 

Fig. 5-18 
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5.9  Data Printout  
 

Printout can be provided even when the function for automatic printout 

after measurement is not used.  The following two procedures are 

available.  

 

(1) Click on the spectrum window, and the circumference turns blue.  

In this status, select the Print command from the File menu.   

Or click the  (print) button on the toolbar.  The field active 

on the data processing window (e.g., ① in Fig. 5-11) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.  

 

 

 

Fig. 5-19 
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(2) Select the Report command in the Data menu.  Or click the  

button on the toolbar.  The Print Preview window will appear as 

shown below, so click Print.  Printout items should be selected 

at the Report tab in Spectrum Properties beforehand.  

 

 

 

Fig. 5-20 

 

 

NOTE: If characters overflow from the print frame in repeat 

measurement or in overlaying, then change the printing 

orientation from vertical (Portrait) to horizontal (Landscape) at 

the Report tab in Fig. 5-21.  
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Select the items to be printed in the following procedure.  

Click the  button, and the Spectrum Properties window will appear.   

↓ 

Select the Report tab, and the window in Fig. 5-21 will open.  

↓ 

In this window, select desired print items.  

 

 

 

Fig. 5-21 
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6.  3-D TIME SCAN  

 

6.1  Flow of Operation  
 

This section explains the parameter setting and operating method for 3-

D time scan.  Measurement proceeds along the following flow.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 6-1  Operational Flow (3-D time scan) 

Click 
 

 button and set your analytical conditions. 

 

 

• Scan range 

• Data mode 

• Scan speed, etc. 

Click  button. 

 

• Sample name 

• Auto File 

• File name, etc. 

Set a sample. 

Click  button to execute wavelength scan. 

• Spectrum tracing 

• Peak detection 

Click  button.  Measurement result will be displayed 

in a report format. 

 

Start 

Method setting 
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comment input 

(See 6.3.) 

Measurement 

(See 6.4.) 

Data processing 

(See Section 7.) 

Result output in report 

(See 6.9.) 

End 
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6.2  Creating an Analysis Method  
 

Set the analytical conditions (method) prior to measurement.   

 

(1) Click the 
 

 button on the Measurement toolbar.  The window 

in Fig. 6-2 appears.  

(Or select the Method command from the Edit menu.)   

 

 

 

Fig. 6-2  Analysis Method  

 

 

(2) On the Analysis Method window, analytical conditions for the 3-D 

time scan mode can be set.  The following tabs are provided on 

this window.  These tabs are detailed on the subsequent pages.  

• General  

• Instrument  

• Monitor  

• Processing  

• Report  
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The parameters shown in Fig. 6-3 are provided at the General tab.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 6-3  General Tab 

 

 

1 Measurement (mode)  

A measurement mode is selectable.  Here, select “3-D Time 

scan.”  

For Wavelength scan, Time scan, Photometry and 3-D Scan, refer 

to Sections 2, 3, 4 and 5, respectively.  

2 Operator  

Enter an operator name.  

3 Instrument  

The name of the connected instrument is indicated.  

4 Sampling 

- Standard  

Indicates that samples are to be exchanged manually.  

5 Comments  

Enter a description or notes on measuring conditions.  

6.2.1 General Tab 
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6 Load  

Click this button to read out saved analytical conditions.   

Upon clicking, the file opening window appears.  So, select an 

analytical condition file.  

7 Save  

When you click this button after setting the parameters, the 

analytical conditions can be saved by overwriting.  In case of a 

new analysis method, clicking this button displays the “Save As” 

window.  You must enter a file name for saving in this window.  

8 Save As  

Click this button for renaming the set conditions for saving.   

The “Save As” window appears, so enter a file name.  
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The window shown below is based on that 3-D Time scan is specified 

for Measurement at the General tab.  When you click the Instrument 

tab, the window in Fig. 6-4 appears.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 6-4  Instrument Tab 

 

 

1 Scan mode  

Select a scan mode here.  In case of Synchronous, the abscissa 

of the graph stands for excitation wavelength.  The unit indication 

of the abscissa becomes ‘EX/EM (nm).’  

2 Data mode  

Select a data mode.  The Phosphorescence mode is for acquiring 

only phosphorescence after extinction of excitation beam while 

turning a chopper on the excitation side.  

3 Chopping speed  

Select a chopping speed.  Setting is allowed when 

Phosphorescence is selected for Data mode.   

The Phosphorescence mode is for acquiring only phosphorescence 

after extinction of excitation beam while turning a chopper on the 

excitation side.  An increase in chopping speed makes the 

chopper turns faster.  

6.2.2 Instrument 

Tab 
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4 EM WL  

For the Excitation scan mode, enter the fixed wavelength on the 

emission side .  For the Synchronous scan mode, enter the start 

wavelength on the emission side.  

5 EX Start WL  

This is the start wavelength on the excitation side in wavelength 

scan.  Enter the shorter wavelength side of measuring wavelength 

range.  

6 EX End WL  

This is the end wavelength on the excitation side in wavelength 

scan.  Enter the longer wavelength side of measuring wavelength 

range.  

7 EX WL  

For the Emission scan mode, enter the fixed wavelength on the 

excitation side.  

8 EM Start WL  

This is the start wavelength on the emission side in wavelength 

scan.  Enter the shorter wavelength side of measuring wavelength 

range.  

9 EM End WL  

This is the end wavelength on the emission side in wavelength 

scan.  Enter the longer wavelength side of measuring wavelength 

range.  

10 Scan speed  

Set a scan speed.  

11 EX Slit  

Select a slit width on the excitation side.  

12 EM Slit  

Select a slit width on the emission side.  

13 PMT Voltage  

A function for controlling the voltage of the photomultiplier detector 

(photomultiplier tube).  As a reference, changing from 400 V to 

700 V increases the data value about two digits and changing from 

700 V to 950 V increases it about 1 digit.  

When a check mark is put for PMT Voltage 0-1000V, the 

photomultiplier voltage is settable within a range from 0 to 1000 V.  

14 PMT Voltage 0-1000V  

When a check mark is put in this box, the photomultiplier voltage is 

settable within a range from 0 to 1000 V.  
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15 Response  

When “Auto” is selected, response will be set automatically 

depending on scan speed.  Select “Auto” usually.  

16 Corrected spectra  

A function for determining the spectrum inherent to a sample by 

correcting the photometer wavelength characteristic using the 

saved instrument parameters, following measurement with the 

instrument parameters for photometer control.  If there are no 

instrument parameters for the wavelength range to be measured, 

only the wavelength range that allows correction is scanned.   

And if there is no wavelength area measurable, an error will occur.  

The Instrument Response command is provided in the Utility menu 

for operating this function.  

When this setting is at ON, “Corrected spectra” appears on the 

monitor window.  (See Fig. 1-43 in 1.6.)  

17 Shutter control  

The shutter can automatically be closed in other than measurement 

for slowing down sample deterioration due to the energy of 

excitation beam and opened when measurement starts.   

18 Replicates  

Set the number of repeat measurements.   

19 Cycle time  

Set a repetition interval.  

20 Range of corrected spectra  

Spectrum correction range is indicated.  

21 Prediction measurement time  

The predicted measurement time is indicated.  After change of a 

parameter such as scan speed, click the Update button.   

The predicted value will then be updated.  
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When selecting the Monitor tab, the window in Fig. 6-5 appears.   

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 6-5  Monitor Tab  

 

 

Assign the following parameters.  

 

1 Y-Axis Max (maximum)  

Enter a maximum value for Y-axis on the monitor window.  

2 Y-Axis Min (minimum)  

Enter a minimum value for Y-axis on the monitor window.  

3 Contour interval  

Function for setting intervals of drawing contour lines.   

4 Open data processing window after data acquisition  

Select whether or not to conduct data processing after sample 

measurement.  When selected (check mark is applied), an icon 

(as shown in ) is displayed for the data 

processing window at the end of measurement.  And by opening 

this icon, data processing such as peak detection is available.  

 

6.2.3 Monitor Tab 
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1 
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NOTE: When the remaining memory capacity of PC in operation is 

very small (system resource is less than 20%), the data 

processing window will not open even if this item is turned ON.  

Either close the presently opened data processing window or 

restart the FL Solutions program.  

 

5 Print report after data acquisition  

Select whether or not to print a report after sample measurement.  

When selected (check mark is applied), printing will be made 

automatically after measurement.  The items set at the Report tab 

will be printed.  When this item is not selected, data processing is 

allowed by reading out a file via [File] - [Open].  
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On selection of the Processing tab, the window in Fig. 6-6 will be 

displayed.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 6-6  Processing Tab  

 

 

1 Peak Finding:  Integration method  

Select an integration method for the peaks to be displayed in the 

data processing window.  

2 Threshold  

Set a detection limit for the photometric value axis of peak and 

valley.  Peaks or valleys below the setting will not be detected.  

3 Sensitivity  

Select the number of data points in the horizontal axis direction 

(abscissa).  For detecting sharp peaks, select a sensitivity value of 

“1.”  Or select “8” for detecting broad peaks.  

 

 

6.2.4 Processing 

Tab 

 

1 

3
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Select the Report tab, and the window in Fig. 6-7 will appear.  

For the settable range of each parameter, refer to Appendix G.  

 

 

 

Fig. 6-7  Report Tab  

 

 

1 Output  

• Print Report  

A report will be printed.  For printing method, refer to 6.9.  

• Use Microsoft(R) Excel  

Data will be transferred to Microsoft
(R)
 Excel.  For transferring 

method, refer to 7.13.  

• Use print generator sheet  

Select this method for using the report generator (option).   

For usage, refer to the instruction manual of the report 

generator.  

2 Orientation  

Selectable when Print Report is chosen for Output.  

Select a printing orientation.  Either Portrait or Landscape 

orientation is selectable.  When the Landscape orientation is 

selected, date and method can be printed.  

6.2.5 Report Tab 
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3 
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3 Print items (printable/transferable items) 

• Include date  

• Include instrument  

• Include graph  

When you put a check mark for this item, any of the graphs 

listed below is selectable.  

◊ Contour  

◊ Bird’s-eye view  

◊ Contour and Bird’s-eye view  

◊ Contour and Spectrum  

• Data listing  

◊ Interval  

◊ Start  

◊ End  

These parameters are settable when “Use Microsoft(R) Excel” 

or “Use print generator sheet” is specified for Output.  

For time scan, make entries for Interval, Start and End.  

For wavelength scan, make entries for Interval, Start and End.  

4 Printer Font  

Click the Select button for changing the font to be used in the 

report.  
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6.3  Defining Your Samples  
 

A sample must be defined in the following procedure before 

measurement.  

 

(1) Click the  (sample name/comment input) button on the 

Measurement toolbar.  The window in Fig. 6-8 will appear.  

 

 

 

Fig. 6-8  

 

 

(2) Make entries for Sample name and Comment.  

Maximum number of enterable characters (half-size)  

Sample name : 40 characters  

Comment : 255 characters  

 

For automatic saving, put a check mark in the “Auto File” box to 

specify a file name.  First click the Select button, and then 

specify a saving location and enter a file name.  

When you put a check mark at each head of “Auto Text file” and 

“Auto Meta file” after turning on “Auto File,” 3-D time scan data 

can be saved automatically in the following file formats as soon 

as this data is automatically saved.  

• ASCII text file (*.txt)  

• Graph meta file (*.wmf)  

The data will be saved in the file name entered for “File name.”  

 

(3) After completion of setting, click OK.  
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6.4  Conducting Measurement  
 

(1) Make sure an analysis method has been set and a sample has 

been defined.  (Refer to “6.2 Creating an Analysis Method” and 

“6.3 Defining Your Samples.”)  

 

(2) Set a sample in the sample compartment and click the  

button on the Measurement toolbar to start measurement.   

(See ① in Fig. 6-9.)  

On this monitor window, the X and Y axes stand for the EM-side 

wavelength and time (s), respectively.  

 

 

 

Fig. 6-9  Monitor Window  

 

 

(3) For halting the measurement midway, click the  (stop) 

button on the toolbar.  (See ② in Fig. 6-9.)  

 

(4) When measurement is completed, the data processing window 

appears as shown in Fig. 6-10.  This is available only when a 

check mark is put for “Open data processing window after data 

acquisition” at the ‘Monitor’ tab of Analysis Method.  (See ④ in 

Fig. 6-5.)  

The measured data will be saved automatically when auto saving 

is selected.   

1

2
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If auto saving is not selected, select the “Save As” command from 

the File menu and save the data.  Opening the saved data file 

will display the data processing window as shown below.  

 

 

 

 

 

Fig. 6-10  Data Processing Window (3-D time scan)  

 

 

① Contour lines  

From these contour lines, the time-scan spectrum and emission, 

excitation or synchronous spectrum can be read out.  

As the cursor is moved, the cursor-specified time scan spectrum 

and emission, excitation or synchronous spectrum are displayed 

in ② and ③.  

 

② Time scan spectrum  

A time scan spectrum at the cursor position in ① is displayed.  

Wavelength and photometric value can be read by selecting the 

“trace” command from the View menu or clicking the  button.  

 

③ Emission spectrum (excitation spectrum, synchronous spectrum)  

An emission spectrum (excitation spectrum, synchronous 

spectrum) at the cursor position in ① is displayed.   

Wavelength and photometric value can be read by selecting the 

“trace” command from the View menu or clicking the  button.  

 

① Contour lines

② Time scan spectrum

③ Emission spectrum 

④ Peak 
table 
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④ Peak table  

Peak wavelength and peak height are indicated.  For setting 

threshold and sensitivity values, click the  button.  

 

NOTICE: 1. The data measured under the following condition will be 

saved automatically in Program Files\FL Solutions\Data.  

(Example:  C:Program Files\FL Solutions\Data)  

(1) Measurement was carried out with “Auto File” 

specified and a file name unspecified.  

2. The data measured under the following conditions will 

be saved automatically in Program Files\FL Solutions.  

(Example:  C:Program Files\FL Solutions)  

(2) There is not an adequate free area in the specified 

storage medium (such as floppy disk or MO).   

(3) Writing is inhibited.  

A file automatically saved under such a condition as above is 

named according to the following rule.  

Rule 1: When a file name is given to analysis method: 

File name of analysis method + serial No. (001, 

002, ...)  

Rule 2: When a file name is not given to analysis method:  

DEFLT + serial No. (001, 002, ...)  
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6.5  Displaying Data in a Bird’s-Eye View  
 

“3-D Time scan” data can be displayed in a bird’s-eye view.  

Select the  (bird’s-eye view) button on the Spectrum toolbar.   

(Or select the bird’s-eye view command from the View menu.)   

 

 

 

Fig. 6-11  

 

 

Viewing direction is changeable by clicking  (from front),  

(from rear),  (from left) or  (from right).  

Clicking  (contour line diagram) displays a contour line diagram.  
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6.6  Contour Scale Expansion with Mouse  
 

In the contour display of 3-D time scan data, display scale can be 

expanded with the mouse.  On the Spectrum toolbar, click the  

(contour scale expansion) button.  The button is set in the clicked 

status.  

 

 

 

Fig. 6-12  

 

 

Move the mouse cursor onto the contour as shown in Fig. 6-13 and drag 

the mouse along an area to be expanded with the left mouse button 

held down.  
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Fig. 6-13  

 

 

The area enclosed with the mouse cursor is now expanded as shown in 

Fig. 6-14.  For restoring the original display, click the  (scale 

reset) button.  

 

 

Fig. 6-14  

 

 

For using the trace cursor on the contour window, click  again for 

returning to the non-clicked status.  
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6.7  Auto Scale Display of Data  
 

When you click the  (auto scale) button on the data processing 

window after completion of measurement or from which the 3-D time 

scan data file has been read out, the contour window, excitation 

spectrum window and emission spectrum window are displayed in the 

auto scale mode as shown in Fig. 6-16.  

 

 

Fig. 6-15  (Before execution of auto scale)  

 

 

 

Fig. 6-16  (After execution of auto scale)  

 

For restoring the original display, click the  (scale reset) button.  
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6.8  Linking Trace Cursors from Peak Table  
 

On the data processing window where a contour and peak table are 

displayed, you may move the mouse cursor onto the peak table and 

click the mouse.  As a result, each trace cursor on the contour window, 

excitation spectrum window and emission spectrum window moves to 

the peak wavelength position.  

 

 

 

Fig. 6-17  
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6.9  Data Printout  
 

 

Printout can be provided even when the function for automatic printout 

after measurement is not used.  The following two procedures are 

available.  

 

(1) Click on the spectrum window, and the circumference turns blue.  

In this status, select the Print command from the File menu.   

Or click the  (print) button on the toolbar.  The field active 

on the data processing window (e.g., ① in Fig. 6-10) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.  

 

 

 

Fig. 6-18  

 

 

(2) Select the Report command in the Data menu.  Or click the  

button on the toolbar.  The Print Preview window will appear as 

shown below, so click Print.  Printout items should be selected 

at the Report tab in Spectrum Properties beforehand.  
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Fig. 6-19  

 

 

NOTE: If characters overflow from the print frame in repeat 

measurement or in overlaying, then change the printing 

orientation from vertical (Portrait) to horizontal (Landscape) at 

the Report tab in Fig. 6-20.  
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Select the items to be printed in the following procedure.  

 

Click the  button, and the Spectrum Properties window will appear.  

↓ 

Select the Report tab, and the window in Fig. 6-20 will open.  

↓ 

In this window, select desired print items.  

 

 

 

Fig. 6-20  
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7.  DATA PROCESSING 

 

This section explains the operation procedures for data processing after 

measurement. 

 

7.1  Loading of Data 
 

Load saved data in the following procedure. 

 

(1) Click the  (open) button on the Standard toolbar.  A window 

as in Fig. 7-1 will appear.  

(Or select the Open command from the File menu.) 

 

 

 

Fig. 7-1 

 

 

(2) The window (Fig. 7-1) has four tool buttons.  Table 7-1 lists the 

tool buttons and their functions. 

 

Table 7-1  Tool Buttons in Open Window 

 

Tool 
Button 

Function Tool 
Button 

Function 

 

Moves to the 
previously 
displayed folder.  

Creates a new 
folder. 

 

Displays a 
hierarchical folder 
at the next higher 
level.  

Lists the following 
display menu items: 
Thumbnails, Tiles, 
Icons, List and 
Details. 

4

3 

2 

1

Tool button
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NOTE: A file cannot be opened newly when the remaining memory 

capacity of PC in operation is very small (the system resource 

is less than 20%).  Either close the presently opened data 

processing window or restart the FL Solutions program. 

 

(3) Specify a folder containing a file to be loaded in “Look in.”  

For example, specify Program Files ⇒ FL Solutions ⇒ Data in 

the local disk.  (Refer to ① in Fig. 7-1.) 

 

(4) Select a file type in “Files of type.”  

The following file types are selectable. 

• Wavelength scan file (*.fds) 

• Time scan file (*.fdt) 

• Photometry file (*.fdq) 

• 3-D scan file (*.fd3) 

• 3-D time scan file (*.ft3) 

• Analysis method file (*.flm) 

• Sample table file (*.fls) 

• Report file (*.flr) 

• All files (*.*) 

 

The files of the selected type will be listed.  (Refer to ② in Fig. 

7-1.) 

 

(5) Select a file.  The selected file is highlighted in blue.  (Refer to 

③ in Fig. 7-1.) 

The following two methods are available for selecting multiple 

files. 

Method 1 : Click the first file and select the subsequent ones 

with the [↓] button while holding down the Shift key. 

Method 2 : Click each file while holding down the Ctrl key. 
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(6) After completion of selection, click Open.  (Refer to ④ in Fig.  

7-1.)  The selected file will open as shown in Fig. 7-2. 

 

 

 

 

Fig. 7-2 
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7.2  Spectrum Tracing 
 

This function is used to read the photometric value at a certain 

wavelength on the measured spectrum. 

For spectrum tracing, it is required to bring the trace cursor onto the 

displayed spectrum in the following two ways. 

 

(1) Click the  (trace cursor) button on the Spectrum toolbar.   

A trace cursor appears on the spectrum.  The wavelength and 

photometric value at the cursor position are indicated at the upper 

left in Fig. 7-3. 

 

 

 

 

 

 

Fig. 7-3 

 

 

Trace cursor 
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(2) Bring the mouse pointer onto the displayed spectrum and right-

click the mouse.  A menu box as in Fig. 7-4 will appear.   

Select “Trace” from the menu box. 

 

 

 

Fig. 7-4 

 

 

(3) The trace cursor can be moved in the following two ways. 

 

① Moving by mouse 

Bring the mouse pointer to the trace cursor position and 

move the cursor to a position for readout with the mouse 

while holding down its left button. 

 

② Moving by arrow keys on keyboard 

By clicking the [←] or [→] key, the trace cursor moves in the 

corresponding direction. 

 

 

Trace

Menu 
box 
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7.3  Scale Change 
 

You can change the X and Y-axis scales of data. 

For scale change, the following three methods are available. 

 

Click the  (properties) button on the Processing toolbar.   

The Spectrum Properties window will open. 

Click the Axes tab.  A tab page as in Fig. 7-5 will appear. 

 

 

 

Fig. 7-5  Axes Tab 

 

 

Enter numerical values in the Maximum and Minimum input boxes for 

the X and Y axes.  The default values are those saved most recently. 

The above page contains the following setting items. 

 

1 X Axis 

Enter minimum and maximum values for the X axis. 

2 Y Axis 

Enter minimum and maximum values for the Y axis. 

3 Default Range 

This button returns the X and Y axes to the default values. 

4 Axis Labels 

Make your selection for the X and Y axis labels from the following 

three: Automatic, Label high, low, and medium values and Use 

fixed increment.  

7.3.1 Change by 

Using Axes 

Tab 

 

1 2

4 

3
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Right-click the mouse on the spectrum window.  A menu box as in Fig. 

7-6 will appear.  Select “Scale” from the menu box. 

 

 

 

Fig. 7-6 

 

 

A window as in Fig. 7-7 will appear.  The window contains the same 

setting items as in 7.3.1. 

 

 

 

Fig. 7-7 

7.3.2 Change by 

Right-clicking 

Mouse 

Scale
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(1) The scale can be expanded with the left button of the mouse. 

Bring the trace cursor onto the spectrum window (Fig. 7-3). 

 

(2) Specify an area to be expanded.  Draw a rectangle while holding 

down the left mouse button, and then release the button.   

The area will be expanded. 

 

 

 

 

Fig. 7-8 

 

 

 

 

Fig. 7-9 

 

(3) For returning to the original scale, click the  button. 

 

7.3.3 Change by 

Using Left 

Mouse Button 

 

Draw a rectangle.
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7.4  Change of Graph Axis 
 

The X axis of a graph can be changed on a spectrum. 

Click the  (properties) button and select the Axes tab. 

 

 

 

Fig. 7-10  Axes Tab 

 

 

• X Axis mode 

The X axis is indicated in either unit below. 

 

◊ Wavelength 

Indicated in wavelength (nm). 

 

◊ Wave number 

Indicated in wavenumber (Kcm
-1

, K = 1000) 

x·λ = 10000 (x: Kcm
-1

, λ: nm) 
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7.5  Change of Spectral Line 
 

You can change the line pattern and color of a spectrum.  Select the 

Lines/Points tab in the Spectrum Properties window.  A tab page as in 

Fig. 7-11 will appear. 

 

 

 

Fig. 7-11  Lines/Points Tab 

 

 

The above page contains the following setting items. 

 

1 Graph 

Select a spectrum for which you want to set a line pattern. 

2 Display mode 

Data can be displayed in the following modes. 

• line 

• point 

• line & point 

3 Line pattern 

Specify a line pattern such as dotted line or solid line. 

4 Point style 

Select a point style to be used for printing or displaying a graph. 

1 

2 

3 

4 

5 

6 
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5 Line color 

Upon clicking Select Color, the Color window appears.   

This window allows you to change the color of spectral line and 

point.  There are 48 basic colors.  By clicking Define Custom 

Colors, a smaller window is added on the right side of the Color 

window as shown in Fig. 7-12.  You can now add 16 colors.  

These colors are usable for the spectral lines and points.   

For defining a color, you can enter values for Hue, Sat (saturation), 

Lum (luminance), Red, Green and Blue.  

Upon completion of the definition, click Add to Custom Colors.  

Then select a desired color from the defined ones. 

 

 

 

Fig. 7-12 

 

 

6 Style 

Specify a line thickness. 
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7.6  Detection of Spectral Peaks 
 

The spectral peaks and valleys are detectable automatically. 

Click the  (peak detection) button on the Processing toolbar.   

A window as in Fig. 7-13 will appear.  Set an integration method, 

threshold and sensitivity. 

(Or select the Peak Finding Parameters command from the Data 

menu.) 

 

 

 

Fig. 7-13 

 

 

1 Integration method 

The following three methods are available and any one may be 

selected for the peak wavelength.  But the area calculation result 

indicated in the peak table will vary with the selected method. 

• Rectangular 

• Trapezoid 

• Romberg 

For details of each method, refer to APPENDIX D. 
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2 Threshold 

Set a detection limit of peak and valley (a difference between the 

peak and valley) on the photometric value axis.  Peaks and valleys 

below the set value will not be detected. 

Input range:  0.001 to 1000 

 

 

 

 

 

3 Sensitivity 

Select the number of data points in the X-axis direction.   

For detection of sharp peaks, select a sensitivity level of “1,” and for 

broad peaks, select “8.” 

• 1 

• 2 

• 4 

• 8 
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7.7  Indication of Peak Information on Spectrum 
 

Click the  (properties) button on the Processing toolbar and select 

the Display tab. 

(Or select the Spectrum Properties command from the Edit menu.) 

 

 

 

Fig. 7-14  Display Tab 

 

 

1 Show trace display 

By putting a check mark here, the trace cursor is displayed to 

enable tracing when the data processing window is opened. 

2 Show gridlines 

By putting a check mark here, the monitor window and data 

processing window can be displayed with gridlines. 

3 Grid increment 

Specify a gridline width.  This parameter becomes valid when a 

check mark is put at “Show gridlines.” 

4 Annotations 

Peak information can be indicated on a spectrum.  Select items to 

be displayed on a spectrum and click OK or Apply. 

• None 

Only a spectrum is displayed. 

• Peak Number 

Peak number is indicated on a spectrum.  

2 

3 

1 

4 
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• Peak WL 

Peak wavelength is indicated on a spectrum. 

• Valley Number 

Valley number is indicated on a spectrum. 

• Valley WL 

Valley wavelength is indicated on a spectrum. 

• Peak and Valley Number 

Peak number and valley number are indicated on a spectrum. 

• Peak and Valley WL 

Peak wavelength and valley wavelength are indicated on a 

spectrum. 

• Peak Data 

Peak data is indicated on a spectrum. 

• Valley Data 

Valley data is indicated on a spectrum. 

• Peak WL, Peak Data 

Peak wavelength and peak data are indicated on a spectrum. 

• Valley WL, Valley Data 

Valley wavelength and valley data are indicated on a spectrum. 

• Peak WL, Peak Data/Valley WL, Valley Data 

Peak wavelength, peak data, valley wavelength and valley data 

are indicated on a spectrum. 

 

 

 

Fig. 7-15  Example of Indication of Peak Wavelength 
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7.8  Smoothing of Spectrum 
 

Click the  (smoothing) button on the Processing toolbar.   

A window as in Fig. 7-16 will open. 

(Or select the Smoothing Parameters command from the Data menu.) 

 

 

 

Fig. 7-16 

 

 

Set the following parameters in the above window. 

 

1 Function type 

Select a smoothing method from the following three.  For details, 

refer to APPENDIX D. 

• Savitgky-Golay 

• Mean 

• Median 

2 Smoothing order 

Set a smoothing order. 

Input range:  2 to 4 

3 Number of points 

Set the number of points to be used in calculation. 

Input range:  5 to 101, Initial value:  7 

4 Number of times 

Set the number of smoothing operations. 

Input range:  1 to 100 

5 Calculate 

This button executes smoothing. 

 

For returning to the original status (before calculation), click the  

(reset) button. 
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7.9  Derivative Operation on Spectrum 
 

Click the  (derivative) button on the Processing toolbar.  A window 

as in Fig. 7-17 will open. 

(Or select the Derivative Parameters command from the Data menu.) 

 

 

 

Fig. 7-17 

 

 

1 Derivative order 

Set a derivative order. 

Input range:  1 to 4 

2 Smoothing order 

Set a smoothing order. 

Input range:  2 to 4 

3 Number of points 

Set the number of data points to be used in calculation. 

Input range:  5 to 101, Initial value:  15 

4 Overlay derivative 

Spectra before and after derivative operation are overlaid for 

display.  Note that the value on the Y axis is not the one after 

derivative operation. 

5 Calculate 

This button executes derivative operation. 

 

Fro returning to the original status (before calculation), click the  

(reset) button. 
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7.10  Overlaid Display of Spectra 
 

This function is usable for comparison of two or more spectra and other 

purposes. 

The following three methods are available. 

 

 

This method is available when two or more spectrum windows are 

already displayed. 

 

(1) Select the Overlay command from the Data menu. 

 

(2) A dialog box as in Fig. 7-18 will appear. 

The dialog box indicates a sample name for the presently 

displayed spectrum. 

 

 

 

Fig. 7-18 

 

 

(3) Click From the windows.  A window as in Fig. 7-19 will appear.  

(Refer to ① in Fig. 7-18.) 

A list of the sample names for the presently displayed spectra is 

indicated in the left box, and a list of the overlaid sample names in 

the right box. 

 

 

 

Fig. 7-19 

 

7.10.1 Insertion from 

Window 
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(4) Select a sample name from the left box.  The selected sample 

name will be highlighted in blue.  (Refer to ② in Fig. 7-20.) 

 

(5) Click the Insert >> button.  (Refer to ③ in Fig. 7-20.) 

 

 

 

Fig. 7-20 

 

 

(6) The selected sample name will be added as shown in Fig. 7-21.  

(Refer to ④ in Fig. 7-21.) 

 

(7) Click OK.  (Refer to ⑤ in Fig. 7-21.) 

 

 

 

Fig. 7-21 
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(8) Two spectra will be overlaid on the data processing window.   

At the same time, a dialog box as in Fig. 7-22 will open.   

Click Close.  (Refer to ⑥ in Fig. 7-22.) 

 

 

 

Fig. 7-22 

 

 

(9) To delete a spectrum, click the corresponding sample name in 

the above Spectra list.  (Refer to ⑦ in Fig. 7-22.)  When the 

clicked sample name is highlighted in blue, the Delete button 

becomes active.  Click the Delete button.  (Refer to ⑧ in Fig. 

7-22.) 

 

 

 

This method overlays spectra by reading them from the already saved 

files. 

 

(1) Select the Overlay command from the Data menu. 

 

(2) A dialog box as in Fig. 7-23 will appear. 

 

 

 

Fig. 7-23 

 

 

(3) Click From the files in Fig. 7-23.  (Refer to ① in Fig. 7-23).   

A window as in Fig. 7-24 will open. 

 

7.10.2 Insertion from 

File 
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(4) Select a file name for overlaid display and click Open.  (Refer to 

② in Fig. 7-24.) 

 

 

 

Fig. 7-24 

 

 

(5) Two spectra will be overlaid on the data processing window.   

At the same time, a dialog box as in Fig. 7-25 will appear.   

Click the Close button.  (Refer to ③ in Fig. 7-25.) 

 

 

 

Fig. 7-25 

 

 

(6) To delete a spectrum, click the corresponding sample name in 

the Spectra list.  (Refer to ④ in Fig. 7-25.)  When the clicked 

sample name is highlighted in blue, the Delete button becomes 

active.  Click the Delete button.  (Refer to ⑤ in Fig. 7-25.) 
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This method is available when two kinds of spectrum windows (already 

processed windows) are displayed on the screen. 

 

 

 

Fig. 7-26 

 

 

(1) Drag the blue frame of a spectrum in the following procedure.  

(Refer to ① in Fig. 7-26.) 

Move the arrow mouse pointer to the blue frame. 

Click the left button of the mouse. 

The mouse pointer will change to . 

 

(2) While holding down the left mouse button, bring the mouse 

pointer onto a spectrum to be overlaid.  (Refer to ② in Fig.  

7-26).  When the mouse pointer changes as shown in Fig. 7-27, 

drop the mouse (release the left mouse button). 

 

 

 

 

 

Fig. 7-27 

 

Open files as in 7.10.3, click a spectrum to be overlaid and press Ctrl + 

C on the keyboard or select the Copy command from the Edit menu.  

Click the spectrum on which overlaying is desired and paste the first 

spectrum by Ctrl + V to complete overlaying. 

 

 

7.10.3 Direct Drag-

and-Drop 

Operation 

2
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This method allows you to display only the spectra selected from 

overlaid ones. 

 

(1) Click the  (display spectra) button on the Spectrum toolbar.   

A window as in Fig. 7-28 will appear. 

 

(2) Select a desired sample name from the Visible Spectra list.   

The selected sample name will be highlighted in blue.  (Refer to 

① in Fig. 7-28.) 

(Multiple spectra are selectable by clicking the left button of the 

mouse on the desired sample names while holding down the Shift 

key.) 

 

(3) Click the OK button.  (Refer to ② in Fig. 7-28.) 

 

(4) Only the selected spectra will be displayed on the spectrum  

window.  In this example, spectrum No. 4 will be displayed.   

This spectrum is not printed, but the sample name, analysis 

method, etc. are printed. 

 

 

 

Fig. 7-28 
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7.11  Arithmetic Operation between Spectra 
 

Shown here is an example of obtaining the difference between two 

overlaid spectra. 

Click the  (spectral calculation) button on the Processing toolbar.  

The Spectral Arithmetic window will open as shown in Fig. 7-29. 

(Or select the Spectral Arithmetic command from the Data menu.) 

 

 

 

 

Fig. 7-29 

 

 

(1) The sample names for the files opened in the window (file names 

in parentheses) are listed.  From this list, select a file for 

arithmetic operation.  (Refer to ① in Fig. 7-29.) 

 

(2) The spectrum selected in (1) is displayed.  (Refer to ② in Fig.  

7-29.) 

 

(3) Set a factor for the spectrum selected in (1).  (Refer to ③ in Fig.  

7-29.) 

 

(4) For multiplying the spectrum by the factor, click Calculate.   

(Refer to ④ in Fig. 7-29.) 

 

(5) For arithmetic operation between two spectra, put a check mark 

in the Spectra Arithmetic check box.  (Refer to ⑤ in Fig. 7-29.) 
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(6) The sample names for the files opened in the window (file names 

in parentheses) are listed.  From this list, select another file for 

arithmetic operation.  (Refer to ⑥ in Fig. 7-30.) 

 

(7) The spectrum selected in (6) is displayed.  (Refer to ⑦ in Fig.  

7-30.) 

 

 

 

Fig. 7-30 

 

 

(8) Set a factor for the spectrum selected in (6).  (Refer to ⑧ in Fig. 

 7-30.) 

 

(9) Select a mathematical operator for the two spectra.  (Refer to ⑨ 

in Fig. 7-30.) 

+: Addition, -: Subtraction, *: Multiplication, /: Division 

 

(10) After setting of a mathematical operator, click Calculate.   

(Refer to ⑩ in Fig. 7-30.) 
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(11) The result of arithmetic operation is displayed as shown in Fig.  

7-31.  (Refer to ⑪ in Fig. 7-31.) 

 

 

 

Fig. 7-31  After Arithmetic Operation 

 

 

(12) Click Save As.  The result of calculation can be saved in file.  

(Refer to ⑫ in Fig. 7-31.) 
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7.12  Area Calculation 
 

An area value is obtainable by integration in the specified range of the 

presently displayed spectrum. 

Click the  (area calculation) button on the Processing toolbar.   

A window as in Fig. 7-32 will appear. 

(Or select the Area command from the Data menu.) 

 

 

 

Fig. 7-32 

 

 

The range for area calculation is settable in the following two ways. 

 

(1) Setting by Moving Cursor 

 

① Click the Start button.  (Refer to ① in Fig. 7-33.)   

Move the trace cursor to a desired start wavelength on the 

spectrum (refer to ② in Fig. 7-33), and then click the right 

button of the mouse. 

 

② Click the End button.  (Refer to ③ in Fig. 7-33.)  Move the 

trace cursor to a desired end wavelength on the spectrum 

(refer to ④ in Fig. 7-33), and then click the right mouse 

button. 

 

7.12.1 Setting of 

Calculation 

Range 
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③ Click the Calculate button.  The result of calculation will be 

indicated.  (Refer to ⑤ in Fig. 7-33.) 

 

 

 

Fig. 7-33 

 

 

(2) Setting by Entering Numerical Value 

 

① Enter a desired start wavelength in the Start input box from 

the keyboard. 

 

② Enter a desired end wavelength in the End input box from 

the keyboard. 

 

③ Click the Calculate button.  The result of calculation will be 

indicated. 
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(3) The principle of area calculation is shown below. 

 

 

 

 

Fig. 7-34  Principle of Calculation 

 

 

The elements (D1 to Dn) of a spectrum are subjected to the 

following calculation for obtaining an area value. 

 

S3 = S1 + S2 = Sa + Sc + Sd 

= {D2 + D3 + ��� Dn-2 + Dn-1 + (D1 + Dn)/2∗∆λ 

S2 = Sb + Sd 

= [(D1 + Dn)∗{∆λ∗ (n – 1)}]/2 

= [(D1 + Dn)∗{section start wavelength (WL1) –  

section end wavelength (WL2)}]/2 

S1 = S3 – S2 

D1:  Spectral data at section start wavelength 

Dn:  Spectral data at section end wavelength 

∆λ:  Sampling interval 

 

In the time scan mode, change as follows. 

Start wavelength (WL1) → End time (T2) 

End wavelength (WL2) → Start time (T1) 
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D1

∆λ

S1

S2
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The result of area calculation can be printed out. 

 

(1) To print a spectrum and the result of area calculation, put a check 

mark at “Print spectrum.”  (Refer to ① in Fig. 7-35.)  To avoid 

printing a spectrum, remove the check mark. 

 

(2) Click Print to start printing.  (Refer to ② in Fig. 7-35.)   

Upon execution of printing, the Area window will close.   

The same window can be called up by clicking the  (area 

calculation) button on the Processing toolbar. 

 

 

 

Fig. 7-35 

 

 

 

 

 

Fig. 7-36  Example of Printout (with spectrum record) 

 

7.12.2 Printing of 

Calculation 

Result 
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(3) Upon clicking the OK button after calculation (refer to ③ in Fig. 

7-35), its result is saved although the Area window is closed. 

 

(4) The result of calculation is reset by clicking the  (reset) 

button on the Processing toolbar with the data processing window 

displayed.  Upon calling up the Area window again, therefore, 

“*****” will be indicated in each result box. 

 

NOTE: Upon execution of file saving after area calculation, its result is 

also saved in a file.  So a numerical value is indicated in each 

result box when the Area window is called up.  These values 

cannot be erased by clicking the reset button because they are 

saved in the computer. 
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For expanding the scale in the Area window, use the left button of the 

mouse. 

 

(1) As shown in Fig. 7-37, specify an area to be expanded by drawing 

a rectangle with the mouse while holding down its left button on a 

spectrum. 

 

 

 

Fig. 7-37 

 

 

(2) Then release the left button.  The specified area will be 

expanded as shown in Fig. 7-38. 

 

 

 

Fig. 7-38 

 

 

(3) Double clicking the left mouse button on the spectrum returns the 

scale to the original one. 

7.12.3 Scale 

Expansion 
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7.13  Transfer of Data to Microsoft(R) Excel 
 

Measured data can be transferred to a worksheet of Microsoft(R) Excel 

in the following procedure. 

 

(1) Click the  (properties) button and select the Report tab.   

A tab page as in Fig. 7-39 will open.  Select “Use Microsoft(R) 

Excel” for Output.  Also select data to be transferred (peak table, 

data listing, etc. in case of wavelength scan).  Then click OK. 

 

 

 

Fig. 7-39 

 

 

(2) Click the  (report) button.  The Microsoft(R) Excel will 

automatically start to read data.  The subsequent procedure 

concerns the Microsoft(R) Excel operation. 

 

 

 

Fig. 7-40 
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(3) Data can be saved with extension code “xls” of Microsoft(R) Excel.  

Select File – Save Copy As and enter a file name. 

 

 

 

Fig. 7-41 

 

 

(4) Upon closing the Microsoft(R) Excel, a window as in Fig. 7-42 

appears.  Now close this window.  The original data processing 

window will appear again. 

 

 

 

Fig. 7-42 
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7.14  Pasting of Spectrum to Microsoft(R) Word 
 

A spectrum can be pasted to a Microsoft(R) Word text as it is.   

Take the following procedure. 

 

(1) Make spectral data active by clicking the relevant spectrum in the 

data processing window.  The thick frame will change to blue. 

 

(2) Select the Copy command from the Edit menu. 

 

(3) Open a Microsoft(R) Word text and click a position for pasting.   

By clicking the Paste command from the Edit menu, the spectrum 

can be pasted to the Microsoft(R) Word text. 

 

Peak tables and/or kinetics data can also be pasted to a Microsoft(R) 

Word text in the same way.  In this case, they are pasted as a text. 

By double-clicking the pasted spectrum, functions such as scale change 

and gridline indication are applicable. 

 

 

 

Fig. 7-43  Spectrum Pasted to Microsoft(R) Word 

 

 

Upon right-clicking the pasted spectrum, a menu box as in Fig. 7-48 will 

appear to enable scale change, etc.  Any change made here is brought 

into a Microsoft(R) Word text. 

 

NOTE: Editing in the Microsoft(R) Word can be made with a PC in 

which the Microsoft(R) Word and FL Solutions program are 

installed. 
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7.15  Pasting of Spectrum to Microsoft(R) Excel 
 

A spectrum can be pasted to the Microsoft(R) Excel as it is.  

Take the following procedure. 

 

(1) Make spectral data active by clicking the relevant spectrum on the 

data processing window.  The thick frame will change to blue. 

 

(2) Select the Copy command from the Edit menu. 

 

(3) Open the Microsoft(R) Excel and select “Paste Special” from its 

Edit menu.  A dialog box as in Fig. 7-44 will open.  Make sure 

that “FL Wavelength Scan Object” is indicated in “As.” 

 

 

 

Fig. 7-44 

 

 

(4) Click OK.  The spectrum will be pasted to the Microsoft(R) Excel. 

 

Peak tables and kinetics data can also be pasted to the Microsoft(R) 

Excel in the same way.  In this case, they are pasted as data for each 

cell. 
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7.16  Conversion of Data into ASCII Text File 
 

A file conversion function is provided for data processing with other 

spreadsheet software.  Conversion can be made to the following three 

data files. 

• JCAMP-DX file (*.dx) 

• ASCII text file (*.txt) 

• Windows metafile (*.wmf) 

 

NOTES: 1. The date/time, analysis method and data list (raw data) 

is converted into a JCAMP-DX file. 

 2. The items selected on the Report tab page of the 

Spectrum Properties window are converted into an 

ASCII text file. 

 

(1) Load a data file for text conversion and open the data processing 

window.  (Refer to 7.1.) 

 

(2) Click the Save As command in the File menu. 

 

(3) A window as in Fig. 7-45 will open.  

Select “ASCII Text Files (*.txt)” in “Save as type.” 

 

For converting a file containing overlaid spectra into an ASCII text, 

select “ASCII Type 1 files (*.txt)” or “ASCII Type 2 files (*.txt).”  

(For details, refer to 7.17.) 

 

 

 

Fig. 7-45 



7.16  Conversion of Data into ASCII Text File 

7 - 38 

(4) Specify a folder for saving, enter a file name and click Save. 

 

 

 

Fig. 7-46 

 

 

File conversion is effective for a data file in any measurement 

mode.  The selected data is separated by tab. 
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7.17  Conversion of Overlaid Spectra into ASCII File 
 

A file conversion function is provided for processing of overlaid spectral 

data with other spreadsheet software.  Conversion can be made to the 

following two ASCII formats. 

• ASCII type 1 file (*.txt) 

• ASCII type 2 file (*.txt) 

 

NOTE: The items selected on the Report tab page of the Spectrum 

Properties window are converted into an ASCII type 1 file or 

ASCII type 2 file.  Note that the instrument conditions are not 

output when the ASCII type 2 file is selected. 

 

(1) Load a data file for text conversion and open the data processing 

window.  (Refer to 7.1.) 

 

(2) Click the [Save As command] in the File menu. 

 

(3) A window as in Fig. 7-47 will open.  

Select either file below in “Save as type.” 

• ASCII Type 1 files (*.txt) 

• ASCII Type 2 files (*.txt) 

 

For a single spectrum, select “ASCII type 1 files (*.txt).” 

 

 

 

Fig. 7-47 
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Output Format of ASCII Type 1 file 

 

For a file containing overlaid spectra, a set of item name and data will 

be output in two columns.   

In reading into the Microsoft(R) Excel, setting is made for each cell in 

the following format. 

 

1st spectral data 2nd spectral data 3rd spectral data 

Item name Data Item name Data Item name Data 

 

 

Figure 7-48 shows an example of output into the Microsoft(R) Excel. 

 

 

 

Fig. 7-48 
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Output Format of ASCII Type 2 file 

 

For a file containing overlaid spectra, the item name will be output in the 

leftmost column and spectral data in each column.  In reading into the 

Microsoft(R) Excel, setting is made for each cell in the following format. 

 

Item name 1st spectral data 2nd spectral data 3rd spectral data 

 

 

Figure 7-49 shows an example of output into the Microsoft(R) Excel. 

 

 

 

Fig. 7-49 

 

 



7.18  Renaming Your Sample 

7 - 42 

7.18  Renaming Your Sample 
 

After measurement, you can change the sample name of saved data.  

Call up the Info tab page and rename your sample in the following 

procedure. 

 

(1) Open a data file for renaming.  (Refer to 7.1.) 

 

(2) Click the  (information tab) button on the Spectrum toolbar.  

A dialog box for input of a sample name/comment will appear.  

The dialog box includes the Info tab. 

 

(3) Or click the  (properties) button on the Processing toolbar.  

The Spectrum Properties window will open.  Click the Info tab.  

A tab page as in Fig. 7-50 will appear. 

 

(You can also open the Spectrum Properties window by selecting 

the Spectrum Properties command from the Edit menu.) 

 

 

 

Fig. 7-50 

 

 

(4) Input a new sample name in “Sample” and click OK. 

 

(5) To save data under the new sample name, click the  (save) 

button on the Standard toolbar for updating, and select the Save 

As command from the File menu for saving under a new file 

name. 
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7.19 Printing of Wavelength and  
Photometric Values on Display 

 

This program provides a function for reading data such as presently 

displayed wavelength and photometric values, traced value on the data 

processing window, etc.  The data can also be printed. 

 

 

Take the following procedure with the monitor window displayed. 

 

(1) Select the Read Data command from the Tools menu.  (Refer to 

① in Fig. 7-51.) 

 

 

 

Fig. 7-51 

 

 

(2) The Read Data box will appear as shown in Fig. 7-52.  

Drag the title area (blue) of the box to the lower right.  (Refer to 

② in Fig. 7-52.) 

 

 

 

Fig. 7-52 
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(3) Bring the mouse pointer onto the monitor window and click the 

right button of the mouse.  A menu box will appear.   

Select “Read Current Data” from the menu box (refer to ③ in Fig. 

7-53), and the photometric value and data value will be read into 

the Read Data box. 

 

Upon start of data reading, Parameter → Scanning → Ready are 

displayed sequentially in the message display area (refer to ④ in 

Fig. 7-53). 

 

 

 

Fig. 7-53 

 

 

(4) The integration time for data reading is usually set at 0.1 s.   

To change the integration time, select the Options command from 

the Tool menu.  Then select the Analysis condition tab (refer to 

⑤ in Fig. 7-54).  A window as in Fig. 7-54 will appear to enable 

setting change. 
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Fig. 7-54 

 

 

(5) In data reading, sample name information is also indicated.  

Sample names can be input.  For input, click the sample name 

column.  (Refer to ⑥ in Fig. 7-55.) 

 

 

 

Fig. 7-55 
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(6) Read data can be deleted.  To delete a data value from the table, 

click the relevant No. (refer to ⑦ in Fig. 7-55).  Then click the 

Delete button (refer to ⑧ in Fig. 7-55).  A dialog box as in Fig. 

7-56 will appear.  Click the Yes button (refer to ⑨ in Fig. 7-56), 

and the data value will be deleted. 

 

 

 

Fig. 7-56 

 

 

(7) To delete all data values, click the Delete all button. 

 

(8) For printing the relevant data, click the  (print) button on the 

Standard toolbar. 

(Or select the Print command from the File menu.) 

 

 

The wavelength and photometric values can be read and printed from 

the data processing window. 

 

(1) Open a data file.  (Refer to 7.1.) 

 

NOTE: Avoid maximizing the opened data file.  With this function, 

two windows are displayed at the same time.  If one window 

is maximized, the other cannot be displayed. 

 

(2) Select the Read Data command from the Tools menu. 

 

(3) The Read Data box will appear as shown in Fig. 7-57.  Drag the 

title area (blue) of the box to the lower right.  (Refer to ① in Fig. 

7-57.) 
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Fig. 7-57 

 

 

(4) Click the spectrum display window.  (Refer to ② in Fig. 7-58.) 

 

(5) Click the  (trace cursor) button on the Spectrum toolbar.  

(Refer to ③ in Fig. 7-58.)  A trace cursor will appear on the 

spectrum.  (Refer to ④ in Fig. 7-58.) 

 

 

 

Fig. 7-58 
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(6) Move the trace cursor onto a spectrum to be traced and click the 

right button of the mouse.  A menu box will appear.   

Select “Read Cursor Data” from the menu box (refer to ⑤ in Fig.  

7-58), and the wavelength and photometric values will be read 

into the Read Data box. 

 

(7) Upon selection of “Read Cursor Data,” display becomes as 

shown in Fig. 7-59. 

 

(8) In data reading from the data processing window, sample name 

information is also indicated.  Sample names can be edited.  

For input, click the sample name column.  (Refer to ⑥ in Fig.  

7-59.) 

 

 

 

Fig. 7-59 

 

 

(9) The read data can be deleted.  To delete a data value from the 

table, click the relevant No. (refer to ⑦ in Fig. 7-59).  Then click 

the Delete button (refer to ⑧ in Fig. 7-59).  A dialog box as in 

Fig. 7-60 will appear.  Click the Yes button (refer to ⑨ in Fig.  

7-60), and the data value will be deleted. 

 

 

 

Fig. 7-60 

 

(10) To delete all data values, click the Delete all button. 
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(11) For printing the relevant data, click the  (print) button on the 

Standard toolbar. 

(Or select the Print command from the File menu.) 
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7.20 Reference to Spectrum Measured in 
Photometry Mode 

 

When the quantification method is peak area, peak height or derivative 

in the photometry mode, wavelength scan is carried out and according 

to its result, a calibration curve is prepared.  The spectrum measured in 

this case can be displayed and printed. 

 

(1) Open a data file (photometry file (*.fdq)).  (Refer to 7.1.)   

A window as in Fig. 7-61 will open. 

 

 

 

Fig. 7-61 

 

 

(2) Right-click the numerical part in “Samp. No.” in the sample 

measurement result indication area.  (Refer to ① in Fig. 7-62.)  

The Load Spectrum from Quant Data button will appear.  

(Refer to ② in Fig. 7-62.) 

 

The same operation is possible in the area for standards. 
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Fig. 7-62 

 

 

(3) Click the Load Spectrum from Quant Data button.  A spectrum 

window as in Fig. 7-63 will appear. 

(Or click a numeral and select the Load Spectrum from Quant 

Data command from the Data menu.) 

 

 

 

Fig. 7-63 

 

 

(4) Upon right-clicking on the displayed spectrum, a menu box will 

appear.  You can also carry out spectrum tracing and scale 

change. 

 

(5) The spectrum can be printed by clicking the  button (or by 

selecting the Print command from the File menu). 
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8. MORE CONVENIENT OPERATION 
(APPLICATION) 

 

8.1  Always Starting with Same Analysis Method 
 

The FL Solutions program can be started under the specified analysis 

method.  Note, however, that this function cannot be used unless any 

analysis method is saved in 8.4. 

 

(1) Select Tools – Options as shown in Fig. 8-1.  (Refer to ① in Fig.  

8-1.) 

 

 

 

Fig. 8-1  Tools Menu 

 

 

(2) Select the Startup tab (refer to ② in Fig. 8-2), and a tab page as 

in Fig. 8-2 will appear. 
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(3) Select “Auto Parameter File” (refer to ③ in Fig. 8-2) and click the 

Set F-7000 Method File button (refer to ④ in Fig. 8-2). 

 

 

 

Fig. 8-2  Startup Tab 

 

 

(4) A window as in Fig. 8-3 will open.  Select a desired method file.  

(Refer to ⑤ in Fig. 8-3.)  The extension code of method file is 

“*.flm.” 

 

 

 

Fig. 8-3 

 

 

This function is validated from the next startup of the FL Solutions 

program. 
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8.2  Online/Offline Setting of Spectrophotometer 
 

The spectrophotometer can be set offline.  And it can be returned to 

the online status. 

 

(1) Click the  button on the Standard toolbar. 

(Or select the Instruments command from the Tools menu.) 

The mouse pointer will turn into an hourglass and about 10 

seconds later, a window as in Fig. 8-4 will appear.  Under this 

display, the spectrophotometer is connected. 

 

 

 

Fig. 8-4 

 

 

(2) Click the instrument name on the Connected Instruments window 

(refer to ① in Fig. 8-4), and the selected line will be highlighted in 

blue.  At the same time, the Close Monitor, Serial Number and 

Close buttons will become active.  Click Serial Number.   

A serial number will be indicated. 

 

(3) Upon clicking the Close Monitor button (refer to ② in Fig. 8-4), 

a window as in Fig. 8-5 will open.  When you click the Yes button 

(refer to ③ in Fig. 8-5), the offline status is set. 

 

 

 

Fig. 8-5 

 

 

(4) For online setting, click the Open Monitor button.   

Initialization will be executed and the monitor window will appear. 

 

1 2
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8.3  Check of Data File Information 
 

You can check the conditions or date of measurement for saved data. 

 

(1) Click the  (open) button on the Standard toolbar. 

(Or select the Open command from the File menu.) 

A window as in Fig. 8-6 will appear.   

 

(2) Specify and right-click a desired file from the displayed file list.  

(Refer to ① in Fig. 8-6.)  A menu box will appear.   

Select “Properties” from the menu box.  (Refer to ② in Fig.  

8-6.) 

 

 

 

Fig. 8-6 

 

 

(3) A window as in Fig. 8-7 will appear.  Necessary information can 

be checked by clicking the Info and Scan tabs. 

 

8.3.1 Check of 

Information on 

Saved Data 
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Fig. 8-7 
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You can check information on presently displayed data. 

 

(1) Click the  (properties) button on the Processing toolbar. 

(Or select the Spectrum Properties command from the Edit 

menu.) 

 

(2) Upon clicking the Info tab (refer to ① in Fig. 8-8), a tab page as 

in Fig. 8-8 will appear.  When you click the Scan tab (refer to ② 

in Fig. 8-9), a tab page as in Fig. 8-9 will appear. 

 

 

 

Fig. 8-8  Info Tab 

 

 

 

 

Fig. 8-9  Scan Tab 

 

8.3.2 Check of 

Information 

on Displayed 

Data 
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(3) When multiple spectra are displayed on the presently opened 

window (recording in overlay mode for example), multiple sample 

names are indicated by clicking the drop-down list box (refer to 

③ in Fig. 8-10).  Select a sample name for the data to be 

checked, and you can check the corresponding information. 

 

 

 

Fig. 8-10 
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8.4  Saving of Analysis Method 
 

The set analysis method can be saved as a file.  So instead of setting 

the method each time, you can just call up the file for setting. 

 

(1) Click the  (analysis method) button on the Measurement 

toolbar. 

(Or select the Method command from the Edit menu on the 

monitor window.) 

A window as in Fig. 8-11 will appear. 

 

 

 

Fig. 8-11 

 

 

(2) Select the Instrument tab, Monitor tab, etc. (refer to ① in Fig.  

8-11) and set an analysis method, sample name, etc. 

 

(3) Upon completion of method setting, click the Save As button.  

(Refer to ② in Fig. 8-11.) 

 

(4) A window as in Fig. 8-12 will appear.  Input a file name.   

(Refer to ③ in Fig. 8-12.)  The extension code of method file is 

“*.flm.” 
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Fig. 8-12 

 

 

(5) For calling up the saved file, click the Load button (refer to ④ in 

Fig. 8-11) and select a file. 
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8.5  Event Log 
 

If an error occurs in use of the instrument, the details of the error is 

automatically recorded in an event log.  You can also record the 

date/time of lamp exchange and the occurrence of trouble. 

 

(1) Select the Event Log command from the Tools menu as shown in 

Fig. 8-13.  (Refer to ① in Fig. 8-13.) 

 

 

 

Fig. 8-13 

 

 

(2) The Event Log tab page will appear as shown in Fig. 8-14.   

It displays the occurrence time, user, description and computer 

for communication errors, etc. 

 

(3) By putting a check mark in the Event or User Notes check box in 

“View,” you can display the corresponding details.  (Refer to ② 

in Fig. 8-14.) 

• Event : Display of events and errors 

• User Notes : Display of user notes 

For displaying only events and errors or only user notes, put a 

check mark in either check box. 

 

 

 

Fig. 8-14  Event Log Tab 
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(4) For adding a user note, click the User Notes tab.  (Refer to ③ in 

Fig. 8-15.)  A tag page as in Fig. 8-15 will appear. 

 

 

 

 

Fig. 8-15  User Notes Tab 

 

 

(5) Input a user name.  (Refer to ④ in Fig. 8-15.)  Enter a note in 

the Description input box.  (Refer to ⑤ in Fig. 8-15.) 

Number of input characters:  127 characters max. 

 

(6) Click the Add Note button.  (Refer to ⑥ in Fig. 8-15.) 

 

(7) Upon clicking the Remove All button, the confirmation message 

show below will appear. 

“Event log will be cleared.  Are you sure to execute it?” 

By clicking Yes, the event log and all of the user information will 

be cleared.  (Refer to ⑦ in Fig. 8-14.) 
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8.6  Check of Program Version 
 

You can check the version of the currently used program.  If the 

instrument develops trouble, inform the service office of the 

phenomenon and program code. 

 

As shown in Fig. 8-16, select the About FL Solutions command from the 

Help menu. 

 

 

 

Fig. 8-16 

 

 

A window as in Fig. 8-17 will open.  Check the program code. 

 

 

 

 

Fig. 8-17 

 

 

 

Version 
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8.7  Change of Window Display for Multiple Spectra 
 

Upon clicking the View menu on the menu bar, you can select a method 

of displaying multiple spectra. 

 

         

 

 

Fig. 8-18  Commands in View Menu 

 

 

• Overlay : Two or more spectra are overlaid for 

comparison, etc.  (Refer to Fig. 8-19.) 

• Stack : Spectral are displayed separately in the 

vertical direction.  (Refer to Fig. 8-20.) 

• Tile : Spectra are displayed separately in the vertical 

and horizontal direction.  For example, 16 

spectra are displayed in 4 rows × 4 columns 

and 15 spectra in 5 rows × 3 columns.   

(Refer to Fig. 8-21.) 

 

• Scale Y Axis Up : Y axis scale is doubled. 

• Scale Y Axis Down : Y axis scale is halved. 

• Reset Y Axes : The scale set under the Monitor tab is taken. 

• Autoscale Y Axis : The scale is matched with the size of 

spectrum. 

 

• Reset Axes : The scale set under the Monitor tab is taken. 

• Autoscale : The scale is matched with the size of 

spectrum. 

 

Monitor window Data processing window
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Overlay 

 

 

 

Fig. 8-19 

 

 

Stack 

 

 

 

Fig. 8-20 
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Tile 

 

 

 

Fig. 8-21 

 

 

NOTE: When six, seven or more spectra are displayed simultaneously, 

the size of each spectrum may become excessively small or 

all the traced values cannot be displayed.  In such a case, 

select the Overlay command from the Data menu to delete 

unnecessary spectra. 
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8.8 Check of Photometric Value at  
Specified Wavelength 

 

This is a function for shifting the excitation and emission-side 

monochromators to the specified wavelengths.  It is also usable for 

checking if the Xe lamp is adjusted properly. 

 

(1) Click the  (wavelength drive) button on the 

Spectrophotometer toolbar. 

(Or open the monitor window and select the Set Wavelength 

command from the Spectrophotometer menu.) 

A window as in Fig. 8-22 will appear. 

 

 

 

Fig. 8-22 

 

 

(2) Input target wavelength values and click OK.   

Each monochromator will be shifted to the specified wavelength 

and a photometric value is indicated on the monitor window.  

(Refer to ② in 1.6.) 

 

[Wavelength drive to zero-order light] 

For checking if the Xe lamp is adjusted properly or relocating the 

instrument, the wavelength needs to be driven to the zero-order light.  

Open the window shown in Fig. 8-22 and set the wavelength at 0 nm. 

By clicking OK, the wavelength is adjusted to the zero-order light. 
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8.9  Collective Printing of Files 
 

Wavelength scan data files (*.fds), time scan data files (*.fdt), 3-D scan 

files (*.fd3) or 3-D time scan file (*.ft3) can be collectively printed. 

 

(1) Select the Plot Spectra command from the File menu.  A window 

as in Fig. 8-23 will appear. 

 

 

 

Fig. 8-23 

 

 

(2) Click Select file.  (Refer to ① in Fig. 8-23.) 

 

 

 

Fig. 8-24 
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(3) Specify the folder of files to be printed in “Look in.”  (Refer to ② 

in Fig. 8-24.) 

 

(4) Select a file type in “Files of type.”  (Refer to ③ in Fig. 8-24.) 

 

(5) Select files.  (Refer to ④ in Fig. 8-24.) 

The following two methods are available for selecting multiple 

files. 

Method 1 : Click the first file and select the subsequent ones 

with the ↓ key while holding down the Shift key. 

Method 2 : Click each file while holding down the Ctrl key. 

 

(6) After completion of selection, click Open.  (Refer to ⑤ in Fig.  

8-24.)  The Plot Spectra dialog box will appear.  The selected 

files are set in the Print file list as shown in Fig. 8-25. 

 

 

 

Fig. 8-25 

 

 

(7) After check, click Print.  Printing will start.  (Refer to ⑥ in Fig. 

8-25.) 

Printing items are those selected for saving.  Up to 100 files can 

be specified. 
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8.10  Collective Conversion of Files 
 

Data files can be collectively converted in the following procedure. 

 

(1) Select the Files Conversion command from the File menu.   

A window as in Fig. 8-26 will appear. 

 

 

 

Fig. 8-26 

 

 

(2) Click the Select file button.  (Refer to ① in Fig. 8-26.)   

A window as in Fig. 8-27 will appear. 

 

 

 

Fig. 8-27 
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(3) Specify the folder of files to be converted in “Look in.”  (Refer to 

② in Fig. 8-27.) 

 

(4) Select a file type in “Files of type.”  (Refer to ③ in Fig. 8-27.) 

 

(5) Select files.  (Refer to ④ in Fig. 8-27.) 

The following two methods are available for selecting multiple 

files. 

Method 1 : Click the first file and select the subsequent ones 

with the ↓ key while holding down the Shift key. 

Method 2 : Click each file while holding down the Ctrl key. 

 

(6) After completion of selection, click Open.  (Refer to ⑤ in Fig.  

8-27.)  The Convert Files window will appear.  The selected 

files are set in the Source file list as shown in Fig. 8-28.  

 

 

 

Fig. 8-28 

 

 

(7) Select a file format after conversion in “Conversion methods.”  

(Refer to ⑥ in Fig. 8-28.)  You can select two or more formats 

for simultaneous conversion. 
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• JCAMP-DX file 

• ASCII text file 

For this file format, select information to be converted. 

◊ Fix 

In any other than the photometry mode, the date, 

analysis method, and data list are output.  In the 

photometry mode, all information excluding calibration 

curve graphs. 

◊ Report format 

Output is provided according to the settings on the 

Report tab page of the Spectrum Properties window. 

• Graph meta file 

 

(8) Specify a folder for saving the converted files. 

When folders exist, the Browse for Folder dialog box appears as 

shown in Fig. 8-29 by clicking the Browse button.  (Refer to ⑦ 

in Fig. 8-28.)  Specify a folder in this dialog box and click the OK 

button. 

 

 

 

Fig. 8-29 
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When there is no folder, the Create New Folder dialog box 

appears as shown in Fig. 8-30 by clicking the Create Folder 

button (refer to ⑧ in Fig. 8-28).  Enter a new folder name in 

“Name” and click the OK button.  A new folder will be created. 

 

 

 

Fig. 8-30 

 

 

(9) Click the Convert Files button (refer to ⑨ in Fig. 8-28) for file 

conversion. 
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8.11  File Loading with Preview 
 

You can load a spectral data file with preview. 

 

(1) Click the  (preview file) button from the Standard toolbar.   

A window as in Fig. 8-31 will open. 

(Or select the Load Spectrum command from the File menu.) 

 

 

 

Fig. 8-31 

 

 

(2) Click the Browse button.  (Refer to ① in Fig. 8-31.)  A window 

as in Fig. 8-29 will appear.  Specify a folder for spectrum loading. 

 

 (3) Select a file type button.  (Refer to ② in Fig. 8-31.)   

The corresponding data files in the folder are indicated in the list 

box. 

 : Wavelength scan data file 

 : Time scan data file 

 : 3-D scan data file 

 : 3-D time scan data file 

2 

3 

4

5

1 



8.11  File Loading with Preview 

8 - 24 

(4) Select a desired file from the data file list.  (Refer to ③ in Fig.  

8-31.) 

The searched data file list is displayed at the left of the window.  

Select a file from the list, and the relevant spectrum will be 

displayed.  The same two data file lists are displayed.  For two 

files, the preview can be displayed simultaneously. 

Upon selection of 3-D scan or 3-D time scan data file, the 

contours for one data element are displayed.  A single data file 

list is available. 

 

(5) Click the Load button.  (Refer to ④ in Fig. 8-31.)  A spectrum 

displayed on the preview window will be loaded and displayed on 

the data processing window. 

 

(6) To exit the file loading, click the Close button.  (Refer to ⑤ in 

Fig. 8-31.) 
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8.12  Enlargement of Values on Monitor 
 

You can enlarge the current values on the monitor. 

Click the  button on the Spectrophotometer toolbar.   

The instrument status window will open as shown in Fig. 8-32.   

This window can be enlarged or contracted with the mouse. 

 

 

 

Fig. 8-32 
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8.13  Display of Monitor Window at Forefront 
 

In repeat measurement or use of the autosampler, the monitor window 

may not be located because some spectral data processing windows 

are overlaid as shown in Fig. 8-33. 

 

 

 

Fig. 8-33 

 

 

Click the  button on the Standard toolbar.  The monitor window 

will be displayed at the forefront. 

 

 

 

Fig. 8-34 
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9. MEASUREMENT USING OPTIONAL 

ACCESSORIES 

 

For how to connect the cable for each accessory, refer to the instruction 

manual attached to the accessory. 

Given below is the description of operations after setting of your analysis 

method, which is required as instructed in Sections 2 to 6. 

 

 

9.1  Use of Sample Sipper 
 

Hook up the sample sipper to the spectrophotometer. 

The parameters for the sample sipper are settable on its front panel. 

Explained here is the procedure for creating a calibration curve and 

measuring an unknown sample in the photometry mode. 

 

 

A message box appears in the standard measurement session, so 

operate in accordance with the messages.  A message box does not 

appear in the sample measurement session.  Measurement can be 

started just by pressing the sipping lever of the sample sipper. 

 

NOTES: 1. In use of the sample sipper, remeasurement, interrupt 

measurement and blank measurement cannot be made.  

But remeasurement of standards is possible. 

 2. When repeat measurement is set, the standards are 

measured by the set number of times.  Samples are 

measured only once. 

 

9.1.1 When Not 

Using Sample 

Table 
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Select the Measure command from the Spectrophotometer menu or 

click the  (measurement) button on the toolbar.  A window as in 

Fig. 9-1 will open. 

 

 

 

Fig. 9-1 

 

 

Press the sipping lever.  Measurement will start.  Upon completion of 

the 1st standard measurement, a message box for the 2nd standard 

measurement will appear. 

For remeasurement or skipping, select the relevant item with the mouse 

(by placing a bullet in its radio button) and click Yes.  When you click 

No, the current measurement sequence is terminated. 

For restarting measurement, click the  button.  Measurement then 

starts from standard 1. 

Upon completion of standard measurement, a window as in Fig. 9-2 will 

appear. 
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Fig. 9-2 

 

 

By clicking OK, a calibration curve is drawn and then samples can be 

measured.  When a window as in Fig. 9-3 appears, press the sipping 

lever.  The result of measurement will appear in the area indicated by 

① in Fig. 9-4. 

 

 

 

Fig. 9-3 
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Fig. 9-4 

 

 

Upon completion of measurement, click the End button.  The data will 

be saved. 

 

For remeasuring any of the standards after their measurements, click its 

data as shown in Fig. 9-5.  Then click the Remeasure button. 

 

 

 

Fig. 9-5 

 

 

① 
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A message box as in Fig. 9-6 will open.  Press the sipping lever. 

 

 

 

Fig. 9-6 

 

 

When a standard is remeasured, the calibration curve is recalculated 

and sample data is also recalculated based on the curve and then 

displayed.  To save the recalculated data, click the End button or the 

 (save) button on the toolbar. 

 

 

A message box is displayed in both standard and sample measurement 

sessions.  So operate according to the messages.  When the 

message box appears, press the sipping lever of the sample sipper. 

 

NOTE: When the sample sipper is used, blank measurement cannot 

be made. 

 

Select the Measure command from the Spectrophotometer menu or 

click the  (measurement) button on the toolbar.  A window as in 

Fig. 9-7 will open. 

 

 

 

Fig. 9-7 

9.1.2 When Using 

Sample Table 
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Press the sipping lever.  Measurement will start.  Upon completion of 

the 1st standard measurement, a message box for the 2nd standard 

measurement will appear.  For remeasurement or skipping, select the 

relevant item with the mouse (by placing a bullet in its radio button), and 

then click Yes.  When you click No, the current measurement 

sequence is terminated. 

For restarting measurement, click the  button.  Measurement then 

starts from standard 1.  

 

Upon completion of standard measurement, a window as in Fig. 9-8 will 

open. 

 

 

 

Fig. 9-8 

 

 

By clicking OK with the mouse, a calibration curve is drawn and then 

samples can be measured. 

 

In case of sample measurement also, a message box as in Fig. 9-9 will 

appear.  Press the sipping lever.  Measurement of sample 1 will start. 
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Fig. 9-9 

 

 

For measurement of sample 2, a message box as in Fig. 9-10 will open. 

 

 

 

Fig. 9-10 

 

 

For measurement of sample 2, press the sipping lever. 

For skipping this sample (measurement of sample 3), select “Skip this 

sample?” and click the Yes button with the mouse. 

For remeasurement, select “Repeat the last measurement?” and click 

the Yes button with the mouse.  When repeat measurement has been 

set, measurement starts from the 1st one (Repl. No. 1) for the sample. 
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In case of interrupt measurement, select “Insert a new sample into the 

sequence?” and click the Yes button with the mouse.  A message box 

as in Fig. 9-11 will appear.  Input a sample name and comment, and 

then click the OK button. 

 

 

 

Fig. 9-11 

 

 

For remeasurement after a series of measurements, click the data to be 

remeasured as shown in Fig. 9-12.  Then lick the Remeasure button. 

 

 

 

Fig. 9-12 
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A window as in Fig. 9-13 will open.  Press the sipping lever, and 

measurement will start.  When a standard is remeasured, the 

calibration curve is recalculated and sample data is also recalculated 

based on the curve and then displayed.  To save the recalculated data, 

click the  (save) button. 

 

 

 

Fig. 9-13 

 

 

(1) When Not Using Sample Table 

 

Set your analysis method.  When the monitor window appears, 

press the sipping lever.  Measurement will start. 

 

(2) When Using Sample Table 

 

Select the Measure command from the Spectrophotometer menu 

or click the  (measurement) button on the toolbar.   

A message box will appear.  Follow the messages given. 

 

 

9.1.3 In Wavelength 

Scan or Time 

Scan Mode 
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9.2  Use of AS-3000 Intelligent Autosampler 
 

Set the rack parameters, injection volume and other items with the  

AS-3000 Intelligent Autosampler.  For details, refer to the instruction 

manual attached to the AS-3000. 

 

 

 

 

 

 

 

 

 

 

 

Fig. 9-14  Cord Connection 

 

 

Parameter setting:  Set all parameters in the AS-3000. 

 

NOTE: When using a sample table, match the number of samples set 

in the AS-3000 with that set in the sample table.  If the latter 

is less than the former, some samples cannot be measured. 

 

 

PC
AS-3000

USB

EXTIN
COM1

OUT1 IN1

Communication cable 
(furnished with F-7000)

Connecting cord  
(furnished with AS-3000) 

F-7000
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<Measurement> 

(1) Select the Measure command from the Spectrophotometer menu 

of the FL Solutions program or click the  (measurement) 

button on the toolbar.  A window as in Fig. 9-15 will open. 

 

 

 

Fig. 9-15  For Start from Creation of Calibration curve 

 

 

(2) Press the START key on the AS-3000. 

 

(3) Measurement will start. 
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9.3  Analog Output 
 

For connection, use the analog output terminal.  Select the Analog 

Output command from the Utility menu.  (The analog output I/F (option) 

is required.) 

 

 

 

Fig. 9-16 

 

 

This is a setting of data value corresponding to analog output of 1 V. 

Analog output value (V) becomes as follows. 

 

Low : (data value)/1000 

High : (data value)/10000 
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APPENDIX A  DETAILS OF QUANTIFICATION  
 

A.1  Foreword 
 

In the Photometry mode of the F-7000 spectrophotometer, the following 

four calibration curve types are available. 

 

• Linear working curve 

• Quadratic working curve 

• Cubic working curve 

• Multiple segment working curve 

 

These are explained in detail below. 

 

 

A.2  Linear Working Curve (1st order) 
 

A regression line is determined via the least squares method from a 

maximum of 20 data.  The calculation formula is as follows: 

 

x = A1 � y + A0 
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where, x : Sample concentration (input value) 

 y : Sample data (measured value) 

 n : Number of samples 
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A.3  Quadratic Working Curve (2nd order) 
 

A quadratic curve is determined via the least squares method from a 

maximum of 20 data.  The calculation formula is as follows: 

 

x = A2 � y
2
 + A1 � y + A0 
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where, x : Sample concentration (input value) 

 y : Sample data (measured value) 

 n : Number of samples 

 

 

A.4  Cubic Working Curve (3rd order) 
 

A cubic curve is determined via the least squares method from a 

maximum of 20 data.  The calculation formula is as follows: 

 

x = A3 � y
3
 + A2 � y

2
 + A1 � y + A0 

 

where, x : Sample concentration (input value) 

 y : Sample data (measured value) 

 n : Number of samples 
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A.5  Multiple Segment Working Curve (Segmented) 
 

The calibration curve is apt to bend when measuring turbid samples or 

the like.  Use of a quantification program allows correcting the 

calibration curve by using up to 20 standards.  Figure A-1 shows an 

example of curve correction.  For the part which exceeds the 

measuring range of the standards, simply extend the line as it is.  

 

 

 

Fig. A-1  Correction of Curve Bending 

 

 

Data

Conc 
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＜Notes on Preparation of Multiple Segment Working Curve> 

(1) A correct calibration curve can be created only when the 

measured value increases or decreases monotonically versus the 

concentration value.  Especially when the inclination is negative-

going, be sure to measure a blank having a data value larger than 

the other standards.  A curve not showing a monotonic increase 

will appear as in Fig. A-2.  And when the data value of the blank 

is small, regardless of a negative-going inclination, the curve will 

appear as in Fig. A-3. 

 

 

 

Fig. A-2 Example of Curve without Monotonic Increase  

(unsuitable curve) 

 

 

 

 

Fig. A-3 Example of Negative-going Curve where Measured  

Value of Blank is Small (unsuitable curve) 

 

 

Data

Conc 

Data

Conc 
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(2) Remeasurement of Standards 

 

The standards can be remeasured after once preparing a 

calibration curve.  The curve prepared in such a case will appear 

as in Fig. A-4. 

 

 

 

Fig. A-4  Calibration Curve when Standards are Remeasured 

 

 

 

Data

Conc

Redrawn 
calibration curve

Remeasured STD1

Initially measured STD1
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APPENDIX B DETAILS OF RATE ANALYSIS 

FUNCTION 

 

B.1  Foreword 
 

Rate analysis is used in the analysis of enzyme reactions.  It is utilized 

for clinical and biochemical tests by reagent manufacturers, hospitals 

and so on.  A computer is used to calculate the concentration from the 

variation in data per unit time, and the result is displayed and printed out. 

 

 

B.2  Calculation Method 
 

A timing chart for rate analysis is shown in Fig. B-1.  Data is acquired 

when the initial delay time has elapsed after pressing the Measure 

button.  A regression line is determined from this data via the least 

squares method, and the gradient and activity value are calculated.  

The calculation formula is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. B-1 

 

 

Data 

Td Tc

Tt

Tm

A0

A1

A5

A4

A3

A2

A6

A7

Time

Start of 
measurement 

Data: A0, A1, A2, A3, 
A4... 

Td : Initial delay time
Tm : Measurement time 
Tc : Sampling interval 
Tt : Calculation time 
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Prepare a regression line via the least squares method from the 

measured data, and obtain a determination coefficient. 

 

y = ax + b 

where, 

 

( )
a

x y
x y

n

x

x

n

i i

i i

i

i

=

−

−

∑∑
∑

∑
∑

2

2

  

( )
b y

a x

ni

i

= −

∗ ∑
∑  

 

xi : Time (s) of each data 

yi : Value of each data 

n : Number of samples 

 

The determination coefficient CD becomes as follows: 
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• Gradient (variation per minute) 
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• Activity 

Ci = k � Di 

 

• R (relative coefficient) 
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• R2 (determination coefficient) 
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NOTE: If the range for rate calculation does not coincide with the 

actual measured data range, then use only the measured data 

within the range for the calculation. 

 



A - 8 

APPENDIX C DETERMINATION COEFFICIENT 

OF CALIBRATION CURVE 

 

C.1  Calculation of Determination Coefficient 

 

The determination coefficient and other factors are calculated via the 

following formula. 

 

 

 

Difference DIFF : DIFFn = Cn - Cstdn 

Relative difference RD : RD
DIFF

A
n
= ×100   

A

A

N

n

=

∑
 

Student’s t-test : t
DIFF

DIFF

N

n

n
=

−

∑
2

1

 

Relative coefficient : 
( ) ( )

( )
R

C C C C

C C

n n stdn

n

=

− − −

−

∑ ∑

∑

2 2

2
 

Determination coefficient : R2 = (R)
2
 

 

An : Photometric or 
average value of 
standard 

Cn : Concentration on 
approximation curve 
versus A 

Cstdn : Standard 
concentration (input 
value) 

N : Number of standards

↑ 
Data 

Conc →
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C.2  Usage of Determination Coefficient 
 

The determination coefficient indicates the goodness of fit of the 

measured standards and the prepared calibration curve.  The closer 

this value is to “1,” the better the fit of the measured value and 

calibration curve.  If the value is far from “1,” then the standards must 

be measured or the calibration curve mode must be changed.  

Examples of determination coefficients upon changing the calibration 

curve mode are given below. 

 

 

 

 

With the above standard data, it can be seen that a quadratic curve 

provides a better result.  A calibration curve, which was formerly judged 

through skill or experience, can thus be judged more easily through 

numerical means. 

 

 

x:  Standard measurement points
 
When calibration curve type is set 
to linear: 

Determination coefficient < 1 

When calibration curve type is set 
to quadratic: 

Determination coefficient ≓ 1 

↑ 
Data 

↑ 
Data 

Conc →

Conc →
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APPENDIX D INTEGRATION METHOD AND 

SMOOTHING 

 

D.1  Foreword 
 

The integration methods and smoothing used in the FL Solutions 

program are explained here. 

 

 

D.2  Integration Methods 
 

The FL Solution program comes with the following three integration 

methods. 

 

• Rectangular 

• Trapezoid 

• Romberg 

 

 

The Rectangular method is the simplest calculation method among the 

above three.  Since one sampling interval is equal to the width of each 

sectional area, the total value of all data points covering a peak is 

approximated as a target area. 

As shown in Fig. D-1, the target area is a total of the rectangular parts 

obtained from linear approximation of the curve drawn by following the 

data points.  If the number of peak data points is small, approximation 

will become rough. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. D-1 

 

D.2.1 Rectangular 

Method 
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The Trapezoid method is an improved method of peak area calculation. 

Each section having a width equal to one sampling interval is indicated 

by a rectangle and a triangle on it.  And the target area is given by 

totaling the area values of all sections. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. D-2 

 

 

When focusing attention on one section, the area Ir of its rectangular 

part can be expressed as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. D-3 

 

 

D.2.2 Trapezoid 

Method 

 

Ir = f1x
where, x : Sampling interval 
 f1 : Left-side height of 

rectangle 

f1 

x

f2
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To this rectangle, a triangular part is to be added. 

When replacing the sectional area with IT, and the triangular area with It, 

IT is given by the following formula. 

I I I
f f

x f x
f f

x
T t r
= + =

−
+ =

+⎛

⎝
⎜

⎞

⎠
⎟

2 1

1

1 2

2 2

 

 

The above formula can be transformed to cover the entire peak as 

follows. 

I
f

f f
f

x
T n

n= + + + +
⎛

⎝
⎜

⎞

⎠
⎟

−

1

2 1
2 2

K

 

 

 

The Romberg method is the most exact integration used in this program. 

The aforementioned Trapezoid method has different step sizes 

(sampling intervals) for determining a peak area more exactly.   

This method capable of using a total of inherent errors can use both of 

two step sizes individually conceivable.  However, unlike a classic 

method of continuous approximation, the step size cannot be reduced 

freely in the same way as an increase in the X-axis direction for exact 

integration.  This is because a spectrum is handled as average data of 

the data points which define the spectrum. 

Yet, the Romberg method allows an increase in step size by a factor of 

2 or 4 when necessary.  This method is implemented as follows. 

 

(1) At every data point, data is integrated by the Trapezoid method. 

(2) At every two data points, data is integrated by the Trapezoid 

method. 

(3) The results of the above (1) and (2) are combined with each other 

to obtain the following. 

 

I I
I I

R n

n n
= +

− 2

3

 

 

where, IR : Integration by Romberg method 

 In : Trapezoid method at every data point 

 I2n : Trapezoid integration at every two data point 

 

 

D.2.3 Romberg 

Method 
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D.3  SMOOTHING 
 

The FL Solutions program comes with the following three smoothing 

methods. 

 

• Savitsky-Golay smoothing 

• Mean smoothing 

• Median smoothing 

 

These are explained in detail below. 

 

 

For this method, refer to the following literature. 

 

Gorry,P.A. 

”General Least-Squares Smoothing and Differentiation by the 

Convolution (Savitsky -Golay) Method”  

Anal.Chem. 1990, 62, 570-573. 

 

D.3.1 Foreword 

 

D.3.2 Savitsky-Golay 

Smoothing 
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Average data is obtained from the numerical values at the specified data 

points and set for the center wavelength. 

 

Example) 

Number of data points : 7 

Number of times : 1 

In case of 7 data points starting from 358.0 nm, the average value is 

set for the center wavelength of 358.6 nm.  At this time, data 

disappears at 3 points at the both sides on the spectrum. 

 

How to acquire data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When an even number (2n) of data points are specified, 

“2n” is replaced with “2n+1” for calculation.  This means that the same 

result is obtained when the number of data points is set at “8” and at “9.” 

 

 

D.3.3 Mean 

Smoothing 

nm Data Data 

358.0 22.41 ⎯ 

358.2 23.15 ⎯ 

358.4 23.82 ⎯ 

358.6 24.41 24.23 

358.8 24.91 24.71 

359.0 25.32 25.10 

359.2 25.60 25.39 

359.4 25.78 25.57 

359.6 25.85 25.65 

359.8 25.83 25.64 

360.0 25.70 25.54 

360.2 25.50 25.35 

360.4 25.23 � 

360.6 24.88 � 

360.8 24.47 � 

� � � 

� � � 
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Middle data is obtained from the numerical values at the specified data 

points and set for the center wavelength. 

 

Example) 

Number of data points : 7 

Number of times : 1 

In case of 7 data points starting from 358.0 nm, the 4th smallest 

value is set for the center wavelength of 358.6 nm.  At this time, 

data disappears at 3 points at the both sides on the spectrum. 

 

How to acquire data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When an even number (2n) of data points are specified, 

“2n” is replaced with “2n+1” for calculation.  This means that the same 

result is obtained when the number of data points is set at “8” and at “9.” 

 

 

D.3.4 Median 

Smoothing 

nm Data Data 

358.0 22.41 ⎯ 

358.2 23.15 ⎯ 

358.4 23.82 ⎯ 

358.6 24.41 24.41 

358.8 24.91 24.91 

359.0 25.32 25.32 

359.2 25.60 25.60 

359.4 25.78 25.70 

359.6 25.85 25.70 

359.8 25.83 25.70 

360.0 25.70 25.70 

360.2 25.50 25.50 

360.4 25.23 � 

360.6 24.88 � 

360.8 24.47 � 

� � � 

� � � 
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APPENDIX E DESCRIPTION OF 
FLUOROMETRY 

 

E.1  Description of Fluorescence 
 

 

 

 

 

 

Fig. E-1  Typical Organic Molecular Energy Level 

 

 

Figure E-1 illustrates the energy level transitions in an organic molecule 

in processes of light absorption and emission. 

When light strike an organic molecule in the ground state, it absorbs 

radiation of certain specific wavelengths to jump to an excited state.   

A part of the excitation (absorbed) energy is lost on vibration relaxation, 

i.e., radiationless transition to the lowest vibrational level takes place in 

the excited state.  And, eventually the molecule returns to the ground 

state while emitting fluorescent radiation. 

Excitation

Stable stage 
(ground state)

Fluorescence/
phosphorescence

Unstable stage 
(excited state) 

Radiationless 
transition 

Radiationless 
transition 

Excited state 

Excited triplet state

Excitation light 
Light Light 

Ground state 
Absorption Fluorescence Phosphorescence
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Also, if radiationless transition to the triplet state takes place, then 

phosphorescence is emitted during triplet-to-singlet transition (from the 

excited triplet state to the ground singlet state). 

Generally phosphorescence persists for 10
-4

 sec or longer due to the 

selection rule imposed on the triplet-to-singlet transition.  In contrast, 

fluorescence persists for a period of 10
-8

 to 10
-9

 sec in most cases. 

 

As mentioned above, a part of the radiation absorbed by a substance is 

lost as vibration energy, etc.; therefore, the fluorescence emitted from 

the substance has a longer wavelength than the excitation light (Stokes’ 

law). 

 

The ratio of the number of photons emitted during fluorescence to the 

number of photons absorbed is called the quantum efficiency of 

fluorescence.  The larger the quantum efficiency a substance has, the 

more fluorescence it emits.  Also, the intensity of fluorescence emitted 

from a substance is proportional to the quantity of light absorbed by it.  

When a dilute solution sample is measured, the fluorescence intensity is 

expressed by the following formula. 

 

F = KI0cleεϕ 

 

where, F : Intensity of fluorescence 

 K : Instrumental constant 

 I0 : Intensity of exciting radiation 

 c : Concentration of substance 

 l : Cell path length 

 ε : Absorptivity of substance 

 ϕ : Quantum efficiency of substance 
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E.2  Advantages of Fluorometry 
 

As contrasted with fluorometry, absorptiometry for a low-concentration 

sample is explained in the following: 

A sample having 99% transmittance to blank is taken as an example.  

In the absorbance measurement of such a substance, inaccuracies 

must always be taken into consideration.  Here, the inaccuracy is 

assumed to be 0.1%.  Since it has an effect on both the blank and 

sample, 

 

Percent transmittance of blank 100.0 ± 0.1% 

Percent transmittance of sample 99.0 ± 0.1% 

Difference (proportional to sample concentration) 1.0 ± 0.2% 

 

In this example, the uncertainty in concentration measurement is ±20%.  

While in the fluorometry, a difference from zero level corresponds to the 

concentration of sample.  Accordingly, the measurement accuracy is 

as follows: 

 

Output signal level at sample measurement 100 ± 0.1 

Value corresponding to blank 0 ± 0.1 

Difference (proportional to sample concentration) 100 ± 0.2 

 

As can be seen from the above, the fluorometry is very advantageous 

for analyzing a low-concentration sample since its uncertainty is in most 

cases theoretically independent of the sample concentration. 

Although actual practice may involve some error factors which increase 

as the sample concentration becomes extremely low, the fluorometry is 

capable of measuring low concentrations with an accuracy 100 times 

higher than in absorptiometry. 

 

 

Figure E-2 is an explanatory illustration of the foregoing description.   

In absorptiometry, a difference between the quantity of incident radiation 

Io and the quantity of transmitted radiation It is represented by signal Is.  

A level at which the signal Is becomes almost equal to a noise level is 

used as a detection limit. 

In fluorometry, however, since the quantity of fluorescence IF itself is 

represented as a signal, just a small amount of fluorescence can be 

amplified electrically for enabling detection. 
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Still more, since a fluorescence wavelength of a substance is different 

from its excitation wavelength (incident light wavelength), the 

fluorescence wavelength is not readily affected by the exciting radiation, 

thereby contributing to ensuring high sensitivity. 

 

 

 

 

Fig. E-2  Comparison between Absorptiometry and Fluorometry 

 

 

In addition to high sensitivity, the fluorometry is advantageous in that 

more information is attainable.  An emission spectrum is also available 

besides an excitation spectrum which corresponds to an absorption 

spectrum in absorptiometry. 

The two kinds of wavelengths can be selected as desired, and a 

fluorescence spectrum can be recorded using a properly selected 

excitation wavelength (or vice versa).  Thus, quantitative and qualitative 

analyses can be made for a sample containing plural components. 

High 
concentration 

Low 
concentration

High 
concentration 

Low 
concentration

(a)  Absorptiometry (b)  Fluorometry 

Amplified 
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Figure E-3 shows a simplified spectral graph of measurement of a 

sample containing multiple components.  In absorptiometry, since only 

the absorption spectrum can be measured, two or more component 

wavelengths are presented.  If the absorption wavelengths are similar 

to each other, each component cannot be separated in measurement.  

In fluorometry, even if the absorption wavelengths are similar, a 

difference in fluorescence makes it possible to select each fluorescence 

wavelength properly.  Thus, each component can be separated in 

measurement. 

 

 

 

Fig. E-3  Measurement of Multi-component Sample 

 

 

Table E-1 compares information attainable in absorptiometry and that in 

fluorometry. 

 

Table E-1 Comparison of Information Attainable in 

Absorptiometry and Fluorometry 

 

Absorptiometry Fluorometry 

Absorption spectrum only 
(corresponding to excitation spectrum 
in fluorometry) 

• Excitation spectrum 

• Fluorescence spectrum 

 

 

 

Absorption spectra

Component A

Component B

Excitation spectra Fluorescence spectra

Component A Component B

(a)  Absorptiometry (b)  Fluorometry 
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E.3 Remarks on Measurement in  
Fluorescence Analysis 

 

For most kinds of samples, an increase of 1 °C in sample temperature 

causes the fluorescence intensity to decrease by 1 to 2%. 

It is also reported that for some kinds of biochemical samples, the 

fluorescence intensity decreases as much as 10% as the temperature 

increases by 1 °C.  When analyzing a sample having a temperature-

dependent property, it is advisable to use the constant-temperature cell 

holder (P/N 650-0150).  Constant-temperature measurement can be 

carried out by circulating constant-temperature water through this cell 

holder. 

 

 

Some kinds of samples may be susceptible to a chemical change due to 

exciting radiation.  In analysis of such a sample, keep the shutter 

closed to cut off an excitation beam until measurement is started, and 

then open the shutter immediately before measurement.  If any 

chemical change due to exciting radiation is observed still, determine a 

signal level at the start time through extrapolation according to variation 

in signal level. 

 

 

In fluorescence measurement, spectra having different natures from 

that of fluorescence may be observed.  These are called Rayleigh 

scattering spectrum and Raman scattering spectra; the former 

appearing at the same wavelength position as the excitation spectrum, 

and the latter appearing at the longer-wavelength side near Rayleigh 

scattering. 

In a fluorescence spectrum, when the excitation wavelength is shifted, 

only the peak height is changed while the peak wavelength position 

remains intact.  In a Raman scattering spectrum, when the excitation 

wavelength is shifted, the peak wavelength position is also changed 

accordingly.  Both the Rayleigh scattering and Raman scattering are 

caused by a solvent which may be contained in the sample.   

When examining the spectral plot, be careful not to mistake these 

scattering effects for the fluorescence peak of interest.  Table E-2 

presents the Raman spectral peak position at each excitation 

wavelength for the purpose of reference. 

 

E.3.1 Temperature 

Dependency of 

Fluorescence 

Intensity 

E.3.2 Chemical 

Change in 

Sample due to 

Radiation 

E.3.3 Raman 

Scattering 
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Fig. E-4  Raman Spectrum of Water 

 

 

Table E-2  Raman Peak Positions at Respective Excitation Wavelengths 

 

 (excitation 
wavelength) 

Water Ethanol Cyclohexane
Carbon 
Tetrachloride 

Chloroform

248 271 267 267 ⎯ ⎯ 

313 350 344 344 320 346 

365 416 405 408 375 410 

405 469 459 458 418 461 

Excitation 
wavelength 
and Raman 
peak 
position (nm) 

436 511 500 499 450 502 

 

R
e
la
ti
v
e
 i
n
te
n
s
it
y
 

Excitation 
wavelength 

Raman 
scattering 
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In measurement of a high-concentration sample, a variety of error 

factors may be involved. 

The most significant error factor consists in that an excitation beam is 

absorbed at the entrance of a cell to prevent a sufficient level of 

excitation at the center of the cell. 

Figure E-5 illustrates an extreme case of this condition.   

Although fluorescence is emitted in the vicinity of the entrance for the 

excitation beam, it is not taken into the emission monochromator. 

 

 

 

 

 

 

 

 

 

Fig. E-5  Sample Having an Extremely High Concentration 

 

 

If only the incident point of excitation beam is bright, it is necessary to 

dilute the sample properly for measurement. 

The second significant error factor consists in extinction due to 

concentration.  This condition is caused by preventing activation 

through interaction of molecules. 

The third significant error factor consists in re-absorption of 

fluorescence.  As shown in Fig. E-6, this condition occurs due to 

overlapping between the short-wavelength side of fluorescence 

spectrum and the long-wavelength side of excitation spectrum.  

Therefore, it seems that the fluorescence spectrum has been shifted 

toward the long-wavelength side to some extent.  In measurement of 

an ordinary kind of sample, however, this condition will not impede 

quantitative determination significantly 

 

 

 

 

Fig. E-6  Explanatory Illustration of Re-absorption 

E.3.4 Handling of 

High-

concentration 

Samples 

Excitation beam 

Fluorescence

Fluorescence is 
reflected here. 

R
e
la
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v
e
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n
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n
s
it
y
 

Fluorescence 
spectrum 

Excitation 
spectrum 

Re-absorption 
occurs here. 

Wavelength 
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In any case, if there is a possibility of a measurement error due to high 

concentration of a sample, dilute the sample properly or carry out 

surface fluorescence measurement using a solid sample holder. 

 

 

Where the excitation and emission wavelengths are plotted near each 

other, care should be exercised not to mistake the Raman and Rayleigh 

scattering for the fluorescence spectrum as mentioned in E.3.3.  

Where the excitation and emission wavelengths are plotted apart from 

each other, care should be exercised not to mistake the second-order 

and third-order scattered radiation for the fluorescence spectrum. 

The second-order scattered radiation appears at a wavelength two 

times longer than the excitation wavelength, and the third-order 

scattered radiation occurs at a wavelength three times longer. 

For instance, if the excitation wavelength is 240 nm, the second-order 

and third-order radiation take place at 480 and 720 nm, respectively.  

For eliminating these scattered radiations, insert a short-wavelength 

cutoff filter in the path of fluorescing radiation (before emission 

monochromator).  It is advisable to use the filter set (P/N 650-0157) 

which is available as an optional accessory. 

 

 

Since the fluorescence spectrophotometer provides high sensitivity, just 

a slight amount of contamination on a cell may have an adverse effect 

on results of measurement.  To prevent this, treat the cell properly after 

its use.  Do not leave the cell containing sample.  In evaporation of a 

solvent, a residue of sample may adhere to the wall of the cell to cause 

contamination. 

In measurement of a very dilute sample, contamination on the inner and 

outer walls of the cell may cause a problem.  If a droplet of sample 

solution is put on the outer wall of the cell in sample injection into it, wipe 

the cell with tissue paper and then set it into the cell holder. 

 

E.3.5 Second-order 

Scattered 

Radiation 

E.3.6 Contamination 

of Cell 
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Figure E-7 shows a measurement example of fluorescence spectrum. 

 

 

 

 

① Scattering of exciting radiation 

② Raman spectrum of solvent 

③ Fluorescence of impurities, solvent, etc. 

④ Fluorescence of sample 

⑤ Second-order spectrum of exciting radiation 

 

Fig. E-7  Measurement Example of Fluorescence Spectrum 

 

 

As shown in Fig. E-7, other peaks than a fluorescence peak of sample 

appear in measurement of fluorescence spectrum.  With reference to 

this example, it is necessary to identify a fluorescence peak of sample. 

 

E.3.7 Measurement 

Example of 

Fluorescence 

Spectrum 

R
e
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v
e
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n
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n
s
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y
 

Wavelength
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APPENDIX F MEASUREMENT OF 
INSTRUMENTAL RESPONSE 
(CORRECTED SPECTRA) 

 

Spectrum correction is performed to enable measuring a true spectrum 

by eliminating instrumental response such as wavelength characteristics 

of the monochromator or detector (photomultiplier).  The measurement 

of instrumental response is needed to perform spectrum correction.  

“Instrumental Response” is the function to measure and save the 

instrumental response. 

 

 

F.1 Measurement of Instrumental Response on 
Excitation Side 

 

This is the function to obtain the instrumental response on the excitation 

side such as wavelength characteristics of the excitation 

monochromator using Rhodamine B as a standard (quantum counter).  

The instrumental response is automatically read with a single 

wavelength scan operation.  A spectrum is correctable within a range 

of 200 to 600 nm. 

 

WARNING 

Rhodamine B can cause injury if directly touched or accidentally 

ingested.  When handling it, be sure to wear proper protective 

gear such as safety gloves and safety mask.  If Rhodamine B 

adheres to the skin, wash it off with soap and plenty of water.  

Consult a physician when needed.  If accidentally ingested, 

immediately consult physician. 

 

 

Pour Rhodamine B into a triangular cell in the procedure illustrated in 

Fig. F-1.  The triangular cell filled with Rhodamine B should be in 

principle stored at a dark place. 

F.1.1 Handling of 

Rhodamine B 
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Fig. F-1  Handling of Rhodamine B 

 

 

(1) Click the  (analysis method) button on the Measurement 

toolbar.  A box for setting your analysis method will appear. 

 

(2) Select the General tab.  On the General tab page, specify 

“Wavelength scan” for the measurement mode. 

 

(3) Select the Instrument tab. 

 

(4) Set “Fluorescence” for the data mode, “400 V” for the 

photomultiplier voltage and “Excitation” for the scan mode. 

 

(5) Execute the Zero Adjust command from the Spectrophotometer 

menu to calibrate the zero point. 

 

Rhodamine B

Cut the supplied 
ampoule of 
Rhodamine B with 
a cutter. 

Syringe 
(F649090)

Suck the 
solution into a 
syringe. 

Open the cover 
of triangular cell 
and pour the 
solution into it. 

Fill the cell with the 
solution in a volume 
at least half the 
capacity and close 
the cover. 

F.1.2 Operating 

Procedures 
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(6) As shown in Fig. F-2, set the triangular cell filled with Rhodamine 

B into the cell holder in the sample compartment, the filter holder 

to the sample compartment and the red filter (single-side frosted) 

in the filter holder.  In so doing, pay attention to the direction of 

the triangular cell and filter.  (Refer to Fig. F-3) 

 

 

 

 

Fig. F-2  Setting of Triangular Cell Containing Rhodamine B 

 

 

 

 

Fig. F-3  Setting Direction of Triangular Cell (top view) 

 

 

NOTE: It may take time to obtain stable data due to characteristics of 

the detector immediately after the photomultiplier voltage has 

been remarkably changed (from 700 V to 250 V for example).  

When more accurately calibrating the zero point, wait until 

stable data is obtained and then proceed to step (5). 

 

Triangular cell with 
fixture (containing 
Rhodamine B) 

Filter holder Red filter 

Metal part

Excitation light

Triangular cell

Fluorescence

Red filter  
(single-side frosted)

Frosted 
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(7) Execute the Instrumental Response command from the Utility 

menu.  The Instrumental Response dialog box will open as 

shown in Fig. F-4. 

Select “EX [200 to 600 nm].”  (Refer to ① in Fig. F-4.) 

 

 

 

Fig. F-4 

 

 

(8) Click the Run button.  (Refer to ② in Fig. F-4.) 

A message box “Set the triangular cell with Rhodamine B to cell 

holder and set the red filter.” will appear.  After setting the 

Rhodamine B and red filter, click the OK button.  (Refer to ③ in 

Fig. F-5.) 

 

 

 

Fig. F-5 

 

 

1 

2

3
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(9) The EX wavelength is set at 640 nm and the instrument starts EX 

wavelength scan (from 198.6 to 601.4 nm). 

At this stage, the following measuring conditions are automatically 

set. 

• Scan mode : Excitation 

• Data mode : Fluorescence 

• EX slit : 5.0 nm 

• EM slit : 20.0 nm 

• Scan speed : 60 nm/min 

• PMT voltage : 400 V 

• Response : Auto 

 

(10) Upon completion of measurement, the conditions set before 

measurement are retrieved. 

Now, the instrument response on the excitation side has been 

measured and stored.  Take out the rectangular cell. 
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F.2 Measurement of Instrumental Response on  
Emission Side 

 

This is the function to obtain the instrumental response on the emission 

side such as wavelength characteristics of the emission monochromator 

or detector (photomultiplier). 

The instrumental response on the emission side is determined by 

measuring a combination of instrumental response on both the 

excitation and emission sides by synchronous wavelength scan, and 

dividing it by the instrumental response on the excitation side 

preliminarily measured.  An emission spectrum is correctable within a 

range of 200 to 600 nm. 

 

 

(1) Click the  (analysis method) button on the Measurement 

toolbar.  A box for setting your analysis method will appear. 

 

(2) Select the General tab.  On the General tab page, specify 

“Wavelength scan” for the measurement mode. 

 

(3) Select the Instrument tab. 

 

(4) Set “Fluorescence” for the data mode and “250 V” for the 

photomultiplier voltage. 

 

(5) Execute the Zero Adjust command from the Spectrophotometer 

menu to calibrate the zero point. 

 

(6) As shown in Fig. F-6, set the diffuser into the cell holder in the 

sample compartment.   

 

 

 

Fig. F-6  Setting of Diffuser 

F.2.1 Overview 

F.2.2 Operating 

Procedures 

 

Diffuser 
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NOTES: 1. Measurement of the instrumental response on the 

excitation side must be completed before executing 

measurement of the instrumental response on the 

emission side. 

 2. It may take time to obtain stable data due to 

characteristics of the detector immediately after the 

photomultiplier voltage has been remarkably changed 

(from 700 V to 250 V for example).  When more 

accurately calibrating the zero point, wait until stable 

data is obtained and then proceed to step (5). 

 

(7) Execute the Instrumental Response command from the Utility 

menu.  The Instrumental Response dialog box will open as 

shown in Fig. F-7. 

Select “EM [200 to 600 nm].”  (Refer to ① in Fig. F-7.) 

 

 

 

Fig. F-7 

 

 

(8) Click the Run button.  (Refer to ② in Fig. F-7.)  A message 

box “Set diffuser to cell holder.” will appear.  Click the OK button.  

(Refer to ③ in Fig. F-8.) 

 

 

 

Fig. F-8 

1 

2

3



A - 33 

(9) The EX and EM wavelengths are set at 198.6 nm and the 

instrument starts synchronous wavelength scan (from 198.6 to 

601.4 nm). 

At this stage, the following measuring conditions are automatically 

set. 

• Scan mode : Synchronous 

• Data mode : Fluorescence 

• EX slit : 5.0 nm 

• EM slit : 20.0 nm 

• Scan speed : 60 nm/min 

• PMT voltage : 250 V 

• Response : Auto 

 

(10) Upon completion of measurement, the conditions set before 

measurement are retrieved. 

Now, the instrument response on the excitation side has been 

measured and stored.  Take out the diffuser. 
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F.3 Measurement of Instrumental Response in 
Long Wavelength Range on Emission Side 

 

When a corrected spectrum in the long wavelength area of 600 nm or 

more is required on the emission side, the beam of a lamp whose 

wavelength characteristics are known is allowed to be irradiated to the 

emission monochromator, and the instrumental response in the long 

wavelength range on the emission side is read for correction. 

As a light source, a sub standard light source (P/N 250-0123) is used.  

The correction range by it is 500 to 900 nm and, when combined with an 

instrumental response in the short wavelength range, spectrum 

correction is available over the entire wavelength range (200 to 900 nm) 

on the emission side. 

 

 

<Mounting and Positioning Sub Standard Light Source> 

Refer to the instruction manual for the sub standard light source 

(optional accessory). 

 

(1) Close the cover of the sample compartment. 

 

(2) Click the  (analysis method) button on the Measurement 

toolbar.  A box for setting your analysis method will appear. 

 

(3) Select the General tab.  On the General tab page, specify 

“Wavelength scan” for the measurement mode. 

 

(4) Select the Instrument tab. 

 

(5) Set “Fluorescence” for the data mode and “400 V” for the 

photomultiplier voltage. 

 

(6) Execute the Zero Adjust command from the Spectrophotometer 

menu to calibrate the zero point. 

 

(7) Set the sub standard light source in the sample compartment with 

reference to its instruction manual.  (Refer to Fig. F-9.) 

Turn on the power switch of the sub standard light source and 

wait for approx. 5 minutes until the lamp stabilizes. 

F.3.1 Overview 

 

F.3.2 Operating 

Procedures 
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Fig. F-9 

 

 

(8) Execute the Instrumental Response command from the Utility 

menu.  The Instrumental Response dialog box will open as 

shown in Fig. F-10. 

Select “EM [500 to 900 nm].”  (Refer to ① in Fig. F-10.) 

 

 

 

Fig. F-10 

 

 

1 

2
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(9) Click the Run button.  (Refer to ② in Fig. F-10.)  A message 

box “Set the sub standard light source.” will appear.  Click the 

OK button.  (Refer to ③ in Fig. F-11.) 

 

 

 

Fig. F-11 

 

 

(10) The instrument starts EM wavelength scan (from 498.6 to  

901.4 nm). 

At this stage, the following measuring conditions are automatically 

set. 

• Scan mode : Emission 

• Data mode : Luminescence 

• EM slit : 5.0 nm 

• Scan speed : 60 nm/min 

• PMT voltage : 400 V 

• Response : Auto 

 

(11) Upon completion of measurement, the conditions set before 

measurement are retrieved. 

Now, the instrument response on the emission side has been 

measured and stored.  Take out the sub standard light source 

and diffuser. 

 

 

3
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F.4 Measurement of Instrumental Response in 
Long Wavelength Range on Excitation Side 

 

When a corrected spectrum in the long wavelength area of 600 nm or 

more is required on the excitation side, the instrumental response in the 

long wavelength range on the excitation side is read for the correction 

with reference to the instrumental response obtained at the long 

wavelength on the emission side. 

This measurement is enabled only when the instrumental response at 

the long wavelength on the emission side is available.  The correction 

range by it is 500 to 900 nm and, when combined with an instrumental 

response in the short wavelength range, spectrum correction is 

available over the entire wavelength range (200 to 900 nm) on the 

excitation side. 

 

 

(1) Close the cover of the sample compartment. 

 

(2) Click the  (analysis method) button on the Measurement 

toolbar.  A box for setting your analysis method will appear. 

 

(3) Select the General tab.  On the General tab page, specify 

“Wavelength scan” for the measurement mode. 

 

(4) Select the Instrument tab. 

 

(5) Set “Fluorescence” for the data mode and “350 V” for the 

photomultiplier voltage. 

 

(6) Execute the Zero Adjust command from the Spectrophotometer 

menu to calibrate the zero point. 

 

F.4.1 Overview 

 

F.4.2 Operating 

Procedures 
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(7) Set the diffuser into the cell holder in the sample compartment.  

(Refer to Fig. F-12.) 

 

 

 

Fig. F-12 

 

 

(8) Execute the Instrumental Response command from the Utility 

menu.  The Instrumental Response dialog box will open as 

shown in Fig. F-13. 

Select “EX [500 to 900 nm].”  (Refer to ① in Fig. F-13.) 

 

 

 

Fig. F-13 

 

 

Diffuser 

1 

2
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(9) Click the Run button.  (Refer to ② in Fig. F-13.)  A message 

box “Set diffuser to cell holder.” will appear.  Click the OK button.  

(Refer to ③ in Fig. F-14.) 

 

 

 

Fig. F-14 

 

 

(10) The EX and EM wavelengths are set at 498.6 nm and the 

instrument starts synchronous wavelength scan (from 498.6 to 

901.4 nm). 

At this stage, the following measuring conditions are automatically 

set. 

• Scan mode : Emission 

• Data mode : Luminescence 

• EX slit : 5.0 nm 

• EM slit : 5.0 nm 

• Scan speed : 60 nm/min 

• PMT voltage : 350 V 

• Response : Auto 

 

(11) Upon completion of measurement, the conditions set before 

measurement are retrieved. 

Now, the instrument response on the emission side has been 

measured and stored.  Take out the diffuser. 

 

3
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F.5  Resetting of Instrumental Response 
 

(1) Click the Reset button in the Instrumental Response dialog box.  

(Refer to ① in Fig. F-15.) 

 

 

 

Fig. F-15 

 

 

(2) A message box “Erase instrumental response on 

excitation/emission side. OK?” will appear.  Click the OK button.  

(Refer to ② in Fig. F-16.) 

 

 

 

Fig. F-16 

 

 

(3) Now, the instrumental response has been erased. 

 

1

2
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APPENDIX G PARAMETER SETTING RANGE 
FOR ANALYSIS METHOD 

 

G.1 General Tab: Common to all measurement 
modes 

 

Parameter Name Setting Range 

Measurement Wavelength scan, Time scan, Photometry, 3-D scan,  
3-D Time scan 

Operator Up to 20 characters 

Comments Up to 255 characters 

Use sample table ON, OFF 

 

ON : Checked 

OFF : Unchecked 

 

 

G.1.1 Wavelength Scan:  Instrument Tab 

 

Parameter Name Setting Range 

Scan mode Excitation, Emission, Synchronous 

Data mode Fluorescence, Luminescence, Phosphorescence 

Chopping speed 10 Hz, 20 Hz, 40 Hz 

EX WL 
 

Scan Mode Input Range 

Excitation 0, 200 to 900 nm 

Synchronous 200 to 890 nm 
  

EX Start WL Input Range:  200 to 890 nm 

EX End WL Input Range:  210 to 900 nm 

EM WL Input Range:  0, 200 to 900 nm 

EM Start WL Input Range:  200 to 890 nm 

EM End WL Input Range:  210 to 900 nm 
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(cont’d) 

Parameter Name Setting Range 

Scan speed  
(unit: nm/min) 

60000 
30000 
12000 

2400 
1200 

240 
60 
30 

When Synchronous is specified for scan mode, 1200 nm/min or less 
is indicated. 

When Phosphorescence is specified for data mode, select from the 
following.   
Chopping speed is in parentheses. 

F-7000 (40 Hz) F-7000 (20 Hz/10 Hz) 

240 
60 
30 

60 
30 

  

Delay 0 to 9999 s 

EX Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

EM Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

PMT Voltage Setting range:  250, 400, 700, 950 V 

0 to 1000 V when “PMT Voltage 0-1000V” is turned ON (checked). 

PMT Voltage  
0 - 1000 V 

ON, OFF 

Response (unit: s) 0.002 
0.004 
0.01 
0.05 
0.1 
0.5 
2.0 
4.0 
8.0 
Auto 

Corrected spectra ON, OFF 

Shutter control ON, OFF 

Replicates 1 to 99 

Cycle time 0.0 to 180.0 min 

 

ON : Checked 

OFF : Unchecked 
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G.1.2 Wavelength Scan:  Monitor Tab 

 

Parameter Name Setting Range 

Y Axis: Max -119999999.9 to 120000000.0 

Y Axis: Min -120000000.0 to 119999999.9 

Open data processing window after data acquisition ON, OFF 

Open data processing window after acquisition 
(Overlay) 

ON, OFF 

Print report after data acquisition ON, OFF 

Overlay ON, OFF 

 

 

G.1.3 Wavelength Scan:  Processing Tab 

 

Parameter Name Setting Range 

CAT ON, OFF 

Processing choices Savitsky-Golay, Smooth, Mean Smooth,  
Median Smooth, Derivative 

Peak Finding: Integration method Rectangular, Trapezoid, Romberg 

Peak Finding: Threshold 0.001 to 1000 

Peak Finding: Sensitivity 1, 2, 4, 8 
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G.1.4 Wavelength Scan:  Report Tab 

 

Parameter Name Setting Range 

Output Print Report, Use Microsoft(R) Excel,  
Use print generator sheet 

Orientation Portrait, Landscape 

Print items: Include date ON, OFF 

Print items: Include method ON, OFF 

Print items: Include graph ON, OFF 

Print items: Include data listing ON, OFF 

ON:  “Constant” or “Select data” is selectable. 

When “Constant” is specified: 

Parameter Setting Range 

Data interval Minimum sampling interval to 
measuring wavelength interval 

Data start Wavelength range on 
Instrument tab page 

Data end Wavelength range on 
Instrument tab page 

When “Select data” is specified: 
Selectable from 12 wavelengths. 

Print items: Include peak table ON, OFF 

ON:  Items to be output peak table are selectable. 

Item Setting Range 

Peak WL/Peak data ON, OFF 

Start WL/End WL ON, OFF 

Valley WL/Valley data ON, OFF 

Peak Area ON, OFF 
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G.2.1 Time Scan:  Instrument Tab 

 

Parameter Name Setting Range 

Data mode Fluorescence, Luminescence, Phosphorescence,  
Phosphorescence Life Time,  
Phosphorescence Life Time (short)  

Chopping speed 10 Hz, 20 Hz, 40 Hz 

EX WL Input Range:  0, 200 to 900 nm 

EM WL Input Range:  0, 200 to 900 nm 

Time unit s, ms 

Scan time 
 

Time Unit Input Range 

s 10 to 9000 s 

ms 100 to 9999 ms 

 

When Phosphorescence Life Time (short) is specified for data 
mode: 

Chopping Speed Scan Time 

40 Hz Fixed at 20 ms 

20 Hz Fixed at 40 ms 

10 Hz Fixed at 80 ms 
  

Delay 0 to 9999 s 

EX Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

EM Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

PMT Voltage Setting range:  250, 400, 700, 950 V 

0 to 1000 V when “PMT Voltage 0-1000V” is turned ON (checked). 

PMT Voltage  
0 - 1000 V 

ON, OFF 

Response (unit: s) 0.002 
0.004 
0.01 
0.05 
0.1 
0.5 
2.0 
4.0 
8.0 

Shutter control ON, OFF 

Replicates 1 to 99 

Cycle time 0.0 to 180.0 min 
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G.2.2 Time Scan:  Monitor Tab 

 

Parameter Name Setting Range 

Y Axis: Max -119999999.9 to 120000000.0 

Y Axis: Min -120000000.0 to 119999999.9 

X Axis: Max (unit: s) 0.1 to 9999.0 

X Axis: Min (unit: s) 0.0 to 9998.9 

Open data processing window after 
data acquisition 

ON, OFF 

Open data processing window after 
acquisition (Overlay) 

ON, OFF 

Print report after data acquisition ON, OFF 

Overlay ON, OFF 

 

 

G.2.3 Time Scan:  Processing Tab 

 

Parameter Name Setting Range 

Processing choices Savitsky-Golay Smooth, Mean Smooth,  
Median Smooth, Derivative 

Peak Finding: Integration method Rectangular, Trapezoid, Romberg 

Peak Finding: Threshold 0.001 to 1000 

Peak Finding: Sensitivity 1, 2, 4, 8 

Kinetics: Start time 0 to 3599 s, 0 to 9998 ms 

Kinetics: End time 0 to 3600 s, 1 to 9999 ms 

Kinetics: K-Factor -9999 to -0.001, 0.001 to 9999 
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G.2.4 Time Scan:  Report Tab 

 

Parameter Name Setting Range 

Output Print Report, Use Microsoft(R) Excel,  
Use print generator sheet 

Orientation Portrait, Landscape 

Print items: Include date ON, OFF 

Print items: Include method ON, OFF 

Print items: Include graph ON, OFF 

Print items: Include data listing ON, OFF 

ON: “Constant” or “Select data” is selectable. 

When “Constant” is specified: 

Parameter Setting Range 

Data interval Minimum sampling interval to 
measuring scan time 

Data start Scan time range on 
Instrument tab page 

Data end Scan time range on 
Instrument tab page 

When “Select data” is specified: 
Selectable from 12 time points (in measurement 
range). 

Print items: Include peak table ON, OFF 

ON:  Items to be output onto peak table are selectable.

Item Setting Range 

Peak time/Peak data ON, OFF 

Start time/End time ON, OFF 

Valley time/Valley data ON, OFF 

Peak Area ON, OFF 
  

Print items: Include kinetics ON, OFF 
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G.3.1A Photometry:  Quantification Tab (Quantification type:  Wavelength) 

 

Parameter Name Setting Range 

Quantification type Wavelength, Peak area, Peak height, Derivative, Ratio 

Calibration type None, 1st order, 2nd order, 3rd order, Segmented 

Number of wavelengths 
 

Calibration Type Setting Range 

None 1 to 6 

1st order 

2nd order 

3rd order 

Segmented 

1 to 3 

    

Concentration unit Up to 8 characters 

Manual calibration ON, OFF 

ON: Factors are specifiable. 

Factor Setting Range 

A0 to A3 -100000 to 100000 
    

Force curve through zero ON, OFF 

Digit after decimal point 0 to 3 

Lower concentration limit 0 to 1e+009 

Upper concentration limit 0 to 1e+009 

 

 

G.3.1B Photometry: Quantification Tab (Quantification type:  Peak area, 

Peak height) 

 

Parameter Name Setting Range 

Quantification type Wavelength, Peak area, Peak height, Derivative, Ratio 

Calibration type None, 1st order, 2nd order, 3rd order, Segmented 

Peak apex Wavelength range on Instrument tab page ± 0.1 to 700.0 nm

Concentration unit Up to 8 characters 

Manual calibration ON, OFF 

ON: Factors are specifiable. 

Factor Setting Range 

A0 to A3 -100000 to 100000 
    

Force curve through zero ON, OFF 

Digit after decimal point 0 to 3 

Lower concentration limit 0 to 1e+009 

Upper concentration limit 0 to 1e+009 

Integration method Rectangular, Trapezoid, Romberg 

Threshold 0.001 to 1000 

Sensitivity 1, 2, 4, 8 
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G.3.1C Photometry:  Quantification Tab (Quantification type:  Derivative) 

 

Parameter Name Setting Range 

Quantification type Wavelength, Peak area, Peak height, Derivative, Ratio 

Calibration type None, 1st order, 2nd order, 3rd order, Segmented 

Peak apex Wavelength range on Instrument tab page 

Concentration unit Up to 8 characters 

Manual calibration ON, OFF 

ON: Factors are specifiable. 

Factor Setting Range 

A0 to A3 -100000 to 100000 
    

Force curve through zero ON, OFF 

Digit after decimal point 0 to 3 

Lower concentration limit 0 to 1e+009 (1000000000) 

Upper concentration limit 0 to 1e+009 (1000000000) 

Derivative order 2, 4 

Smoothing order 2 to 4 

Number of points 5 to 101 

 

 

G.3.1D Photometry:  Quantification Tab (Quantification type:  Ratio) 

 

Parameter Name Setting Range 

Quantification type Wavelength, Peak area, Peak height, Derivative, 
Ratio 

Subtract background [Wavelength 3] ON, OFF 

K-Factor 0 

K-Factor 1 

K-Factor 2 

-9999 to -0.001, 0.001 to 9999 

Operand + (plus), - (minus), * (times) 
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G.3.2A Quantification: Instrument Tab (Quantification type:  Wavelength, 

Ratio) 

 

Parameter Name Setting Range 

Data mode Fluorescence, Luminescence, Phosphorescence 

Chopping speed 10 Hz, 20 Hz, 40 Hz 

Wavelength mode EX WL Fixed, EM WL Fixed, Both WL Fixed 

Fixed WL Input Range:  0, 200 to 900 nm 

WL 1 to WL 6 Input Range:  0, 200 to 900 nm 

EX Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

EM Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

PMT Voltage Setting range:  250, 400, 700, 950 V 

0 to 1000 V when “PMT Voltage 0-1000V” is turned ON 
(checked). 

PMT Voltage 0 - 1000 V ON, OFF 

Auto statistic calc. number 2 to 4000 

Replicates 1 to 20 

Integration time 0.1 to 10.0 s 

Delay 0 to 9999 s 
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G.3.2B Photometry: Instrument Tab (Quantification type:  Peak area, Peak 

height, Derivative) 

 

Parameter Name Setting Range 

Scan mode Excitation, Emission, Synchronous 

Data mode Fluorescence, Luminescence, Phosphorescence 

Chopping speed 10 Hz, 20 Hz, 40 Hz 

EX WL 
 

Scan Mode Input Range 

Excitation 0, 200 to 900 nm 

Synchronous 200 to 890 nm 
    

EX Start WL Input Range:  200 to 890 nm 

EX End WL Input Range:  210 to 900 nm 

EM WL Input Range:  0, 200 to 900 nm 

EM Start WL Input Range:  200 to 890 nm 

EM End WL Input Range:  210 to 900 nm 

Scan speed (unit: nm/min) 60000 
30000 
12000 

2400 
1200 

240 
60 
30 

When Synchronous is specified for scan mode,  
1200 nm/min or less is indicated. 

When Phosphorescence is specified for data mode, select 
from the following.  Chopping speed is in parentheses. 

(40 Hz) (20 Hz/10 Hz)

240 
60 
30 

60 
30 

    

Delay 0 to 9999 s 

EX Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

EM Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

PMT Voltage Setting range:  250, 400, 700, 950 V 

0 to 1000 V when “PMT Voltage 0-1000V” is turned ON 
(checked). 

PMT Voltage 0-1000V ON, OFF 
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(cont’d) 

Parameter Name Setting Range 

Response (unit: s) 0.002 
0.004 
0.01 
0.05 
0.1 
0.5 
2.0 
4.0 
8.0 
Auto 

Corrected spectra ON, OFF 

Shutter control ON, OFF 

Replicates 1 to 20 

Auto statistic calc. number 2 to 4000 
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G.3.3 Photometry:  Standard Tab 

 

Parameter Name Setting Range 

Number of Samples 1 to 20 

Sample Up to 40 characters 

Comment Up to 255 characters 

Concentration 0 to 1000000000 

 

 

G.3.4 Photometry:  Monitor Tab 

 

Parameter Name Setting Range 

Y Axis: Max. -119999999.9 to 120000000.0 

Y Axis:  Min. -120000000.0 to 119999999.9 

Open data processing window after data acquisition ON, OFF 

Print report after data acquisition ON, OFF 

 

 

G.3.5 Photometry:  Report Tab 

 

Parameter Name Setting Range 

Output Print Report, Use Microsoft(R) Excel, Use print 
generator sheet 

Print items: Include date ON, OFF 

Print items: Include method ON, OFF 

Print items: Include calibration curve ON, OFF 

Print items: Include standard data ON, OFF 

Print items: Include standard comment ON, OFF 

Print items: Include calibration data ON, OFF 

Print items: Include sample data ON, OFF 

Print items: Include sample comment ON, OFF 
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G.4.1 3-D Scan:  Instrument Tab 

 

Parameter Name Setting Range 

Data mode Fluorescence, Phosphorescence 

Chopping speed 10 Hz, 20 Hz, 40 Hz 

EX Start WL Input Range:  200 to 850 nm 

EX End WL Input Range:  250 to 900 nm 

EX Sampling interval Input Range:  1 to 50 nm 

EM Start WL Input Range:  200 to 850 nm 

EM End WL Input Range:  250 to 900 nm 

EM Sampling interval Input Range:  1 to 10 nm 

Scan speed (unit: nm/min) 60000 
30000 
12000 

2400 
1200 

240 
60 
30 

when Synchronous is specified for scan mode,  
1200 nm/min or less is indicated. 

When Phosphorescence is specified for data mode, select 
from the following.  Chopping speed is in parentheses. 

(40 Hz) (20 Hz/10 Hz) 

240 
60 
30 

60 
30 

    

EX Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

EM Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

PMT Voltage Setting range:  250, 400, 700, 950 V 

0 to 1000 V when “PMT Voltage 0-1000V” is turned ON 
(checked). 

PMT Voltage 0 - 1000 V ON, OFF 

Response (unit: s) 0.002 
0.004 
0.01 
0.05 
0.1 
0.5 
2.0 
4.0 
8.0 
Auto 
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(cont’d 

Parameter Name Setting Range 

Corrected spectra ON, OFF 

Shutter control ON, OFF 

 

ON : Checked 

OFF : Unchecked 

 

 

G.4.2 3-D Scan:  Monitor Tab 

 

Parameter Name Setting Range 

Y Axis: Max -119999999.9 to 120000000.0 

Y Axis: Min -120000000.0 to 119999999.9 

Contour interval 0.001 to 1000.000 

Open data processing window after data acquisition ON, OFF 

Print report after data acquisition ON, OFF 

 

 

G.4.3 3-D Scan:  Processing Tab 

 

Parameter Name Setting Range 

Peak Finding: Integration method Rectangular 

Peak Finding: Threshold 0.001 to 1000 

Peak Finding: Sensitivity 1, 2, 4, 8 
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G.4.4 3-D Scan:  Report Tab 

 

Parameter Name Setting Range 

Output Print Report, Use Microsoft(R) Excel, Use print 
generator sheet 

Orientation Portrait, Landscape 

Print items: Include date ON, OFF 

Print items: Include instrument ON, OFF 

Print items: Include graph ON, OFF 

ON: Any of the following items is selectable. 

• Contour 

• Bird’s-eye view 

• Contour and Bird’s-eye view 

• Contour and Spectrum 

Print items: Include peak table ON, OFF 

Print items: Data listing*
1
 ON, OFF 

ON: Setting can be made for excitation and emission 
spectra. 

Parameter Setting Range 

Interval Minimum data interval to 
measuring wavelength interval 

Start Wavelength range on Instrument 
tab page 

End Wavelength range on Instrument 
tab page 

    

 

*1: Valid when “Use Microsoft(R) Excel” or “Use print generator sheet” is specified for 

Output.  Always turned ON when “Use print generator sheet” is specified. 
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G.5.1 3-D Time Scan:  Instrument Tab 

 

Parameter Name Setting Range 

Scan mode Excitation, Emission, Synchronous 

Data mode Fluorescence, Luminescence, Phosphorescence 

Chopping speed 10 Hz, 20 Hz, 40 Hz 

EX WL 
  

Scan Mode Input Range 

Excitation 0, 200 to 900 nm 

Synchronous 200 to 890 nm 
   

EX Start WL Input Range:  200 to 890 nm 

EX End WL Input Range:  210 to 900 nm 

EM WL Input Range:  0, 200 to 900 nm 

EM Start WL Input Range:  200 to 890 nm 

EM End WL Input Range:  210 to 900 nm 

Scan speed (unit: nm/min) 60000 
30000 
12000 

2400 
1200 

240 
60 
30 

When Synchronous is specified for scan mode,  
1200 nm/min or less is indicated. 

When Phosphorescence is specified for data mode, select 
from the following.  Chopping speed is in parentheses. 

(40 Hz) (20 Hz/10 Hz)

240 
60 
30 

60 
30 

    

EX Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

EM Slit (unit: nm) 1.0 
2.5 
5.0 

10.0 
20.0 

PMT Voltage 250, 400, 700, 950 V 

0 to 1000 V when “PMT Voltage 0-1000V” is turned ON 
(checked). 

PMT Voltage 0 - 1000 V ON, OFF 
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(cont’d) 

Parameter Name Setting Range 

Response (unit: s) 0.002 
0.004 
0.01 
0.05 
0.1 
0.5 
2.0 
4.0 
8.0 
Auto 

Corrected spectra ON, OFF 

Shutter control ON, OFF 

Replicates 2 to 99 

Cycle time 2 to 3600 s 

 

ON : Checked 

OFF : Unchecked 

 

 

G.5.2 3-D Time Scan:  Monitor Tab 

 

Parameter Name Setting Range 

Y Axis: Max -119999999.9 to 120000000.0 

Y Axis: Min -120000000.0 to 119999999.9 

Contour interval 0.001 to 1000 

Open data processing window after data acquisition ON, OFF 

Print report after data acquisition ON, OFF 

 

 

G.5.3 3-D Time Scan:  Processing Tab 

 

Parameter Name Setting Range 

Peak Finding: Integration method Rectangular 

Peak Finding: Threshold 0.001 to 1000 

Peak Finding: Sensitivity 1, 2, 4, 8 
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G.5.4 3D Time Scan:  Report Tab 

 

Parameter Name Setting Range 

Output Print Report, Use Microsoft(R) Excel, Use print 
generator sheet 

Orientation Portrait, Landscape 

Print items: Include date ON, OFF 

Print items: Include instrument ON, OFF 

Print items: Include graph ON, OFF 

ON: Any of the following items are selectable. 

• Contour 

• Bird’s-eye view 

• Contour and Bird’s-eye view 

• Contour and Spectrum 

Print items: Data listing*
1
 ON, OFF 

ON: Setting can be made for time scan and 
wavelength scan spectra. 

Parameter Setting Range 

Interval Minimum data interval to measuring 
wavelength interval 

Start Wavelength range on Instrument tab 
page 

End Wavelength range on Instrument tab 
page. 

    

 

*1: Valid when “Use Microsoft(R) Excel” or “Use print generator sheet” is specified for 
Output.  Always turned ON when “Use print generator sheet” is specified. 
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APPENDIX H  SAMPLING INTERVAL 
 

H.1  Wavelength Scan 
 

The data sampling interval is set as follows according to the scan speed. 

 

[Data mode = Fluorescence/Luminescence] 

 

Scan Speed (nm/min) Sampling Interval (nm) 

60000 2.0 

30000 1.0 

12000 0.2 

2400 0.2 

1200 0.2 

240 0.2 

60 0.2 

30 0.2 

 

 

[Data mode = Phosphorescence, Chopping speed = 40 Hz] 

 

Scan Speed (nm/min) Sampling Interval (nm) 

240 0.2 

60 0.2 

30 0.2 

 

 

[Data mode = Phosphorescence, Chopping speed = 20/10 Hz] 

 

Scan Speed (nm/min) Sampling Interval (nm) 

60 0.2 

30 0.2 
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H.2  Time Scan 
 

The data sampling interval is set as follows according to the scan time. 

 

[Data mode = Fluorescence/Luminescence/Phosphorescence/ 

Phosphorescence Life Time] 

 

Sampling Interval [ms] 

Phosphorescence 
Mode/Chopping Speed 

Scan Time  
[s] 

Fluorescence/Luminescence/
Phosphorescence  
Life Time Mode 40 Hz 20 Hz 10 Hz 

0.1 ~ 1 1 50 100 200 

~ 3 1 50 100 200 

~ 7 2 50 100 200 

~ 18 5 50 100 200 

~ 36 10 50 100 200 

~ 72 20 50 100 200 

~ 180 50 50 100 200 

~ 360 100 100 100 200 

~ 720 200 200 200 200 

~ 1800 500 500 500 1000 

~ 3600 1000 1000 1000 1000 

~ 7200 2000 2000 2000 2000 

~ 9000 5000 5000 5000 5000 

 

 

[Data mode = Phosphorescence Life Time (short)] 

 

Chopping Speed [Hz] Scan Time [ms] Sampling Interval [µs] 

40 20 10 

20 40 20 

10 80 40 
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H.3  3-D Time Scan 
 

The data sampling interval is set as follows according to the scan speed. 

 

[Data mode = Fluorescence/Luminescence] 

 

Scan Speed (nm/min) Sampling Interval (nm) 

60000 2.0 

30000 1.0 

12000 1.0 

2400 1.0 

1200 1.0 

240 1.0 

60 1.0 

30 1.0 

 

 

[Data mode = Phosphorescence, Chopping speed = 40 Hz] 

 

Scan Speed (nm/min) Sampling Interval (nm) 

240 1.0 

60 1.0 

30 1.0 

 

 

[Data mode = Phosphorescence, Chopping speed = 20/10 Hz] 

 

Scan Speed (nm/min) Sampling Interval (nm) 

60 1.0 

30 1.0 
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APPENDIX I PARAMETER SETTING RANGE 
ON OPTIONS WINDOW 
 

I.1  Display Tab 
 

Parameter Name Setting Range 

Show trace display ON, OFF 

Show gridlines with 
increment 

ON, OFF 

ON: Gridline width is selectable from 
Wide, Middle and Narrow. 

Display items:  
Wavelength scan 

Show graph only,  
Show graph plus peak table 

Display items:  
Time scan 

Show graph only,  
Show graph plus kinetic data,  
Show graph plus peak table 

Display items:  
3-D Scan 

Show contour plus EX, EM spectrum, 
Show contour plus EX,  
EM spectrum plus peak table 

Display items:  
Intracellular cation scan 

Show graph only,  
Show graph plus kinetic data,  
Show graph plus mean,  
Show graph plus point 

Display items:  
Intracellular cation spectrum 

Show fluorescence only,  
Show fluorescence plus ratio,  
Show fluorescence plus concentration, 
Show fluorescence plus ratio plus 
concentration 

Display items:  
Polarization time scan 

Show Graph only,  
Show graph plus kinetic data,  
Show graph plus point 

Display items:  
Polarization spectrum 

Show fluorescence only,  
Show fluorescence plus polarization 
degree,  
Show fluorescence plus anisotropy,  
Show fluorescence plus polarization 
degree plus anisotropy 
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I.2  Processing Tab 
 

Parameter Name Setting Range 

Integration method Rectangular, Trapezoid, Romberg 

Calibration formula Data = f(Conc), Conc = f(Data) 

Data output to peak table ON, OFF 

Smoothing: Processing Savitsky-Golay, Mean, Median 

Smoothing: Order 2 to 4 

Smoothing: Number of points 5 to 101 

Derivative: Smoothing order 2 to 4 

Derivative: Smoothing order 5 to 101 

 

 

I.3  Analysis Condition Tab 
 

Parameter Name Setting Range 

Integration time for current data 0.1 to 10.0 s 

Change Instrumental Response Condition ON, OFF 
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APPENDIX J  ERROR MESSAGE LIST 
 

Error Message Probable Cause Remedy 

ROM Error  ROM error has occurred. Contact our local service office. 

RAM Error  RAM error has occurred. Contact our local service office. 

Lamp is not lighted Lamp extinguished during 
initialization. 

Replace the lamp. 

Power interruption Momentary power failure 
detected at instrument. 

Check the connection of USB cable, 
and start up PC and 
spectrophotometer again.  If error 
recurs, contact our local service 
office. 

Zero adjust error! Faulty chopper operation Contact our local service office. 

Auto Pre-scan error! 

Peak not Found! 

Peak was not detected in 
auto pre-scan. 

Peak may be detected by widening 
the slit or increasing photomultiplier 
voltage. 

Pre-scan error! 

Peak not Found! 

Peak was not detected in 
normal pre-scan. 

Peak may be detected by widening 
the slit or increasing photomultiplier 
voltage. 

Wavelength Initialization 
error (EX)! 

Initialize position of EX side 
wavelength feed screw 
cannot be detected. 

Contact our local service office. 

Wavelength Initialization 
error (EM)! 

Initialize position of EM side 
wavelength feed screw 
cannot be detected. 

Contact our local service office. 

Shutter Initialization error  Initialize position of shutter 
cannot be detected. 

Contact our local service office. 

EX Slit initialization error! Initialize position of EX side 
slit cannot be detected.  

Contact our local service office. 

EM Slit initialization error! Initialize position of EM side 
slit cannot be detected.  

Contact our local service office. 

Chopper error! Sync signal from chopper 
cannot be detected.  

Contact our local service office. 

Progam status error Abnormality detected in 
spectrophotometer main unit 
program.  

Contact our local service office. 

The Xe lamp was turned off 
suddenly.  

Turn off the main switch of 
the spectrophotometer unit. 

Xe lamp has burned out. Replace with a new Xe lamp.  
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